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Abstract

				This guide describes how to use the Red Hat Fuse Tooling, which provides developer tools designed to increase your productivity when designing, developing, testing, and debugging your integration applications.
			






Preface




			Red Hat Fuse Tooling is an Eclipse-based IDE that simplifies and streamlines the process of developing integration applications within Red Hat CodeReady Studio. Fuse Tooling provides a set of developer tools that are specifically designed to work with:
		
	
					Red Hat Fuse
				
	
					Red Hat JBoss EAP
				
	
					Apache Camel
				
	
					Apache CXF
				
	
					Apache Karaf
				
	
					Spring Boot
				



			This guide provides information about how to use Fuse Tooling to:
		
	
					Create a project for your application, including Maven dependencies
				
	
					Connect and configure Enterprise Integration Patterns to build routes
				
	
					Browse endpoints and routes
				
	
					Drag and drop messages onto running routes
				
	
					Browse and visualize runtime processes via JMX
				
	
					Debug locally running Camel contexts and routes
				
	
					Test your application by:
				
	
							Creating and using JUnit test cases on Apache Camel routes
						
	
							Using JMX to analyze running components
						
	
							Tracing messages through Apache Camel routes
						



	
					Deploy your application
				



			For new users, the Tooling Tutorials provide step-by-step instructions on how to create, debug, test, and deploy a sample Camel application.
		

Part I. Developing Applications






Chapter 1. Creating a New Fuse Integration Project



Overview




				Creating a new Fuse Integration project involves these main steps:
			
	
						Specifying the project name and workspace
					
	
						Configuring the project deployment environment
					
	
						Selecting a project template
					
	
						If necessary, resolving Maven dependency errors
					



				After you configure the project, the tooling downloads all of the required Maven dependencies and creates the POM file needed to run and publish the project.
			
Note

					The first time that you build a Fuse project in CodeReady Studio, it might take several minutes for the wizard to finish generating the project as it downloads dependencies from remote Maven repositories.
				


Before you begin




				Before you create a new Fuse Integration project, you should have the following information:
			
	
						Your target runtime environment: Fuse on OpenShift or Fuse standalone (Spring Boot, Fuse on Karaf, or Fuse on EAP)
					
	
						The Camel version (if other than the default used by the tooling)
					



Specifying the project name and workspace




				To create a new Fuse Integration project, follow these steps:
			
	
						Select New → Project → Red Hat Fuse → Fuse Integration Project to open the New Fuse Integration Project wizard.
					

						The wizard opens with the Use default workspace location option selected in the Location pane.
					
[image: nfpProjectName1]


	
						In Project Name, type a name for the new project, for example MySampleProject.
					
	
						Specify the workspace location in which you want to store the data for the project.
					
	
								To use the default workspace, leave the Use default workspace location option enabled.
							
	
								To use an alternative location clear the Use default workspace location option and specify a location in the Path field.
							

								Click 
								[image: BrowseButton]
								 to quickly find and select an alternate workspace.
							




	
						Click Next to open the Select a Target Environment page.
					



Configuring the project deployment environment




				When you create a new project, you specify the project’s target deployment environment so that your project has the resources it needs at runtime. You must select a deployment platform and a Camel version. Optionally, you can specify a runtime configuration.
			

				With the Select a Target Environment page open:
			
	
						Select whether you want to deploy the project on Kubernetes/OpenShift or on a Standalone platform.
					
[image: NFPcamelVersion]


						If you select Kubernetes/OpenShift for the deployment platform, the Sprint Boot runtime is automatically selected and you can skip to Step 3.
					

	
						If you select Standalone for the deployment platform:
					
	
								Choose a target runtime environment:
							
	
										Spring Boot
									
	
										Karaf/Fuse on Karaf
									
	
										Wildfly/Fuse on EAP
									



	
								For the Karaf and EAP standalone runtime environments, choose one of the following options for the runtime configuration:
							
	
										Accept the None selected option (you can define the runtime configuration later).
									
	
										Select an existing runtime configuration from the drop-down menu.
									
	
										Create a new runtime configuration as described in the section called “Creating a new target runtime (optional)”.
									






	
						In the Select the Camel version for your new project pane, accept the default Camel version associated with the runtime or change the default by:
					
	
								Selecting a Camel version from the drop-down list. Fuse Tooling supports the listed productized versions.
							
	
								Typing a different Camel version if you want to experiment with non-productized versions (that are not supported).
							

								You can click the Verify button to check whether the tooling can access the specified version. If not, a notification similar to the following example appears in the Select a Target Runtime page header:
							
[image: Verify Camel]

Note

									After you create, configure, and save a project, you can change the Camel version. See Chapter 12, Changing the Camel version.
								





	
						After you choose a runtime environment and a Camel version on which to base your new Fuse Integration project, click Next to open the wizard’s Advanced Project Setup page and then follow the steps in the section called “Selecting a project template”.
					


Creating a new target runtime (optional)




				For the Karaf and EAP standalone runtime environments, you can optionally create a new runtime configuration from the New Fuse Integration Project wizard.
			
	
						From the wizard’s the Select a Target Runtime page, click New to open the New server runtime environment page:
					
[image: New Server Runtime Environment]


	
						Expand the Red Hat JBoss Middleware folder, and then select a Red Hat Fuse runtime environment.
					

						Leave the Create a new local server option unchecked. You can create the local server later when you are ready to publish your project (see the section called “Adding a Server”).
					
Note

							If you check the Create a new local server option, the New Fuse Integration Project wizard walks you through additional steps to define and configure the Fuse server runtime (as described in the section called “Adding a Server”). Then, when it builds the project, it also adds the server runtime to the Servers view in the Fuse Integration perspective.
						


	
						Click Next to open the server’s New Server Runtime Environment page:
					
[image: nfpRuntimeDefJBF1]


	
						Specify the Name, Home Directory, Execution Environment of the server runtime:
					
	
								Name — Accept the default or enter a new name for the runtime environment.
							
	
								Home Directory — Click the Browse button to locate and select the server runtime’s installation directory.
							
Note

									If the server is not already installed on your machine, you can install it now by clicking the Download and install runtime link and then following the site’s download instructions. Depending on the site, you might be required to provide valid credentials before you can continue the download process.
								


	
								Runtime JRE: Execution Environment — Accept the default or select another JavaSE version from the drop-down list.
							

								If the version that you want does not appear on the list, click the Environments button and select the version from that list. The JRE version that you select must be installed on your machine.
							
Note

									Fuse 7.x requires JRE version 1.8.
								


	
								Runtime JRE: Alternate JRE - If your project requires a different version of Java, you can use this option.
							



	
						Click Finish to return to the New Fuse Integration Project wizard’s Select a Target Runtme page:
					

						The newly configured target runtime appears in the Target Runtime pane’s drop-down menu, and the Camel version supported by the runtime appears in the Camel Version pane, grayed out.
					

						After you create a Fuse Integration project, it is possible to change the Camel version. See Chapter 12, Changing the Camel version.
					

	
						Click Next to specify a template for the project as described in the section called “Selecting a project template”.
					




Selecting a project template




				The Advanced Project Setup page provides a list of templates that you can use as a starting point for your new project. The templates, based on common use cases, provide sample code and data to get you started quickly. The list of available templates depends on the runtime environment that you selected on the previous page. Select a template to view its description in the right pane.
			
Note

					If you do not see a template that meets your requirements, you can click the Where can I find more examples to use as templates? link to open an information dialog with a list of URLs with more examples:
				
[image: nfpTemplateExamples]


					To use one of these examples:
				
	
							Select Cancel to exit the New Fuse Integration Project wizard.
						
	
							Clone the repository from one of the listed URLs.
						
	
							Import the example project into CodeReady Studio as described in Chapter 13, Importing an existing Maven project.
						



	
						For Fuse on OpenShift there is a single template that demonstrates how to configure Camel routes in Spring Boot using a Spring XML configuration file. This template creates a Fuse Integration project and requires a Camel version newer than 2.18.1.redhat-000012.
					

						This template creates a project that runs on OpenShift servers, and it supports the Spring DSL only. For details on using this template, see Chapter 7, Getting Started with Fuse on OpenShift.
					
[image: nfpTemplateOpenShift]


	
						For Wildfly or Fuse on EAP there is a single template that provides a sample Camel route that calls into a bean service to say "Hello". This template creates a project that runs on Red Hat EAP servers, and it supports the Spring DSL only.
					
[image: nfpTemplateEAP]


	
						For Karaf or Fuse on Karaf, you have a choice of templates. You can create an empty project, which creates a skeleton Camel context routing file based on one of the three supported Domain Specific Languages (DSLs), or you can use a predefined template, each of which is based on a common use case. Individual templates might not support all DSL options.
					
Note

							For Java DSL, the tooling generates a CamelRoute.java file that you can edit in the tooling’s Java editor, but it does not generate a graphical diagram representation of it.
						

	
								Content Based Router — Provides a sample Camel route that reads files from a specific location and routes them to different output folders according to message content.
							

								This template creates a project that runs on Red Hat Fuse servers, and it supports all three of the DSLs.
							

	
								CXF code first — Provides a sample Camel route that is started by a CXF web service call.
							

								This template creates a project that runs on Red Hat Fuse servers, and it supports the Spring and Java DSLs only.
							
[image: nfpTemplateKaraf]

	
										Select a template from the list.
									
	
										Click Finish.
									

										The tooling starts building the project and adds it to the Project Explorer view.
									

										If the Fuse Integration perspective is not already open, the tooling asks whether you want to switch to it now:
									
[image: OpenAssociatedPerspective]


	
										Click Yes to open the new project in the Fuse Integration perspective:
									
[image: nfpTemplateProjectOpen]


										The project appears in the Project Explorer view. By default, the project includes an Apache Camel context (XML) file.
									

	
										Click the Source tab at the bottom of the canvas to see the generated Camel context file:
									
[image: nfpTemplateCBRsource]










Note

					If you want to add another new Camel context file to the project, see Chapter 11, Creating a New Camel XML file.
				

					When you build a project that uses CXF you might want the build process to automatically operate on the Java files to generate WSDL files. To do this, configure the java2ws Maven plug-in in the project’s .pom file. See: Apache CXF Development Guide, Maven Tooling Reference, java2ws.
				


Resolving Maven dependency errors




				You might encounter Maven dependency errors after you create a new Fuse Integration project.
			

				Though it can happen at other times, it more typically occurs when you cancel a project build before the process has finished. Interrupting the process in this way often prevents all of the project’s dependencies from downloading from the Maven repositories, which can take some time.
			

				You can often resolve these dependency errors by updating Maven dependencies as follows:
			
	
						In the Project Explorer view, right-click the root project to open the context menu.
					
	
						Select Maven → Update Project.
					
	
						In the Update Maven Project wizard:
					
	
								Select the project that you want to update, if more than one appears in the wizard’s list.
							
	
								Click the Force Update of Snapshots/Releases option to enable it.
							



	
						Click OK.
					

						In the bottom, right corner of the workbench, you can view the progress status bar churning as missing dependencies are downloaded from the Maven repositories.
					





Chapter 2. Editing a routing context in the route editor



The following sections describe how to edit a routing context.
Adding patterns to a route




					Routes consist of a sequence of connected patterns, referred to as nodes once they are placed on the canvas inside a Route container node. A complete route typically consists of a starting endpoint, a string of processing nodes, and one or more destination endpoints.
				

					When you add a pattern into a Route container on the canvas, the pattern takes on a color that indicates its type of node:
				
	
							Blue — Route containers, which correspond to route elements in the context file, and other container nodes, such as when and otherwise EIPs that contain other EIPs that complete their logic
						
	
							Green — Consumer endpoints that input data entering routes
						
	
							Orange — EIPs that route, transform, process, or control the flow of data transiting routes
						
	
							Purple — Producer endpoints that output the data exiting routes
						


Procedure




					To add a pattern to a route:
				
	
							In the Palette, locate the pattern that you want to add to the route.
						
	
							Use one of the following methods:
						
	
									Click the pattern in the Palette and then, in the canvas, click the route container.
								
	
									Drag the pattern over the target Route container and drop it.
								

									Alternatively, you can add a pattern on an existing node that has no outgoing connection, or on a connection existing between two nodes, to have the tooling automatically wire the connections between all nodes involved.
								

									The tooling checks whether the resulting connection is valid and then either allows or prevents you from adding the pattern on the target. For valid connections, the tooling behaves differently depending on whether the target is a node or a connection:
								
	
											For an existing node, the tooling adds the new node to the target node’s outgoing side (beneath or to the right of it depending on how the editor preferences are set) and automatically wires the connection between them
										
	
											For an existing connection, the tooling inserts the new node between the two connected nodes and automatically rewires the connections between the three nodes
										






	
							Optionally, you can manually connect two nodes:
						
	
									In the Route container on the canvas, select the source node to display its connector arrow.
								
	
									Drag the source node’s connector arrow ( 
									[image: ConnectorArrow]
									 ) to the target node, and release the mouse button to drop the connector on it.
								
Note

										Not all nodes can be connected. When you try to connect a source node to an invalid target node, the tooling displays the 
										[image: unconfigured co gray]
										 symbol attached to the mouse cursor, and the connector fails to stick to the target node.
									





	
							After you add a pattern inside a Route container, you can drag it to different location inside the route container or to another route container on the canvas, as long as it can establish a valid connection. You can also relocate existing nodes that are already connected, as long as the move can establish another valid connection.
						

							To view a short video that illustrates how to reposition endpoints, click here.
						

	
							Select File → Save. The tooling saves routes in the context file regardless of whether they are complete.
						



					The new pattern appears on the canvas in the Route container and becomes the selected node. The Properties view displays a list of the new node’s properties that you can edit.
				

Changing the layout direction




					When you connect one node to another, the tooling updates the layout according to the route editor’s layout preference. The default is Down.
				

					To access the route editor 's layout preference:
				
	
							On Linux and Windows machines, select Windows → Preferences → Fuse Tooling → Editor → Choose the layout direction for the diagram editor.
						
	
							On OS X, select CodeReady Studio → Preferences → Fuse Tooling → Editor → Choose the layout direction for the diagram editor.
						



Related topics



	
							the section called “Configuring a pattern”
						
	
							the section called “Removing patterns from a route”
						




Configuring a pattern



Overview




					Most patterns require some explicit configuration. For example, an endpoint requires an explicitly entered URI.
				

					The tooling’s Properties view provides a form that lists all of the configuration details a particular pattern supports. The Properties view also provides the following convenience features:
				
	
							validating that all required properties have values
						
	
							validating that supplied values are the correct data type for the property
						
	
							drop-down lists for properties that have a fixed set of values
						
	
							drop-down lists that are populated with the available bean references from the Apache Camel Spring configuration
						



Procedure




					To configure a pattern:
				
	
							On the canvas, select the node you want to configure.
						

							The Properties view lists all of the selected node’s properties for you to edit. For EIPs, the Details tab lists all of a pattern’s properties. For components from the Components drawer, the Details tab lists the general properties and those that require a value, and the Advanced tab lists additional properties grouped according to function.
						

							The Documentation tab describes the pattern and each of its properties.
						

	
							Edit the fields in the Properties view to configure the node.
						
	
							When done, save your work by selecting File → Save from the menu bar.
						




Removing patterns from a route



Overview




					As you develop and update a route, you may need to remove one or more of the route’s nodes. The node’s 
					[image: garbageIcon]
					 icon makes this easy to do. When you delete a node from the canvas, all of its connections with other nodes in the route are also deleted, and the node is removed from the corresponding route element in the context file.
				
Note

						You can also remove a node by opening its context menu and selecting Remove.
					


Procedure




					To remove a node from a route:
				
	
							Select the node you want to delete.
						
	
							Click its 
							[image: garbageIcon]
							 icon.
						
	
							Click Yes when asked if you are sure you want to delete this element.
						



					The node and all of its connections are deleted from the canvas, and the node is removed from its corresponding route element in the context file.
				

Related topics



	
							the section called “Adding patterns to a route”
						




Adding routes to the routing context



Overview




					The camelContext element within an XML context file creates a routing context. The camelContext element can contain one or more routes, and each route, displayed on the canvas as a Route container node, maps to a route element in the generated camelContext element.
				

Procedure




					To add another route to the camelContext:
				
	
							In the Design tab, do one of the following:
						
	
									Click a Route pattern in the Palette's Routing drawer and then click in the canvas where you want to place the route.
								
	
									Drag a Route pattern from the Palette's Routing drawer and drop it onto the canvas.
								

									The Properties view displays a list of the new route’s properties that you can edit.
								




	
							In the Properties view, enter:
						
	
									An ID (for example, Route2) for the new route in the route’s Id field
								
Note

										The tooling automatically assigns an ID to EIP and component patterns dropped on the canvas. You can replace these autogenerated IDs with your own to distinguish the routes in your project.
									


	
									A description of the route in the Description field
								
	
									Values for any other properties, as needed. Required properties are indicated by an asterisk (*).
								



	
							On the menu bar, select File → Save to save the changes you made to the routing context file.
						
	
							To switch between multiple routes, select the route that you want to display on the canvas by clicking its entry under the project’s Camel Contexts folder in the Project Explorer view.
						
[image: routeEntriesProjectExplorer]


	
							To display all routes in the context, as space allows, click the context file entry in the Project Explorer view.
						
	
							To view the code generated by the tooling when you add a route to the canvas, click the Source tab.
						
Note

								You can alternately add a route in the Source tab, by adding a <route/> element to the existing list within the camelContext element.
							






Deleting a route



Overview




					In some cases you made need to delete an entire route from your routing context. The Route container’s 
					[image: garbageIcon]
					 icon makes this easy to do. When you delete a route, all of the nodes inside the Route container are also deleted, and the corresponding route element in the context file is removed.
				
Note

						You can also remove a route using the Route container’s context menu and selecting Remove.
					

Important

						You cannot undo this operation.
					


Procedure




					To delete a route:
				
	
							If the routing context contains more than one route, first select the route you want to delete in the Project Explorer view.
						
[image: routeEntriesProjectExplorer]


	
							On the canvas, click the Route container’s 
							[image: garbageIcon]
							 icon.
						
[image: routeDelete]


	
							Click Yes when asked if you are sure you want to delete this element.
						



					The route is removed from the canvas, from the context file, and from the Project Explorer view.
				


Adding global endpoints, data formats, or beans



Overview




					Some routes rely on shared configuration provided by global endpoints, global data formats, or global beans. You can add global elements to the project’s routing context file by using the route editor’s Configurations tab.
				

					To add global elements to your routing context file:
				
	
							Open your routing context file in the route editor.
						
	
							At the bottom of the route editor, click the Configurations tab to display global configurations, if there are any.
						
[image: ConfigurationsView]


	
							Click Add to open the Create a new global element dialog.
						
[image: CnfigsVAddButton]


							The options are:
						
	
									Endpoint — see the section called “Adding a global endpoint”.
								
	
									Data Format — see the section called “Adding a global data format”.
								
	
									Bean — see the section called “Adding a global bean”.
								






Adding a global endpoint



	
							In the Create a new global element dialog, select Endpoint and click OK to open the Select component dialog.
						
[image: CnfigsVSelectCamComponent1]

Note

								By default, the Select component dialog opens with the Show only palette components option enabled. To see all available components, uncheck this option.
							

Note

								The Grouped by categories option groups components by type.
							
[image: CnfigsVSelectCamComponentGrouped]



	
							In the Select component dialog, scroll through the list of Camel components to find and select the component you want to add to the context file, and then enter an ID for it in the Id field.
						
[image: CnfigsVCamComponentSelected]


							In this example, the JMS component is selected and myJMS is the Id value.
						

	
							Click Finish.
						
[image: CnfigsVmyEndptAdded2]


							You can now set properties in the Properties view as needed.
						

							The tooling autofills Id with the value you entered in the component’s Id field in [globalEndptSelect]. In this example, Camel builds the uri (required field) starting with the component’s schema (in this case, jms:), but you must specify the destinationName and the destinationType to complete the component’s uri.
						
Note

								For the JMS component, the destination type defaults to queue. This default value does not appear in the uri field on the Details page until you have entered a value in Destination Name (required field).
							


	
							To complete the component’s uri, click Advanced.
						
	
							In the Destination Name field, enter the name of the destination endpoint (for example, FOO.BAR). In the Destination Type field, enter the endpoint destination’s type (for example, queue, topic, temp:queue, or temp:topic).
						
[image: JMSCompAdvanPathProp]


							The Properties view’s Details and Advanced tabs provide access to all properties available for configuring a particular component.
						

	
							Click the Consumer (advanced) tab.
						
[image: JMSCompConsumerAdvanProps2]


							Enable the properties Eager Loading Of Properties and Expose Listener Session.
						

	
							In the route editor, switch to the Source tab to see the code that the tooling added to the context file (in this example, a configured JMS endpoint), before the first route element.
						
[image: CnfigsEndptSourceView]


	
							When done, save your changes by selecting File → Save on the menu bar.
						



Adding a global data format



	
							In the Create a new global element dialog, select Data Format and click OK to open the Create a global Data Format dialog.
						
[image: CnfigsVCreateGlobalDF1]


							The data format defaults to avro, the format at the top of the list of those available.
						

	
							Open the Data Format drop-down menu, and select the format you want, for example, xmljson.
						
	
							In the Id field, enter a name for the format, for example, myDataFormat).
						
[image: CnfigsVCreateGlobalDF2]


	
							Click Finish.
						
[image: CnfigsVEditGlobalDFprops1]


	
							In the Properties view, set property values as appropriate for your project, for example:
						
[image: CnfigsVEditGlobalDFprops2]


	
							In the route editor, click the Source tab to see the code that the tooling added to the context file. In this example, a configured xmljson data format is before the first route element.
						
[image: CnfigsVGlobalDFSourceV]


	
							When done, save your changes by selecting File → Save on the menu bar.
						



Adding a global bean




					A global bean enables out-of-route bean definitions that can be referenced from anywhere in the route. When you copy a Bean component from the palette to the route, you can find defined global beans in the Properties view’s Ref dropdown. Select the global bean that you want the Bean component to reference.
				

					To add a global bean element:
				
	
							In the Create a new global element window, select Bean and click OK to open the Bean Definition dialog.
						
[image: CnfigsVCreateGlobalBean1]


	
							In the Id field, enter an ID for the global bean, for example, TransformBean. The ID must be unique in the configuration.
						
	
							Identify a bean class or a factory bean.
						

							To specify a factory bean, you must have already added another global bean with a factory class specified. You can then select that global bean to declare it as a global bean factory. One instance of the bean factory class will be in the runtime. Other global beans can call factory methods on that class to create their own instances of other classes.
						

							To fill the Class field, do one of the following:
						
	
									Enter the name of a class that is in the project or in a referenced project.
								
	
									Click …​ to navigate to and select a class that is in the project or in a referenced project.
								
	
									Click + to define a new bean class and add it as a global bean.
								



	
							If the bean you are adding requires one or more arguments, in the Constructor Arguments section, for each argument:
						
	
									Click Add.
								
	
									Optionally, in the Type field, enter the type of the argument. The default is java.lang.String.
								
	
									In the Value field, enter the value of the argument.
								
	
									Click OK.
								



	
							Optionally specify one or more properties that are accessible to the global bean. In the Bean Properties section, do the following for each property:
						
	
									Click Add.
								
	
									In the Name field, enter the name of the property.
								
	
									In the Value field, enter the value of the property.
								
	
									Click OK.
								



	
							Click Finish to add the global bean to the configuration. The global bean ID you specified appears in the Configurations tab, for example:
						
[image: CnfigsBeanInList]


	
							Switch to the Source tab to see the bean element that the tooling added to the context file. For example:
						
[image: CnfigsBeanSourceV]


	
							Click the Configurations tab to return to the list of global elements and select a global bean to display its standard properties in the Properties view, for example:
						
[image: CnfigsBeanProperties]

Note

								To view or edit a property that you specified when you added a global bean, select the bean in the Configurations tab and then click Edit.
							


	
							Set global bean properties as needed:
						
	
									Depends-on is a string that you can use to identify a bean that must be created before this global bean. Specify the ID (name) of the depended on bean. For example, if you are adding the TransformBean and you set Depends-on to ChangeCaseBean then ChangeCaseBean must be created and then TransformBean can be created. When the beans are being destroyed then TransformBean is destroyed first.
								
	
									Factory-method is useful only when the global bean is a factory class. In this situation, specify or select a static factory method to be called when the bean is referenced.
								
	
									Scope is singleton or prototype. The default, singleton, indicates that Camel uses the same instance of the bean each time the bean is called. Specify prototype when you want Camel to create a new instance of the bean each time the bean is called.
								
	
									Init-method lets you specify or select which of the bean’s init() methods to call when the bean is referenced.
								
	
									Destroy-method lets you specify or select which of the bean’s destory methods to call when the processing performed by the bean is done.
								



	
							When done, save your changes by selecting File → Save on the menu bar.
						



Deleting a global element




					The procedure is the same whether removing an endpoint, data format or bean that was previously added to the routing context.
				
Note

						You cannot perform an undo operation for deletion of a global element. If you inadvertently delete a global element that you want to keep in the configuration you might be able to undo the deletion by closing the context file without saving it. If this is not feasible then re-add the inadvertently deleted global element.
					

	
							In the Configurations tab, select the global element that you want to delete.
						

							For example, suppose you want to delete the data format myDataFormat that was added in the section called “Adding a global data format”:
						
[image: CnfigsVDFSelectDelete]


	
							Click Delete.
						

							The global element myDataFormat disappears from the Configurations tab.
						

	
							Switch to the Source tab to check that the tooling removed the XML code from the routing context.
						
[image: CnfigsDelDFSourceV]


	
							When done, save your changes by selecting File → Save on the menu bar.
						



Editing a global element




					The procedure is the same whether modifying the properties of an endpoint, data format or bean that you added to the routing context.
				

					Typically, you do not want to change the ID of a global element. If the global element is already in use in a running route, changing the ID can break references to the global element.
				
	
							In the Configurations tab, select the global element that you want to edit.
						

							For example, to edit the endpoint myJMS that was added in the section called “Adding a global endpoint”, select it:
						
[image: CnfigsVEndptEditSelect]


	
							Click Edit.
						
[image: CnfigsVEndptClickEdit]


							In the Properties view, modify the element’s properties as needed.
						

	
							For example, open the Advanced → Consumer tab, and change the value of Concurrent Consumers to 2:
						
[image: CnfigsEditEndpntConcurConsume2]


	
							In the route editor, click the Source tab and check that the tooling added the property concurrentConsumers=2 to the routing context:
						
[image: CnfigsVEndptEditSourceV]


	
							When done, save your changes by selecting File → Save on the menu bar.
						




Configuring the route editor



Overview




					Using Fuse preference settings, you can specify options for the route editor’s behavior and user interface:
				
	
							The default language to use for expressions in Enterprise Integration Patterns (EIPs)
						
	
							The direction (to the right or down) in which patterns flow on the Design canvas when you create routes
						
	
							Whether the Design canvas displays a grid overlay in the background of the canvas.
						
	
							The method for labeling nodes on the Design canvas
						



Procedure




					To configure the route editor:
				
	
							Open the Editor preferences window:
						
	
									On Linux and Windows machines, select Windows → Preferences → Fuse Tooling → Editor.
								
	
									On OS X, select CodeReady Studio → Preferences → Fuse Tooling → Editor.
								

									[image: PreferencesEditor]

								




	
							To select the default language that you want to use for expressions in Enterprise Integration Pattern (EIP) components, select a language from the drop-down list. The default is Simple.
						
	
							To specify the direction in which you want the route editor to align the patterns in a route, select Down or Right. The default is Down.
						
	
							To enable or disable displaying a grid overlay on the background of the canvas, check the box next to Show diagram grid in Routes Editor. The default is enabled.
						
	
							To enable or disable using component IDs as labels in the route editor’s Design tab, check the box next to Use ID values for component labels. The default is disabled.
						

							If you check this option and also specify a preferred label for a component (see Step 6), then the preferred label is used for that component instead of the ID value.
						

	
							To use a parameter as the label for a component (except for endpoints, such as File nodes) in the route editor’s Design tab:
						
	
									In the Preferred labels section, click Add. The New Preferred Label dialog opens.
								

									[image: NewPreferredLabel]

								

	
									Select a Component and then select the Parameter to use as the label for the component.
								
	
									Click OK. The component and parameter pairs are listed in the Editor Preferences window.
								

									[image: PreferredLabelsList]

								

									You can optionally Edit and Remove component labels.
								
Note

										If you check the Use ID values for component labels option, it applies to all components except for the components listed in the Preferred labels section.
									





	
							Click Apply and Close to apply the changes to the Editor preferences and close the Preferences window.
						


Note

						You can restore the route editor’s original defaults at any time by returning to the Editor preferences dialog and clicking Restore Defaults.
					




Chapter 3. Viewing and editing Rest DSL components




				Apache Camel supports multiple approaches to defining REST services. In particular, Apache Camel provides the REST DSL (Domain Specific Language), which is a simple but powerful API that can be layered over any REST component and provides integration with the OpenAPI 2.0 specification. OpenAPI (formerly Swagger) is a vendor-neutral and portable open description format for API services.
			

				For information about using the Camel Rest DSL, see the “Defining REST services” chapter of the Apache Camel Development Guide.
			

				With the Fuse Tooling, you can view and edit Rest DSL components that are in your Camel Context file.
			

				You can also configure your Fuse Integration project to expose your REST API to an OpenAPI client as described here: https://access.redhat.com/articles/4296981.
			
Viewing a graphical representation of Rest DSL components




					To view the REST DSL components in your Camel Context file in graphical mode:
				
	
							Open the Camel Context file in the route editor.
						
	
							Click the REST tab to the view the Rest DSL components.
						
[image: RESTtab]


							The REST Configuration section displays these configuration options:
						
	
									Component — The Camel component to use for the REST transport.
								
	
									Context Path — The leading context-path for the REST services. You can use this option for components, such as Servlet, where the web application is deployed using a context-path.
								
	
									Port — The port number that exposes the REST service.
								
	
									Binding Mode — The binding mode for JSON or XML format messages. Possible values are: off (the default), auto, json, xml, or json_xml.
								
	
									Host — The hostname to use for exposing the REST service.
								



	
							Click a REST element to view its associated operations (for example, GET, POST, PUT, and DELETE) in the REST Operations section.
						
	
							Click a REST element or a REST operation to view its properties in the Properties view.
						
[image: RESTproperties]





Editing Rest DSL components in the graphical view




					You can add, edit, or delete REST elements in your project’s Camel Context file in the REST tab.
				
	
							To add a new REST element:
						
	
									In the REST elements section, click the + button. A REST element is added to the list of REST elements.
								
	
									In the Properties view, edit the REST element properties.
								
[image: RESTAddElement2]





	
							To add a REST operation to a REST element:
						
	
									In the list of REST elements, select a REST element.
								
	
									In the REST operations section, click the + button.

								

									The Add REST Operation dialog box opens.
								
[image: RESTAddOperation]


	
									Specify the ID, URI, and Operation Type. Optionally, select a Referenced Route ID.
								
	
									Click Finish. The new operation shows in the list of REST operations for the selected REST element.
								



	
							To edit a REST element or operation, select it in the REST tab and then edit its property values in the Properties tab.
						
	
							To remove a selected REST element or operation, click the x button.
						



Viewing and editing the Rest DSL source code




					You can also view and edit Rest DSL components in the Source tab:
				
	
							Open the Camel Context file in the route editor.
						
	
							Click the route editor’s Source tab and then edit the code.
						
[image: RESTsourcetab]


	
							Optionally, click the REST tab to see the changes in the graphical view.
						
	
							To save your changes, select File → Save.
						




Chapter 4. Migrating a SOAP application to RESTful web services




				You can use the WSDL-to-Camel Rest wizard to migrate from an existing JAX-WS SOAP web services implementation to a RESTful web services implementation by using an existing WSDL. The wizard is available as part of Fuse Tooling and it is based on the wsdl2rest utility, available in Github wsdl2rest project.
			

				It supports the following specifications/configurations:
			
	
						Document/literal (doc/lit)
					
	
						Document/literal Wrapped (doc/lit wrap)
					
	
						RPC/literal (rpclit)
					


Wizard workflow




					The wizard uses a WSDL path which can be a valid URL (in the file:// URL form) or a remote URL (using http or https) and the selected Fuse project. In the wizard, you provide the paths for the generated Java code, the generated Camel configuration file, the target address for the generated camel endpoint, and the bean implementation class.
				

					The wizard generates the destination Java and Camel paths based on the project. The generated Java code is available in src/main/java and the Camel file in an appropriate location for Spring or Blueprint, such as src/main/resources/META-INF/spring.
				

					You can modify the generated classes and configure them to a certain point.
				

Prerequisites




					Before you begin, you must meet these prerequisites:
				
	
							A pre-existing Fuse Integration Project. You can create a new project using the File→ New→ Fuse Integration Project wizard.
						
	
							A WSDL file accessible through URL. It can be local (file:// url) or remote (http or https).
						



Migrating a sample SOAP application to RESTful web services




					Follow these steps to run the wizard:
				
	
							In CodeReady Studio, select your Fuse project in the Project Explorer view.
						
	
							Right-click on the Fuse project and then select New → Camel Rest DSL from WSDL.
						

							The Select Incoming WSDL and Project for Generated Output page opens. The Destination Project field is automatically pre-populated with the Fuse project selected in the Project Explorer. This project is the destination for the artifacts that the wizard generates.
						
[image: wsdl to rest p1]


	
							For WSDL File, specify the original SOAP service for processing.
						
	
							Click Next. The Specify Advanced Options for WSDL-to-REST Processing page appears.
						
[image: wsdl to rest p2]

	
									For Destination Java Folder, specify the location of the CXF-generated Java classes.
								
	
									For Destination Camel Folder, specify the location of the generated Camel Rest DSL configuration file.
								
Note

										The path and name of the generated Camel file varies based on the type of Camel project:
									
	
												For Spring projects: src/main/resources/META-INF/rest-camel-context.xml
											
	
												For Spring Boot projects: src/main/resources/spring/rest-springboot-context.xml
											
	
												For Blueprint projects: src/main/resources/OSGI-INF/rest-blueprint-context.xml
											




	
									Optionally, for Target Service Address provide the SOAP address specified in the WSDL binding. You can change this option to match the actual address of the SOAP service referenced by the WSDL.
								
	
									Optionally, for Target REST Service Address provide the URL for accessing the REST service. This URL is decomposed into settings for the <restConfiguration> and <rest> tags in the Rest DSL to specify the complete URL for REST operations mapped to the SOAP service.
								



	
							Click Finish to create two files as the output:
						
	
									The Camel configuration with Rest DSL.
								
	
									Java classes from CXF to wrap the SOAP service.
								







Chapter 5. Creating a new Apache Camel JUnit test case



Overview




				A common way of testing routes is to use JUnit. The design time tooling includes a wizard that simplifies creating a JUnit test case for your routes. The wizard uses the endpoints you specify to generate the starting point code and configuration for the test.
			
Note

					After you create the boilerplate JUnit test case, you need to modify it to add expectations and assertions specific to the route that you’ve created or modified, so the test is valid for the route.
				


Prerequisites




				Before you create a new JUnit test case, you need to perform a preliminary task:
			
	
						If you are replacing an existing JUnit test case, you need to delete it before you create a new one. See the section called “Deleting and existing JUnit test case”.
					
	
						If you are creating a new JUnit test case in a project that hasn’t one, you need to first create the project_root/src/test/java folder for the test case that is included in the build path. See the section called “Creating and adding the src/test/java folder to the build path”.
					



Deleting and existing JUnit test case



	
						In the Project Explorer view, expand the project’s root node to expose the <root_project>/src/test/java folder.
					
	
						Locate the JUnit test case file in the /src/test/java folder.
					

						Depending on which DSL the project is based on, the JUnit test case file is named BlueprintXmlTest.java or CamelContextXmlTest.java.
					

	
						Right-click the JUnit test case .java file to open the context menu, and then select Delete.
					

						The JUnit test case .java file disappears from the Project Explorer view.
					

						You can now create a new JUnit test case.
					




Creating and adding the src/test/java folder to the build path



	
						In the Project Explorer view, right-click the project’s root to open the context menu.
					
	
						Select New → Folder to open the Create a new folder resource wizard.
					
	
						In the wizard’s project tree pane, expand the project’s root node and select the src folder.
					

						Make sure <project_root>/src appears in the Enter or select the parent folder field.
					

	
						In Folder name, enter /test/java. This folder will store the new JUnit test case you create.
					
	
						Click Finish.
					

						In the Project Explorer view, the new src/test/java folder appears under the src/main/resources folder. You can verify that this folder is on the class path by opening its context menu and selecting Build Path. If Remove from Build Path is a menu option, you know the src/test/java folder is on the class path.
					

						You can now create a new JUnit test case.
					




Creating a JUnit test case




				To create a new JUnit test case for your route:
			
	
						In the Project Explorer view, select the routing context .xml file in your project.
					
	
						Right-click it to open the context menu, and then select New → Camel Test Case to open the New Camel JUnit Test Case wizard, as shown in Figure 5.1, “New Camel JUnit Test Case wizard”.
					
Figure 5.1. New Camel JUnit Test Case wizard
[image: Entry page of the New Camel JUnit Test Case wizard]



						Alternatively, you can open the wizard by selecting File → New → Other > Fuse > Camel Test Case from the menu bar.
					

	
						In Source folder, accept the default location of the source code for the test case, or enter another location.
					

						You can click 
						[image: Browse button]
						 to search for a location.
					

	
						In Package, accept the default package name for the generated test code, or enter another package name.
					

						You can click 
						[image: Browse button]
						 to search for a package.
					

	
						In Camel XML file under test, accept the default pathname of the routing context file that contains the route you want to test, or enter another pathname.
					

						You can click 
						[image: Browse button]
						 to search for a context file.
					

	
						In Name, accept the default name for the generated test class, or enter another name.
					
	
						Select the method stubs you want to include in the generated code.
					
	
						If you want to include the default generated comments in the generated code, check the Generate comments box.
					
	
						Click 
						[image: Next button]
						 to open the Test Endpoints page. For example, Figure 5.2, “New Camel JUnit Test Case page” shows a route’s input and output file endpoints selected.
					
Figure 5.2. New Camel JUnit Test Case page
[image: Example Test Endpoints page]



	
						Under Available endpoints, select the endpoints you want to test. Click the checkbox next to any selected endpoint to deselect it.
					
	
						Click 
						[image: Finish button]
						 .
					
Note

							If prompted, add JUnit to the build path.
						





				The artifacts for the test are added to your project and appear in the Project Explorer view under src/test/java. The class implementing the test case opens in the Java editor.
			


Chapter 6. Running routes inside Red Hat Fuse Tooling




				There are two ways to run your routes using the tooling:
			
	
						the section called “Running routes as a local Camel context”
					
	
						the section called “Running routes using Maven”
					


Running routes as a local Camel context



Overview




					The simplest way to run an Apache Camel route is as a Local Camel Context. This method enables you to launch the route directly from the Project Explorer view’s context menu. When you run a route from the context menu, the tooling automatically creates a runtime profile for you. You can also create a custom runtime profile for running your route.
				

					Your route runs as if it were invoked directly from the command line and uses Apache Camel’s embedded Spring container. You can configure a number of the runtime parameters by editing the runtime profile.
				

Procedure




					To run a route as a local Camel context:
				
	
							In the Project Explorer view, select a routing context file.
						
	
							Right-click it to open the context menu, and then select Run As → Local Camel Context.
						
Note

								Selecting Local Camel Context (without tests) directs the tooling to run the project without performing validation tests, which may be faster.
							





Result




					The Console view displays the output generated from running the route.
				

Related topics



	
							the section called “Editing a Local Camel Context runtime profile”
						




Running routes using Maven



Overview




					If the project containing your route is a Maven project, you can use the m2e plug-in to run your route. Using this option, you can execute any Maven goals, before the route runs.
				

Procedure




					To run a route using Maven:
				
	
							In the Project Explorer view, select the root of the project .
						
	
							Right-click it to open the context menu, and then select Run As → Maven build.
						
	
									The first time you run the project using Maven, the Edit Configuration and launch editor opens, so you can create a Maven runtime profile.
								

									To create the runtime profile, on the Maven tab:
								
	
											Make sure the route directory of your Apache Camel project appears in the Base directory: field.
										

											For example, on Linux the root of your project is similar to ~/workspace/simple-router.
										

	
											In the Goals: field, enter camel:run.
										
Important

												If you created your project using the Java DSL, enter exec:java in the Goals: field.
											


	
											Click Apply and then Run.
										



	
									Subsequent Maven runs use this profile, unless you modify it between runs.
								






Results




					The Console view displays the output from the Maven run.
				

Related topics



	
							the section called “Editing a Maven runtime profile”
						




Working with runtime profiles




					Red Hat Fuse Tooling stores information about the runtime environments for each project in runtime profiles. The runtime profiles keep track of such information as which Maven goals to call, the Java runtime environment to use, any system variables that need to be set, and so on. A project can have more than one runtime profile.
				
Editing a Local Camel Context runtime profile



Overview




						A Local Camel Context runtime profile configures how Apache Camel is invoked to execute a route. A Local Camel Context runtime profile stores the name of the context file in which your routes are defined, the name of the main to invoke, the command line options passed into the JVM, the JRE to use, the classpath to use, any environment variables that need to be set, and a few other pieces of information.
					

						The runtime configuration editor for a Local Camel Context runtime profile contains the following tabs:
					
	
								Camel Context File — specifies the name of the new configuration and the full path of the routing context file that contains your routes.
							
	
								JMX — specifies JMX connection details, including the JMX URI and the user name and password (optional) to use to access it.
							
	
								Main — specifies the fully qualified name of the project’s base directory, a few options for locating the base directory, any goals required to execute before running the route, and the version of the Maven runtime to use.
							
	
								JRE — specifies the JRE and command line arguments to use when starting the JVM.
							
	
								Refresh — specifies how Maven refreshes the project’s resource files after a run terminates.
							
	
								Environment — specifies any environment variables that need to be set.
							
	
								Common — specifies how the profile is stored and the output displayed.
							



						The first time an Apache Camel route is run as a Local Camel Context, Red Hat Fuse Tooling creates for the routing context file a default runtime profile, which should not require editing.
					

Accessing the Local Camel Context’s runtime configuration editor



	
								In the Project Explorer view, select the Camel context file for which you want to edit or create a custom runtime profile.
							
	
								Right-click it to open the context menu, and then select Run As → Run Configurations to open the Run Configurations dialog.
							
	
								In the context selection pane, select Local Camel Context, and then click 
								[image: New profile icon]
								 at the top, left of the context selection pane.
							
	
								In the Name field, enter a new name for your runtime profile.
							


Figure 6.1. Runtime configuration editor for Local Camel Context
[image: Local camel context runtime configuration editor]



Setting the camel context file




						The Camel Context File tab has one field, Select Camel Context file…​. Enter the full path to the routing context file that contains your route definitions.
					

						The Browse button accesses the Open Resource dialog, which facilitates locating the target routing context file. This dialog is preconfigured to search for files that contain Apache Camel routes.
					

Changing the command line options




						By default the only command line option passed to the JVM is:
					
-fa context-file

						If you are using a custom main class you may need to pass in different options. To do so, on the Main tab, click the Add button to enter a parameter’s name and value. You can click the Add Parameter dialog’s Variables…​ button to display a list of variables that you can select.
					

						To add or modify JVM-specific arguments, edit the VM arguments field on the JRE tab.
					

Changing where output is sent




						By default, the output generated from running the route is sent to the Console view. But you can redirect it to a file instead.
					

						To redirect output to a file:
					
	
								Select the Common tab.
							
	
								In the Standard Input and Output pane, click the checkbox next to the Output File: field, and then enter the path to the file where you want to send the output.
							

								The Workspace, File System, and Variables buttons facilitate building the path to the output file.
							




Related topics



	
								the section called “Running routes as a local Camel context”
							




Editing a Maven runtime profile



Overview




						A Maven runtime profile configures how Maven invokes Apache Camel. A Maven runtime profile stores the Maven goals to execute, any Maven profiles to use, the version of Maven to use, the JRE to use, the classpath to use, any environment variables that need to be set, and a few other pieces of information.
					
Important

							The first time an Apache Camel route is run using Maven, you must create a default runtime profile for it.
						


						The runtime configuration editor for a Fuse runtime profile contains the following tabs:
					
	
								Main — specifies the name of the new configuration, the fully qualified name of the project’s base directory, a few options for locating the base directory, any goals required to execute before running the route, and the version of the Maven runtime to use.
							
	
								JRE — specifies the JRE and command line arguments to use when starting the JVM.
							
	
								Refresh — specifies how Maven refreshes the project’s resource files after a run terminates.
							
	
								Source — specifies the location of any additional sources that the project requires.
							
	
								Environment — specifies any environment variables that need to be set.
							
	
								Common — specifies how the profile is stored and the output displayed.
							



Accessing the Maven runtime configuration editor



	
								In the Project Explorer view, select the root of the project for which you want to edit or create a custom runtime profile.
							
	
								Right-click it to open the context menu, and then select Run As → Run Configurations to open the Run Configurations dialog.
							
	
								In the context selection pane, select Maven Build, and then click 
								[image: New profile icon]
								 at the top, left of the context selection pane.
							


Figure 6.2. Runtime configuration editor for Maven
[image: Maven runtime configuration editor]



Changing the Maven goal




						The most commonly used goal when running a route is camel:run. It loads the routes into a Spring container running in its own JVM.
					

						The Apache Camel plug-in also supports a camel:embedded goal that loads the Spring container into the same JVM used by Maven. The advantage of this is that the routes should bootstrap faster.
					

						Projects based on Java DSL use the exec:java goal.
					

						If your POM contains other goals, you can change the Maven goal used by clicking the Configure…​ button next to the Maven Runtime field on the Main tab. On the Installations dialog, you edit the Global settings for <selected_runtime> installation field.
					

Changing the version of Maven




						By default, Red Hat Fuse Tooling for Eclipse uses m2e, which is embedded in Eclipse. If you want to use a different version of Maven or have a newer version installed on your development machine, you can select it from the Maven Runtime drop-down menu on the Main tab.
					

Changing where the output is sent




						By default, the output from the route execution is sent to the Console view. But you can redirect it to a file instead.
					

						To redirect output to a file:
					
	
								Select the Common tab.
							
	
								Click the checkbox next to the Output File: field, and then enter the path to the file where you want to send the output.
							

								The Workspace, File System, and Variables buttons facilitate building the path to the output file.
							




Related topics



	
								the section called “Running routes using Maven”
							






Chapter 7. Getting Started with Fuse on OpenShift




				Fuse on OpenShift (the name for Fuse Integration Services since 7.0) enables you to deploy Fuse applications on OpenShift Container Platform.
			
Important

					For Fuse Integration projects (Fuse on OpenShift projects), Fuse Tooling requires installation of the Red Hat Container Development Kit (CDK) v3.x. See the Getting Started Guide for instructions. In addition to the prerequisites specified in this guide, you need to establish a Red Hat account if you do not have one. Your Red Hat user name and password are required to start the virtual OpenShift instance provided in the Red Hat Container Development Kit.
				

					You can easily get an account by registering on the Red Hat Customer Portal. Click 
					[image: Account]
					 in the upper right corner of the white banner, and then click 
					[image: RH acctRegBut]
					 on the Login to Your Red Hat Account page.
				


				Fuse Tooling enables you to develop and deploy Fuse Integration projects using the s2i binary workflow. In this workflow, the tooling builds your project locally, assembles it into an image stream, then pushes the image stream to OpenShift, where it is used to build the Docker container. Once the Docker container is built, OpenShift deploys it in a pod.
			
Important

					Fuse Tooling works only with the S2I binary workflow and only with projects based on the Spring Boot framework.
				

Note

					Although Fuse Tooling can deploy Fuse Integration projects created using the tooling to remote OpenShift servers, this chapter describes creating and deploying Fuse Integration projects to a virtual OpenShift instance, installed locally using the Red Hat Container Development Kit (CDK) v3.x.
				


				The following sections describe how to create and deploy your first Fuse Integration project:
			
	
						the section called “Adding the Red Hat Container Development Kit server”
					
	
						the section called “Starting the Container Development Environment (CDE) and virtual OpenShift server”
					
	
						the section called “Creating a new OpenShift project”
					
	
						the section called “Creating a new Fuse Integration project”
					
	
						the section called “Deploying the Fuse Integration project to OpenShift”
					


Note

					You can also run a Fuse Integration project as a local Camel context, see the section called “Running routes as a local Camel context”, and then connect to it in the JMX Navigator view, where you can monitor and test the routing context. You can also run the Camel debugger on a Fuse Integration project (Part II, “Debugging Routing Contexts”) to expose and fix any logic errors in the routing context.
				

Adding the Red Hat Container Development Kit server




					To add the Red Hat Container Development Kit to the Servers view:
				
	
							If necessary, switch to the Fuse Integration perspective by selecting Window → Perspective → Open Perspective → Fuse Integration.
						
Note

								If a view that is described in this procedure is not open, you can open it by selecting Window → Show View → Other and then select the name of the view that you want to open.
							


	
							In the Servers view, click the link No servers are available. Click this link to create a new server…​ to open the Define a New Server wizard. This link appears only when the Servers view contains no server entry.
						

							Otherwise, right-click in the Servers view to open the context menu, and then select New → Server to open the Define a New Server wizard.
						
[image: DefNewSrvCDK]


	
							Select Red Hat JBoss Middleware → Red Hat Container Development Kit 3.2+.
						

							Accept the defaults for:
						
	
									Server’s hostname — localhost
								
	
									Server name — Container Development Environment
								



	
							Click Next to open the Red Hat Container Development Environment page.
						
	
							Next to MiniShift Binary, click Browse, navigate to the location where you installed the Red Hat Container Development Kit 3.x and then click Open.
						
	
							Next to Username, click Add to open the Add a Credential page.
						
	
							Set the credentials this way:
						
	
									Username — Enter the name you use to log into your Red Hat account.
								
	
									Always prompt for password — Leave as is (disabled).
								
	
									Password — Enter the password you use to log into your Red Hat account.
								



	
							Click OK to return to the Red Hat Container Development Environment page, which is now populated. For example:
						
[image: CDEdefUserFolder3]


	
							Click Finish. Container Development Environment 3.2+ [Stopped, Synchronized] appears in the Servers view. Container Development Environment 3.2+ is the default server name when you add a CDK 3.x server.
						



Starting the Container Development Environment (CDE) and virtual OpenShift server




					Starting the Container Development Environment (CDE) also starts the virtual OpenShift server. Stopping the CDE also stops the virtual OpenShift server.
				
	
							In the Servers view, select Container Development Environment 3 [stopped, Synchronized], and then click 
							[image: run exec]
							 on the Servers menu bar.
						

							Console view opens and displays the status of the startup process:
						
[image: CDEstartTerminal]

Note

								On initial startup, the CDE asks whether you accept the untrusted SSL certificate. Click Yes.
							


							When the startup process has finished, the Servers view displays:
						
[image: CDEsrvStartedSyncd]


	
							Switch to the OpenShift Explorer view.
						

							The virtual OpenShift server instance, developer, is also running:
						
[image: OSEopenshift devAutostart]


							https://192.168.99.100:8443 is an example of a URL for the OpenShift developer web console. Your installation displays the URL for your instance. For more details, see the section called “Accessing the OpenShift web console”.
						




Creating a new OpenShift project




					When you deploy your Fuse Integration project to OpenShift, it is published to the OpenShift project you create here.
				
	
							In the OpenShift Explorer view, right-click the developer entry, to open the context menu.
						
	
							Select New → Project to open the New OpenShift Project wizard.
						
	
							Set the new project’s properties this way:
						
	
									In the Project Name field, enter the name for the project’s namespace on the virtual OpenShift server.
								

									Only lower case letters, numbers, and dashes are valid.
								

	
									In the Display Name field, enter the name to display on the virtual OpenShift web console’s Overview page.
								
	
									Leave the Description field as is.
								

									For example:
								
[image: New Project]





	
							Click Finish.
						

							The new OpenShift project (in this example, New FIS Test newtest) appears in the OpenShift Explorer tab, under, in this example, developer https://192.168.99.100:8443:
						
[image: OSEnewFISprojCreated]

Note

								MyProject myproject is an initial example project included with OpenShift.
							


							With New FIS Test newtest selected in the OpenShift Explorer view, the Properties view displays the project’s details. For example:
						
[image: OSEnewFISprojProps]

Note

								When you deploy the project to OpenShift, the Properties view gathers and displays the same information about the project that the OpenShift web console does.
							





Creating a new Fuse Integration project




					Before you create a new Fuse Integration project, you should enable staging repositories. This is needed because some Maven artifacts are not in default Maven repositories. To enable staging repositories, select Window → Preferences → Fuse Tooling → Staging Repositories.
				

					To create a Fuse Integration project, use the Spring Boot on OpenShift template:
				
	
							In the Project Explorer view, right-click to open the context menu and then select New → Fuse Integration Project to open the wizard’s Choose a project name page:
						
[image: New Fuse Integration Project]


	
							In the Project Name field, type a name that is unique to the workspace you are using, for example, myFISproject.
						

							Accept the defaults for the other options.
						

	
							Click Next to open the Select a Target Runtime page:
						
[image: New Project Camel Version]


							Leave the defaults for Target Runtime (No Runtime selected) and Camel Version.
						

	
							Click Next to open the Advanced Project Setup page:
						
[image: Advanced Project Setup]


	
							Select the Simple log using Spring Boot - Spring DSL template.
						
[image: Advanced Project Templates]


	
							Click Finish.
						
Note

								Because of the number of dependencies that are downloaded for a first-time Fuse Integration project, building it can take some time.
							

								If the Fuse Integration perspective is not already open, Developer Studio prompts you to indicate whether you want to open it now. Click Yes.
							





					When the build is done the Fuse Integration perspective displays the project, for example:
				
[image: FIS ProjCreatedFIP]


					At this point, you can:
				
	
							Deploy the project on OpenShift
						
	
							the section called “Running routes as a local Camel context” to verify that the routing context runs successfully on your local machine
						

							Connecting to the running context in the JMX Navigator view (see the section called “Viewing processes in a local JMX server”), you can monitor route components and test whether the route performs as expected:
						
	
									View a route component’s JMX statistics — see Chapter 21, Viewing a component’s JMX statistics.
								
	
									Edit the running route — see Chapter 25, Managing routing endpoints.
								
	
									Suspend/resume the running route — see Chapter 27, Managing routing contexts
								
	
									Start/stop tracing on the running route — see Chapter 23, Tracing Routes
								



	
							Run the Camel debugger on the project’s camel-context.xml file to discover and fix logic errors — see Part II, “Debugging Routing Contexts”
						



Deploying the Fuse Integration project to OpenShift



	
							In the Project Explorer view, right-click the project’s root (in this example, myFISproject) to open the context menu.
						
	
							Select Run As → Run Configurations to open the Run Configurations wizard.
						
	
							In the sidebar menu, select Maven Build → Deploy <projectname> on OpenShift (in this example, Deploy myFISproject on OpenShift) to open the project’s default run configuration:
						
[image: FIS RunCnfgMain]


							Leave the default settings as they are on the Main tab.
						

	
							Open the JRE tab to access the VM arguments:
						
[image: FIS RunCfgJRE]


	
							In the VM arguments pane, change the value of the -Dkubernetes.namespace=test argument to match the project name that you used for the OpenShift project when you created it (OpenShift project name in the section called “Creating a new OpenShift project”.
						

							In this example, change the default value test to newtest:
						
[image: FIS RunCfgVMargsChg]


							Depending on your OpenShift configuration, you may need to modify other`VM arguments to support it:
						
	
									-Dkubernetes.master=https://192.168.99.1:8443
								

									When running multiple OpenShift instances or using a remote instance, you need to specify the URL of the OpenShift instance targeted for the deployment. The URL above is an example.
								

	
									-Dkubernetes.trust.certificates=true
								
	
											When using the CDK, this argument is required. Leave it set to true.
										
	
											If you are using an OpenShift instance that has a valid SSL certificate, change the value of this argument to false.
										






	
							Click Apply and then click Run.
						

							Because of the number of dependencies to download, first-time deployment can take some time. The speed of your computer and your internet connection are contributing factors. Typically, it takes 25 to 35 minutes to complete a first-time deployment.
						

							In the Console view, you can track the progress of the deploy process. In the following output, the entry *Pushing image 172.30.1 …​.. * indicates that the project built successfully and the application images are being pushed to OpenShift, where they will be used to build the Docker container.
						
[image: FIS ConLogSuccess1]


							The Console view displays BUILD SUCCESS when deployment completes successfully:
						
[image: FIS ConLogSuccess2]


	
							Switch to the OpenShift Explorer view and select New FIS Test newtest:
						
[image: OSE NewFISTestDeploy1]


							In the Properties view, the Details page displays all of the project’s property values.
						
[image: OSEnewFISprojProps]


							Open the other tabs (Builds, Build Configs, Deployments,…​) to view other properties of the project. The Properties view provides the same information as the OpenShift Web Console.
						

	
							In the OpenShift Explorer view, select camel-ose-springboot-xml to view its details in the Properties view:
						
[image: NFT camxmlPropsDetails]


							Scroll through the other tabs to view other properties of the deployment configuration.
						

	
							In the OpenShift Explorer view, select camel-ose-springboot-xml-1-mdmtd Pod Running, and then view the details of the running instance in the Properties view:
						
[image: NFT ImageStreamPropsDetails]


	
							In the OpenShift Explorer view, right-click camel-ose-springboot-xml-1-mdmtd Pod Running, and then select Pod Logs…​.
						
Note

								If prompted, enter the path to the installed oc executable. It is required to retrieve pod logs.
							


							The Console view automatically opens, displaying the logs from the running pod:
						
[image: OSE podLogsDisplayed]


							Click 
							[image: Close]
							 in the Console view’s menu bar to terminate the session and clear console output.
						




Accessing the OpenShift web console



Note

						This information applies to Red Hat Container Development Kit installations only.
					


					To access the OpenShift web console, open a browser and enter the OpenShift server’s URL, which is specific to your instance and your machine. For example, enter https://192.168.99.100:8443, in the browser’s address field.
				

					You can log into the web console either as a developer or as an administrator, using the default credentials:
				
	
							Default developer role
						

							Developer users can view only their own projects and the supplied OpenShift sample project, which demonstrates OpenShift v3 features. Developer users can create, edit and delete any project that they own that is deployed on OpenShift.
						
	
									Username - developer
								
	
									Password - developer
								



	
							Default administrator role
						

							An administrator user can view and access all projects on OpenShift (CDK). Administrator users can create, edit and delete, any project deployed on OpenShift.
						
	
									Username - admin
								
	
									Password - admin
								






					For more information on using the OpenShift web console, see Getting Started Guide.
				


Chapter 8. Using the Red Hat Fuse SAP Tool Suite




				The Red Hat Fuse SAP Tool Suite makes it possible to integrate your Camel routes with a remote SAP Application Server. A variety of SAP components are provided to support Remote Function Calls (RFC) and the sending and receiving of Intermediate Documents (IDocs). The SAP Tool Suite depends on the JCo and IDoc client libraries from SAP. To install and use these libraries, you must have an SAP Service Marketplace Account.
			
Installing the Red Hat Fuse SAP Tool Suite



Overview




					The Red Hat Fuse SAP Tool Suite provides the Edit SAP Connection Configuration dialog, which helps you to create and manage the SAP Application Server and Destination connections. The suite is not installed by default, because it requires third-party JCo and IDoc client libraries, which are licensed separately by SAP.
				

Platform restrictions for SAP tooling




					Because the SAP tool suite depends on the third-party JCo and IDoc libraries, it can only be installed on the platforms that these libraries support. For details about the platform restrictions for SAP tooling, see Red Hat Fuse Supported Configurations.
				

Prerequisites



	
							Before you can install the Fuse SAP Tool Suite, you must download the JCo and IDoc libraries from: http://service.sap.com/connectors
						
	
							To determine the appropriate JCo and IDoc libraries for your operating system, see the Red Hat Fuse Supported Configurations page.
						
	
							To download the JCo and IDoc libraries, you need an SAP Service Marketplace Account.
						
	
							For this installation procedure, you can leave the downloaded files in archive format. There is no need to extract the contents.
						



Procedure




					To install the Fuse SAP Tool Suite into Red Hat CodeReady Studio, perform the following steps:
				
	
							In Red Hat CodeReady Studio, select File → Import to open the Import wizard.
						
	
							In the Select screen of the Import wizard, select Fuse → Install Fuse SAP Tool Suite, and then click Next.
						
	
							The Install the Red Hat Fuse SAP Tool Suite screen opens, which displays the instructions for downloading the JCo and IDoc libraries from the SAP Service Marketplace. Click Next.
						
	
							The Select JCo and IDoc Archive to Import screen opens. Next to the JCo Archive File field, use the Browse button to select the JCo archive that you downloaded from the SAP Service Marketplace. After selecting the JCo archive, the Archive Version and Archive OS Platform fields are automatically filled in, so that you can check whether the library you are installing has the correct version and OS platform.
						

							Next to the IDoc Archive File field, use the Browse button to select the IDoc archive that you downloaded from the SAP Service Marketplace.
						

							After selecting both archive files, click Finish.
						

	
							A new Install wizard (for installing Eclipse plug-ins) opens automatically. This wizard displays the following to plug-ins to be installed:
						
	
									Fuse SAP Tool Suite
								
	
									SAP JCo and IDoc Libraries
								

									Make sure that both of these plug-ins are selected. Click Next.
								
Note

										The SAP JCo and IDoc Libraries plug-in is dynamically constructed from the selected JCo and IDoc libraries.
									





	
							The Install Details screen allows you to review the plug-ins to be installed. Click Next.
						
	
							The Review Licenses dialog opens. Select the I accept radiobutton option, and then click Finish.
						
	
							If you encounter a Security Warning dialog (warning of unsigned content), click OK to ignore the warning and continue installing.
						
	
							The Restart Eclipse dialog opens. Click OK to restart Eclipse.
						




Create and Test SAP Destination Connection



Overview




					In Fuse SAP Tool suite, the Edit SAP Connection Configuration dialog helps you to create and manage the SAP Application Destination connections. This section describes how to create and test the SAP destination connection.
				

Procedure




					To create and test an SAP destination connection, perform the following steps:
				
	
							Navigate to the global Configurations tab of the route editor and click Add.
						

							The Create new global element view appears.
						

	
							Under SAP, select the type of connection you would like to create. Choose the SAP Connection and click Ok.
						

							The Edit SAP Connection Configuration dialog appears. It allows you to create, edit and delete the Destination and Server Connection Configurations.
						

	
							To create a new Destination Data Store, click the Add Destination tab.
						

							The Create Destination dialog appears.
						

	
							Enter a name for the destination in the Destination Name field and click Ok.
						
	
							In the Properties dialog,
						
	
									Click the Basic tab to configure the basic properties required to connect to an SAP destination. In this tab, fill in the following property fields to configure the connection:
								
	
											SAP Application Server
										
	
											SAP System Number
										
	
											SAP Client
										
	
											Logon User
										
	
											Logon Password
										
	
											Logon Language
										



	
									Click the Connection tab to add values required to connect to an SAP destination. Fill in the following property fields to configure the connection:
								
	
											SAP System Number
										
	
											SAP Router String
										
	
											SAP Application Server
										
	
											SAP Message Server
										
	
											SAP Message Server Port
										
	
											Gateway Host
										
	
											Gateway Port
										
	
											SAP System ID
										
	
											SAP Application Server Group
										



	
									Click the Authenticate tab to add values required to validate an SAP destination. Fill in the following property fields to configure the connection.
								
	
											SAP Authentication type
										
	
											SAP Client
										
	
											Logon User
										
	
											Logon User Alias
										
	
											Logon Password
										
	
											SAP SSO Logon Ticket
										
	
											SAP X509 Login Ticket
										
	
											Logon Language
										



	
									Click the Special tab. In this tab, fill in the following property fields to configure the connection:
								
	
											Select CPIC Trace
										
	
											Initial Codepage
										



	
									Click the Pool tab and fill in the following property fields to configure the connection:
								
	
											Connection Pool Peak Limit
										
	
											Connection Pool Capacity
										
	
											Connection Pool Expiration Time
										
	
											Connection Pool Expire Check Period
										
	
											Connection Pool Max Get Client Time
										



	
									Click the SNC tab and fill in the following property fields to configure the connection:
								
	
											SNC Partner Name
										
	
											SNC Level of Security
										
	
											SNC Name
										
	
											SNC Library Path
										



	
									Click the Repository tab and fill in the following property fields to configure the connection:
								
	
											Repository Destination
										
	
											Repository Logon User
										
	
											Repository Logon Password
										
Note

												If you need more information about these settings, refer the SAP documentation.
											








	
							You are now ready to test the destination connection. In the Edit SAP Connection Configuration dialog, right-click on the destination name and select Test.
						

							The Test Destination Connection dialog opens.
						

	
							The dialog uses the current destination configuration settings to connect to the SAP Destination Data Store. If the test is successful, you will see the following message in the status area:
						
Connection test for destination 'YourDestination' succeeded.

							Otherwise, an error report appears in the status area.
						

	
							Click Close to close the Test Destination Connection dialog.
						
	
							Click Finish. The newly created SAP Destination Connection appears under SAP.
						




Create and Test SAP Server Connection



Overview




					In Fuse SAP Tool suite, the Edit SAP Connection Configuration dialog helps you to create and manage the SAP Application Server connections. This section describes how to create and test the SAP Server connection.
				

Procedure




					To create and test the SAP Server connection, perform the following steps:
				
	
							Navigate to the global Configurations tab of route editor and click Add.
						

							The Create new global element view appears.
						

	
							Under SAP, select the type of connection you would like to create. Choose the SAP Connection and click Ok.
						

							The Edit SAP Connection Configuration dialog appears. It allows you to create, edit and delete the Destination and Server Connection Configurations.
						

	
							To create a new Server Data Store, click the Add Server tab.
						

							The Create Server dialog appears.
						

	
							Enter a name for the Server in the Server Name field and click Ok.
						
	
							In the Properties dialog,
						
	
									Click the Mandatory tab to configure the basic properties required to connect to an SAP server. In this tab, fill in the following property fields to configure the connection:
								
	
											Gateway Host
										
	
											Gateway Port
										
	
											Program ID
										
	
											Repository Destination
										
	
											Connection Count
										



	
									Click the Optional tab and fill in the following property fields to configure the connection:
								
	
											SAP Router String
										
	
											Worker Thread Count
										
	
											Minimum Worker Thread Count
										
	
											Maximum Startup Delay
										
	
											Repository Map
										



	
									Click the SNC tab and fill in the following property fields to configure the connection.
								
	
											SNC Level of Security
										
	
											SNC Name
										
	
											SNC Library Path
										
Note

												For more information about the settings, refer the SAP documentation.
											








	
							You are now ready to test the server connection. In the Edit SAP Connection Configuration dialog, right-click on the server name and select Test.
						

							The Test Server Connection dialog opens.
						

	
							The dialog uses the current server configuration settings to connect to the SAP Server Data Store. If the test is successful, you will see the following message in the status area:
						
Server state: STARTED
Server state: ALIVE

							If the test fails, the server status is reported as DEAD.
						

	
							Click Stop to shut down the Test Sever.
						
	
							Click Close to close the Test Server Connection dialog.
						
	
							Click Finish. The newly created SAP Server Connection appears under SAP.
						




Deleting Destination and Server Connections



Overview




					This following section describes how to delete the SAP Destination and Server connections in the Edit SAP Connection Configuration dialog.
				

Procedure




					If you want to delete the Destination and Server connections, perform the following steps:
				
	
							Navigate to the global Configurations tab of route editor and click Add.
						

							The Create new global element view appears.
						

	
							Under SAP, select the SAP Connection and click Ok.
						

							The Edit SAP Connection Configuration dialog appears. It allows you to create, edit and delete the Destination and Server Connection Configurations.
						

	
							In the Edit SAP Connection Configuration dialog, select the Destination and Server Data Stores which you want to delete.
						
	
							Click Delete. It will delete the selected connections.
						

							Atlast, click Finish. It will save all the changes.
						





Create a New SAP Endpoint



Overview




					You can use the Components palette in the route editor to add SAP components to a route with the help of the Edit SAP Connection Configuration dialog.
				
Note

						If you are using the SAP Connection view, remember to paste the requisite SAP connection configuration data into your Blueprint XML or Spring XML code.
					


Prerequisites




					You must already have created some SAP destination connections and/or server connections with the help of the Edit SAP Connection Configuration dialog.
				
Note

						If you are using the SAP Connection view, export this configuration to a file of the appropriate type (Blueprint XML or Spring XML).
					


Procedure




					To create a new SAP endpoint, perform the following steps:
				
	
							It is assumed that you already have a Fuse project and a Camel XML file to work with (which could either be in Blueprint XML or Spring XML format).
						
	
							Open your Camel XML file in the route editor. If you have already installed the Red Hat Fuse SAP Tool Suite, you should be able to see the SAP components under the Components palette in the route editor. The following SAP components are provided by the tool suite:
						
	
									SAP IDoc Destination
								
	
									SAP IDoc List Destination
								
	
									SAP IDoc List Server
								
	
									SAP qRFC Destination
								
	
									SAP Queued IDoc Destination
								
	
									SAP Queued IDoc List Destination
								
	
									SAP sRFC Destination
								
	
									SAP sRFC Server
								
	
									SAP tRFC Destination
								
	
									SAP tRFC Server
								

									In the Design tab of the route editor, drag one of these components onto the canvas to create a new SAP endpoint in the current camelContext.
								
Note

										The SAP Netweaver component does not belong to the Red Hat Fuse SAP Tool Suite. It is hosted in the Apache Camel project.
									





	
							Switch to the Source tab of the route editor, by clicking the Source tab at the bottom of the canvas. You can see the XML source of the routes.
						
	
							When specifying an SAP endpoint URI, you must embed either a destination name or a server connection name in the URI format. For example, the sap-srfc-destination component has the following URI format:
						
sap-srfc-destination:destinationName:rfcName

							To reference a particular destination, use the value of the relevant entry element’s key attribute as the destinationName in this URI.
						






Chapter 9. Getting Started with Data Transformation




				One of the challenges that comes with system and data integration is that the component systems often work with different data formats. You cannot simply send messages from one system to another without translating it into a format (or language) recognized by the receiving system. Data transformation is the term given to this translation.
			

				In this chapter, you learn how to include data transformation in a predefined Camel route. The Camel route directs messages from a source endpoint that produces XML data to a target endpoint that consumes JSON data. You add and define a data transformation component that maps the source’s XML data format to the target’s JSON data format.
			
Creating a project for the data transformation example



	
							Create a new Fuse Integration Project (select File → New → Fuse Integration Project).
						

							Provide the following information in the wizard:
						
	
									Project name: starter
								
	
									Deployment platform: Standalone
								
	
									Runtime environment: Karaf/Fuse on Karaf
								
	
									Camel version: Use the default
								
	
									Template: Empty - Blueprint DSL
								



	
							Download the prepared data examples from: https://github.com/FuseByExample/fuse-tooling-tutorials/archive/user-guide-11.1.zip
						
	
							Extract the data folder and the three files that it contains from the user-guide-11.1.zip archive into the Fuse Integration project’s src directory (starter/src/data).
						
	
							In the Project Explorer view, expand the starter project.
						
	
							Double-click Camel Contexts → src/main/resources/OSGI-INF/blueprint/blueprint.xml to open the route in the route editor’s Design tab.
						
	
							Click the Source tab to view the underlying XML.
						
	
							Replace <route id="_route1"/> with the following code:
						
<route id="_route1">
  <from id="_from1" uri="file:src/data?fileName=abc-order.xml&amp;noop=true"/>
  <setHeader headerName="approvalID" id="_setHeader1">
    <simple>AUTO_OK</simple>
  </setHeader>
  <to id="_to1" uri="file:target/messages?fileName=xyz-order.json"/>
</route>

	
							Click the Design tab to return to the graphical display of the route:
						
[image: Description]





Adding a data transformation node to the Camel route



	
							In the Palette, expand the Transformation drawer.
						
	
							Click the Data Transformation pattern and then, in the canvas, click the arrow between the SetHeader _setHeader1 and To_to1 nodes.
						

							The New Transformation wizard opens with the Dozer File Path field auto-filled.
						
[image: Description]


	
							Fill in the remaining fields:
						
	
									In the Transformation ID field, enter xml2json.
								
	
									For Source Type, select XML from the drop-down menu.
								
	
									For Target Type, select JSON from the drop-down menu.
								



	
							Click Next.
						

							The Source Type (XML) definition page opens, where you specify either an XML Schema (default) or an example XML Instance Document to provide the type definition of the source data:
						
[image: Description]


	
							Leave XML Schema enabled.
						
	
							For Source file, browse to the location of the XML schema file or the XML instance file to use for the type definition of the source data, and select it (in this case, abc-order.xsd).
						

							The XML Structure Preview pane displays a preview of the XML structure.
						

	
							In the Element root field, enter ABCOrder.
						

							The tooling uses this text to label the pane that displays the source data items to map.
						

							The Source Type (XML) definition page should now look like this:
						
[image: Description]


	
							Click Next to open the Target Type (JSON) definition page. This is where you specify the type definition for the target data.
						
[image: Description]


	
							Click JSON Instance Document.
						

							In the Target File field, enter the path to the xyz-order.json instance document, or browse to it. The JSON Structure Preview pane displays a preview of the JSON data structure:
						
[image: Description]


	
							Click Finish.
						



					The transformation editor opens. This is where you can map data items in your XML source to data items in your JSON target.
				
[image: Description]


					The transformation editor is composed of three panels:
				
	
							Source — lists the available data items of the source
						
	
							Mappings — displays the mappings between the source and target data items
						
	
							Target — lists the available data items of the target
						



					In addition, the editor’s details pane, located just below the editor’s three panels (once the first mapping has been made), graphically displays the hierarchical ancestors for both the mapped source and target data items currently selected. For example:
				
[image: Details pane with source property customerNum mapped to target property role="italic">custId]


					Using the details pane, you can customize the mapping for the selected source and target data items:
				
	
							Set property — Modify an existing mapping or map a simple data item to one in a collection (see the section called “Mapping a simple data item to a data item in a collection”).
						
	
							Set variable — Specify a constant value for a data item (see the section called “Mapping a constant variable to a data item”).
						
	
							Set expression — Map a data item to the dynamic evaluation of a specified expression (see the section called “Mapping an expression to a data item”).
						
	
							Add transformation — Modify the value of a mapped data item using a built-in function (see the section called “Adding a built-in function to a mapped data item”).
						
	
							Add custom transformation — Modify the value of a mapped data item using the Java method you create or one you previously created (see the section called “Adding a custom transformation to a mapped data item”).
						



Mapping source data items to target data items



	
							Expand all items in the Source and Target panels located on left and right sides of the Mappings panel.
						
[image: Description]


	
							Drag a data item from the Source panel and drop it on its corresponding data item in the Target panel.
						

							For example, drag the customerNum data item from the Source panel and drop it on the custId data item in the Target panel.
						
[image: Description]


							The mapping appears in the Mappings panel, and the details of both the Source and Target data items appear below in the details pane.
						

	
							Continue dragging and dropping source data items onto their corresponding target data items until you have completed all basic mappings.
						

							In the starter example, the remaining data items to map are:
						
	Source	Target
	 
											orderNum
										

										 	 
											orderId
										

										 
	 
											status
										

										 	 
											priority
										

										 
	 
											id
										

										 	 
											itemId
										

										 
	 
											price
										

										 	 
											cost
										

										 
	 
											quantity
										

										 	 
											amount
										

										 


Note

								You can map collections (data items containing lists or sets) to non-collection data items and vice versa, but you cannot map collections to other collections.
							


	
							Click 
							[image: Hide mapped fields icon]
							 on both the Source and Target panels to quickly determine whether all data items have been mapped.
						
[image: Description]


							Only data items that have not been mapped are listed in the Source and Target panels.
						

							In the starter example, the remaining unmapped Target attributes are approvalCode and origin.
						

	
							Click the blueprint.xml tab to return to the graphical display of the route:
						
[image: DTmapComplete]


	
							Click File → Save.
						



					You can run a JUnit test on your transformation file after you create the transformation test. For details, see the section called “Creating the transformation test file and running the JUnit test”. If you do so at this point, you will see this output in the Console view:
				

					For the source XML data:
				
<?xml version="1.0" encoding="UTF-8"?>
<ABCOrder xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:java="http://java.sun.com">
    <header>
        <status>GOLD</status>
        <customer-num>ACME-123</customer-num>
        <order-num>ORDER1</order-num>
    </header>
    <order-items>
        <item id="PICKLE">
            <price>2.25</price>
            <quantity>1000</quantity>
        </item>
        <item id="BANANA">
            <price>1.25</price>
            <quantity>400</quantity>
        </item>
    </order-items>
</ABCOrder>

					For the target JSON data:
				
{"custId":"ACME-123","priority":"GOLD","orderId":"ORDER1","lineItems":[{"itemId":"PICKLE",
"amount":1000,"cost":2.25},{"itemId":"BANANA","amount":400,"cost":1.25

Creating the transformation test file and running the JUnit test



	
							Right-click the starter project in the Project Explorer view, and select New → Other → Fuse Tooling → Fuse Transformation Test.
						
	
							Select Next to open the New Transformation Test wizard.
						
	
							In the New Transformation Test wizard, set the following values:
						
	Field	Value
	 
											Package
										

										 	 
											example
										

										 
	 
											Camel File Path
										

										 	 
											OSGI-INF/blueprint/blueprint.xml
										

										 
	 
											Transformation ID
										

										 	 
											xml2json
										

										 



	
							Click Finish.
						
	
							In the Project Explorer view, navigate to starter/src/test/java/example, and open the TransformationTest.java file.
						
	
							Add the following code to the transform method:
						
startEndpoint.sendBodyAndHeader(readFile("src/data/abc-order.xml"), "approvalID", "AUTO_OK");

	
							Click File → Save.
						

							You can now run a JUnit test on your transformation file at any point in these tutorials.
						

	
							In the Project Explorer view, expand the starter project to expose the /src/test/java/example/TransformationTest.java file.
						
	
							Right click it to open the context menu, and select Run as JUnit Test.
						

							The JUnit Test pane opens to display the status of the test. To avoid cluttering your workspace, drag and drop the pane in the bottom panel near the Console view.
						
[image: Description]


	
							Open the Console view to see the log output.
						



Mapping a constant variable to a data item




					When a source/target data item has no corresponding target/source data item, you can map a constant variable to the existing data item.
				

					In the starter example, the target data item origin does not have a corresponding source data item. To map the origin attribute to a constant variable:
				
	
							In the Source panel, click the Variables view.
						
[image: Description]


	
							In the Variables view, click 
							[image: Add a new variable icon]
							 to open the Enter a new variable name dialog.
						
[image: Description]


	
							Enter a name for the variable you want to create.
						

							For the starter example, enter ORIGIN.
						

	
							Click OK.
						

							The newly created variable ORIGIN appears in the Variables view in the Name column and the default value ORIGIN in the Value column.
						

	
							Click the default value to edit it, and change the value to Web.
						
	
							Press Enter.
						
	
							Drag and drop the new variable ORIGIN onto the origin data item in the Target panel.
						
[image: Description]


							The new mapping of the variable $(ORIGIN) appears in the Mappings panel and in the details pane.
						

	
							Run a JUnit test on your TransformationTest.java file. For details, see the section called “Creating the transformation test file and running the JUnit test”.
						

							The Console view displays the JSON-formatted output data:
						
{"custId":"ACME-123","priority":"GOLD","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"itemId":"PICKLE","amount":1000,"cost":2.25},
{"itemId":"BANANA","amount":400,"cost":1.25}]}




Mapping an expression to a data item




					This feature enables you, for example, to map a target data item to the dynamic evaluation of a Camel language expression.
				

					Use the target approvalCode data item, which lacks a corresponding source data item:
				
	
							Click 
							[image: Add a new mapping icon]
							 to add an empty transformation map to the Mappings panel.
						
[image: Description]


	
							From the Target panel, drag and drop the approvalCode data item to the target field of the newly created mapping in the Mappings panel.
						
[image: Description]


							The approvalCode data item also appears in the details pane’s target box.
						

	
							In the details pane, click 
							[image: drop-down menu access]
							 on the ABCOrder source box to open the drop-down menu.
						
[image: Description]


							Menu options depend on the selected data item’s data type. The available options are bolded.
						

	
							Select Set expression to open the Expression dialog.
						
[image: Description]


	
							In Language, select the expression language to use from the list of those available. Available options depend on the data item’s data type.
						

							For the starter example, select Header.
						

	
							In the details pane, select the source of the expression to use.
						

							The options are Value and Script.
						

							For the starter example, click Value, and then enter ApprovalID.
						

	
							Click OK.
						
[image: Description]


							Both the Mappings panel and the details pane display the new mapping for the target data item approvalCode.
						

	
							Run a JUnit test on your TransformationTest.java file. For details, see the section called “Creating the transformation test file and running the JUnit test”.
						

							The Console view displays the JSON-formatted output data:
						
{"custId":"ACME-123","priority":"GOLD","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"itemId":"PICKLE","amount":1000,"cost":2.25},
{"itemId":"BANANA","amount":400,"cost":1.25}]}




Adding a custom transformation to a mapped data item




					You may need to modify the formatting of source data items when they do not satisfy the requirements of the target system.
				

					For example, to satisfy the target system’s requirement that all customer IDs be enclosed in brackets:
				
	
							In the Mappings panel, select the customerNum mapping to populate the details pane.
						
[image: Description]


	
							In the details pane, click 
							[image: drop-down menu access]
							 on the ABCOrder source box to open the drop-down menu.
						
[image: Description]


	
							Select Add custom transformation to open the Add Custom Transformation page.
						
[image: Description]


	
							Click 
							[image: create new function button]
							 next to the Class field to open the Create a New Java Class wizard.
						
[image: Description]


	
							Modify the following fields:
						
	
									Package — Enter example.
								
	
									Name — Enter MyCustomMapper.
								
	
									Method Name — Change map to brackets.
								

									Leave all other fields as is.
								




	
							Click Finish.
						

							The Add Custom Transformation page opens with the Class and Method fields auto filled:
						
[image: Description]


	
							Click OK to open the MyCustomMapper.java file in the Java editor:
						
[image: Description]


	
							Edit the brackets method to change the last line return null; to this:
						
return "[" + input + "]";

	
							Click the transformation.xml tab to switch back to the transformation editor.
						
[image: Description]


							The details pane shows that the brackets method has been associated with the customerNum data item.
						

							The brackets method is executed on the source input before it is sent to the target system.
						

	
							Run a JUnit test on your TransformationTest.java file. For details, see the section called “Creating the transformation test file and running the JUnit test”.
						

							The Console view displays the JSON-formatted output data:
						
{"custId":"[ACME-123]","priority":"GOLD","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"itemId":"PICKLE","amount":1000,"cost":2.25},
{"itemId":"BANANA","amount":400,"cost":1.25}]}




Mapping a simple data item to a data item in a collection




					In this tutorial, you will modify an existing mapping that maps all ids in the Source to the itemIds in the Target. The new mapping will map the customerNum data item in the Source to the itemId of the second item in the lineItems collection in the Target.
				

					With this change, no ids in the Source will be mapped to itemIds in the Target.
				
	
							In the Mappings panel, select the mapping id  — > itemId to display the mapping in the details pane.
						
[image: Description]


	
							On the Source box, click 
							[image: drop-down menu access]
							 to open the drop-down menu, and select Set property.
						
[image: Description]


	
							In the Select a property page, expand the header node and select customerNum. Click OK to save the changes.
						
[image: select a property]


	
							The details pane now shows that XyzOrder has a lineItems field. Click the toggle button next to lineItems to increase its value to 1.
						
Note

								Indexes are zero-based, so a value of 1 selects the second instance of itemId in the collection.
							

[image: Description]


							Notice that the details pane shows customerNum mapped to the itemId of the second item in the lineItems collection.
						

	
							Run a JUnit test on your TransformationTest.java file. For details, see the section called “Creating the transformation test file and running the JUnit test”.
						

							The Console view displays the JSON-formatted output data:
						
{"custId":"[ACME-123]","priority":"GOLD","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"amount":1000,"cost":2.25},
{"itemId":"ACME-123","amount":400,"cost":1.25}]}




Adding a built-in function to a mapped data item




					You can use the built-in string-related functions to apply transformations to mapped data items.
				
	
							In the Transformations panel, select the status to priority mapping to populate the details pane.
						
[image: Description]


	
							In the Source box, click 
							[image: drop-down menu access]
							 to open the drop-down menu, and select Add transformation.
						
[image: Description]


	
							In the Transformations pane, select append, and in the Arguments pane, enter -level for the value of suffix.
						

							This append function adds the specified suffix to the end of the status string before mapping it to the target priority data item.
						
[image: Description]


	
							Click OK.
						
[image: Description]


							By default, the details pane displays the results of adding the append function to the status data item in a user-friendly format. You can change this formatting by clicking the right-most 
							[image: drop-down menu access]
							 on the Source box, and selecting Show standard formatting.
						
[image: Description]


	
							Run a JUnit test on your TransformationTest.java file. For details, see the section called “Creating the transformation test file and running the JUnit test”.
						

							The Console view displays the JSON-formatted output data:
						
{"custId":"[ACME-123]","priority":"GOLD-level","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"amount":1000,"cost":2.25},{"itemId":"ACME-123",
"amount":400,"cost":1.25}]}




Publishing a Fuse Integration project with data transformation to a Red Hat Fuse server




					Before you publish your data transformation project to a Fuse server (see Chapter 29, Publishing Fuse Integration Projects to a Server), you need to install the following features in the Fuse runtime:
				
	
							camel-dozer
						
	
							camel-jackson
						
	
							camel-jaxb
						



					To install the required features on the Fuse runtime:
				
	
							If not already there, switch to the Fuse Integration perspective.
						
	
							If necessary, add the Fuse server to the Servers list (see the section called “Adding a Server”).
						
	
							Start the Fuse Server (see the section called “Starting a Server”), and wait for the JBoss Fuse shell to appear in the Terminal view.
						
	
							For each of the required camel- features, at the JBossFuse:admin@root> prompt type:
						

							features:install camel-<featureName>
						

							Where featureName is one of dozer, jackson, or jaxb.
						

	
							To verify that each of the features was successfully installed, at the JBossFuse:admin@root> prompt type:
						

							features:list --ordered --installed
						

							You should see the camel features you just installed in the output listing:
						
[image: DTCamFeatsInstalled]






Chapter 10. Developing extensions for Fuse Online integrations




				Fuse Online is a Red Hat Fuse feature that provides a web interface for integrating applications. Without writing code, a business expert can use Fuse Online to connect to applications and optionally operate on data between connections to different applications. If Fuse Online does not provide a feature that an integrator needs, then a developer can create an extension that defines the needed behavior.
			

				You can use Fuse Tooling to develop extensions that provide features for use in Fuse Online. An extension defines:
			
	
						One or more custom steps that operate on data between connections in an integration
					

						or
					

	
						One custom connector
					



				In Fuse Online, a connector represents a specific application to obtain data from or send data to. Each connector is a template for creating a connection to that specific application. For example, the Salesforce connector is the template for creating a connection to Salesforce. If Fuse Online does not provide a connector that the Fuse Online user needs, you can develop an extension that defines a custom connector.
			

				In Fuse Online, a data operation that happens between connections in an integration is referred to as a step. Fuse Online provides steps for operations such as filtering and mapping data. To operate on data between connections in ways that are not provided by Fuse Online built-in steps, you can develop a Fuse Online extension that defines one or more custom steps.
			
Note

					You might prefer to develop an extension in the IDE of your choice. Whether you use Fuse Tooling or another IDE is entirely a matter of personal preference. Information about developing an extension in any IDE is in Integrating Applications with Fuse Online.
				

Overview of tasks




					Here is an overview of the tasks for developing a Fuse Online extension:
				
	
							In Red Hat CodeReady Studio, create a Fuse Online extension project and select Custom Connector or Custom Step as the extension type.
						
	
							Depending on the extension type, write the code for the extension:
						
	
									For a Custom Connector: Define the base Camel component, the connector icon, global connector properties, and the connector actions.
								
	
									For a Custom Step: Add routes, define actions, and specify any dependencies.
								



	
							Build a .jar file.
						
	
							Provide the .jar file to the Fuse Online user.
						



					The Fuse Online user uploads the .jar file to Fuse Online, which makes the custom connector or custom step(s) available for use. For information about Fuse Online and how to create integrations, see Integrating Applications with Fuse Online.
				

Prerequisites




					Before you begin, you need the following information and knowledge:
				
	
							A description of the required functionality for the Fuse Online custom connector or step (from the Fuse Online user).
						
	
							The Fuse Online version number for the extension.
						
	
							For a custom connector, an icon image file in PNG or SVG format. Fuse Online uses this icon when it displays the flow of an integration. If you do not provide an icon, then Fuse Online generates one when the .jar that contains the extension is uploaded.
						
	
							You should be familiar with:
						
	
									Fuse Online
								
	
									Spring Boot XML or Java
								
	
									Apache Camel routes (if you want to create a route-based step extension)
								
	
									JSON
								
	
									Maven
								






Creating a custom connector




					In Fuse Online, a custom connector consists of one or more connection configuration parameters, one or more connection actions, and optional configuration parameters for each action.
				

					Here is an overview of the tasks for developing a custom connector:
				
	
							In Red Hat CodeReady Studio, create a Fuse Online extension project and select Custom Connector as the extension type.
						
	
							Write the code for the extension. Define the base Camel component, the connector icon, global connector properties, and the connector actions.
						


Creating a Fuse Online Extension project for a custom connector




						A Fuse Tooling Fuse Online extension project provides a starting point for a custom connector.
					

						To create a Fuse Tooling Fuse Online extension project, follow these steps:
					
	
								In Red Hat CodeReady Studio, select New → Project → Red Hat Fuse → Fuse Online Extension Project.
							

								The New Fuse Online Extension Project wizard opens.
							
[image: FuseOnlineExtWiz page1]


	
								Enter the name and location for the project, then click Next.
							
[image: FuseOnlineExtWiz page2]


	
								Select the Fuse Online version.
							
	
								Specify the following extension details:
							
	
										ID — A value that you define and that is unique in the Fuse Online environment. This value will be visible in Fuse Online when the Fuse Online user imports the extension .jar file.
									
	
										Name — The name of the extension. This value will be visible in Fuse Online as the extension name. In Fuse Online, on the Customizations → Extensions tab, the user can see a list of the names and descriptions of extensions that have been uploaded to Fuse Online.
									
	
										Description — An optional description of the extension content.
									
	
										Version — The version of the extension. For example, if this is the initial version, you could type 1.0. If you are updating a version, you could type 1.1 or 2.0.
									



	
								Select Custom Connector for the kind of Fuse Online extension that you want to create.
							
[image: FuseOnlineExtWiz connector]


	
								Click Finish.
							



						The new project appears in the Red Hat CodeReady Studio Project Explorer view. It includes the following files for a custom connector extension:
					
	
								In the src/main/resources/META-INF/syndesis folder:
							
	
										A descriptor file: syndesis-extension-definition.json
									

										This is the file that you edit to: * Add top-level global properties, connector actions, and action properties. * Change the Extension Id, Name, Version, or Description values.
									

	
										A default icon image file: icon.png
									

										You can optionally replace this file with your own icon image (PNG or SVG) file.
									




	
								A Maven Project Object Model file: pom.xml
							

								This file contains information about the project and configuration details used by Maven to build the project, including default extension dependencies. You edit this file to add custom dependencies. The scope for any dependency that Red Hat ships is provided, for example:
							
<dependency>
    <groupId>io.syndesis.extension</groupId>
    <artifactId>extension-api</artifactId>
    <scope>provided</scope>
</dependency>
<dependency>
    <groupId>org.apache.camel</groupId>
    <artifactId>camel-core</artifactId>
    <scope>provided</scope>
</dependency>
<dependency>
    <groupId>org.springframework.boot</groupId>
    <artifactId>spring-boot-starter</artifactId>
    <scope>provided</scope>
</dependency>




Writing code for the custom connector




						After you create the Fuse Online extension project, you write the code that defines the custom connector elements based on the description of the required functionality provided to you by the Fuse Online user. The Table 10.1, “Custom connector elements” table shows how the elements of the custom connector that you create in Fuse Tooling correspond to elements in Fuse Online.
					
Table 10.1. Custom connector elements
	Fuse Tooling element	Fuse Online element	Description
	 
										Global (top-level) property
									

									 	 
										Connection configuration parameter
									

									 	 
										When a Fuse Online user creates a connection from this connector, the user specifies a value for this property as part of the configuration of the connection.
									

									 
	 
										Action
									

									 	 
										Connection action
									

									 	 
										In Fuse Online, for a connection created from this connector, a Fuse Online user selects one of these actions.
									

									 
	 
										Property defined in an action
									

									 	 
										An action configuration parameter
									

									 	 
										When a Fuse Online user configures the action that the connection performs, the Fuse Online user specifies a value for this property as part of the configuration of the action.
									

									 




						To write the code that implements a custom connector for Fuse Online:
					
	
								Open the syndesis-extension-definition.json file in the Editor view and write the code that defines the global properties, the actions that the custom connector can perform, and each action’s properties.
							

								Each global property corresponds to a connection configuration parameter in Fuse Online. Each action property corresponds to a Fuse Online connection action configuration parameter. In Fuse Online, when the user selects a custom connector, Fuse Online prompts for values for each connection configuration parameter. A custom connector can be for an application that uses the OAuth protocol. In this case, be sure to specify a global property for the OAuth client ID and another global property for the OAuth client secret. The Fuse Online user will need to specify values for these parameters for a connection created from this connector to work.
							

								Each connector action declares a base Camel component scheme.
							

								The example provided by the New Fuse Online Extension Project wizard uses the telegram Camel component scheme:
							
{
  "schemaVersion" : "v1",
  "name" : "Example Fuse Online Extension",
  "extensionId" : "fuse.online.extension.example",
  "version" : "1.0.0",
  "actions" : [ {
    "id" : "io.syndesis:telegram-chat-from-action",
    "name" : "Chat Messages",
    "description" : "Receive all messages sent to the chat bot",
    "descriptor" : {
      "componentScheme" : "telegram",
      "inputDataShape" : {
        "kind" : "none"
      },
      "outputDataShape" : {
        "kind" : "java",
        "type" : "org.apache.camel.component.telegram.model.IncomingMessage"
      },
      "configuredProperties" : {
        "type" : "bots"
      }
    },
    "actionType" : "connector",
    "pattern" : "From"
  }, {
    "id" : "io.syndesis:telegram-chat-to-action",
    "name" : "Send a chat Messages",
    "description" : "Send messages to the chat (through the bot).",
    "descriptor" : {
      "componentScheme" : "telegram",
      "inputDataShape" : {
        "kind" : "java",
        "type" : "java.lang.String"
      },
      "outputDataShape" : {
        "kind" : "none"
      },
      "propertyDefinitionSteps" : [ {
        "description" : "Chat id",
        "name" : "chatId",
        "properties" : {
          "chatId" : {
            "kind" : "parameter",
            "displayName" : "Chat Id",
            "type" : "string",
            "javaType" : "String",
            "description" : "The telegram's Chat Id, if not set will use CamelTelegramChatId from the incoming exchange."
          }
        }
      } ],
      "configuredProperties" : {
        "type" : "bots"
      }
    },
    "actionType" : "connector",
    "pattern" : "To"
  } ],
  "properties" : {
    "authorizationToken" : {
      "kind" : "property",
      "displayName" : "Authorization Token",
      "group" : "security",
      "label" : "security",
      "required" : true,
      "type" : "string",
      "javaType" : "java.lang.String",
      "secret" : true,
      "description" : "Telegram Bot Authorization Token"
    }
  }
}

	
								If the custom connector requires additional dependencies, add them to the project’s pom.xml file. The default scope for dependencies is runtime. If you add a dependency that Red Hat ships, define its scope as provided, for example:
							
<dependencies>
    <dependency>
          <groupId>org.apache.camel</groupId>
          <artifactId>camel-telegram</artifactId>
          <scope>provided</scope>
    </dependency>
      </dependencies>




						When you finish writing the code for the custom connector, build the .jar file as described in the section called “Building the Fuse Online extension JAR file”.
					


Creating custom steps




					After you create the Fuse Online extension project, you write the code that defines the custom steps based on the description of the required functionality provided to you by the Fuse Online user. Within a single extension, you can define more than one custom step and you can define each custom step with Camel routes or with Java beans.
				
Creating a Fuse Online Extension project for custom steps




						To create a Fuse Tooling Fuse Online extension project, follow these steps:
					
	
								In Red Hat CodeReady Studio, select New → Project → Red Hat Fuse → Fuse Online Extension Project.
							

								The New Fuse Online Extension Project wizard opens.
							
[image: FuseOnlineExtWiz page1]


	
								Enter the name and location for the project, then click Next.
							
[image: FuseOnlineExtWiz page2]


	
								Select the Fuse Online version.
							
	
								Specify the following extension details:
							
	
										ID — A value that you define and that is unique in the Fuse Online environment. This value will be visible in Fuse Online when the Fuse Online user imports the extension .jar file.
									
	
										Name — The name of the extension. This value will be visible in Fuse Online as the extension name. In Fuse Online, on the Customizations → Extensions tab, the user can see a list of the names and descriptions of extensions that have been uploaded to Fuse Online.
									
	
										Description — An optional description of the extension content.
									
	
										Version — The version of the extension. For example, if this is the initial version, you could type 1.0. If you are updating a version, you could type 1.1 or 2.0.
									



	
								Select Custom Step for the kind of Fuse Online extension that you want to create.
							
	
								Select the template for the custom step:
							
[image: FuseOnlineExtWiz step]

	
										Camel route — Provides a sample Camel route.
									
	
										Java bean — Provides a sample Java bean.
									
Note

											The template that you select provides a starting point for your project. If you want to create one or more custom steps based on Camel routes and one or more other custom steps based on Java beans within the same extension, start with one of the templates and then add the needed file and dependencies for the other type of custom step.
										





	
								Click Finish.
							



						The new project appears in the Red Hat CodeReady Studio Project Explorer view. It includes the following files depending on the template that you selected for the custom step:
					
	
								In the src/main/resources/META-INF/syndesis folder:
							
	
										A descriptor file: syndesis-extension-definition.json
									

										This is the file that you edit to: * Add one or more actions. An action in the `.json `file becomes a custom step in Fuse Online. In an action element, a property in the `.json `file becomes a step configuration parameter in Fuse Online. * Change the Extension Id, Name, Version, or Description values.
									

	
										For a Camel route template, a Camel context file: extensions/log-body-action.xml
									

										This file contains a sample route with a log component. You customize the Camel routes in this file.
									

	
										For a Java bean template, a Java file: extensions/extension.java
									

										This file contains a sample POJO-based logging extension.
									




	
								A Maven Project Object Model file: pom.xml
							

								This file contains information about the project and configuration details used by Maven to build the project, including default extension dependencies. You edit this file to add custom dependencies. The scope for any dependency that Red Hat ships is provided, for example:
							
<dependency>
    <groupId>io.syndesis.extension</groupId>
    <artifactId>extension-api</artifactId>
    <scope>provided</scope>
</dependency>
<dependency>
    <groupId>org.apache.camel</groupId>
    <artifactId>camel-core</artifactId>
    <scope>provided</scope>
</dependency>
<dependency>
    <groupId>org.springframework.boot</groupId>
    <artifactId>spring-boot-starter</artifactId>
    <scope>provided</scope>
</dependency>




Writing code for the custom step




						After you create the Fuse Online extension project, you write the code that defines the custom step(s)based on the description of the required functionality provided to you by the Fuse Online user.
					

						Table 10.2, “Custom step elements” shows how the elements of the custom step that you create in Fuse Tooling correspond to elements in Fuse Online.
					
Table 10.2. Custom step elements
	Fuse Tooling element	Fuse Online element	Description
	 
										Action
									

									 	 
										Custom Step
									

									 	 
										In Fuse Online, after the user imports the step extension, the custom step(s) appear(s) on the Choose a step page.
									

									 
	 
										Property defined in an action
									

									 	 
										A custom step configuration parameter
									

									 	 
										In Fuse Online, when the user selects a custom step, Fuse Online prompts for values for configuration parameters.
									

									 




						To write the code that implements a custom step for Fuse Online:
					
	
								For a Camel route-based step, in the extension.xml file, create routes that address the purpose of the extension. The entrypoint of each route must match the entrypoint that you define in the syndesis-extension-definition.json file, as described in Step 2.
							

								For a Java bean-based step, edit the java file.
							

	
								In the syndesis-extension-definition.json file, write the code that defines the actions and their properties. You need a new action for each entrypoint.
							

								Each action that you create corresponds to a custom step in Fuse Online. You can use different types of code for each action. That is, you can use a Camel route for one action and a Java bean for another action.
							

								Each property corresponds to a Fuse Online step configuration parameter. In Fuse Online, when the user selects a custom step, Fuse Online prompts for values for configuration parameters. For example, a custom log step might have a level parameter that indicates how much information to send to the log.
							

								Here is the template for the .json file that contains the extension metadata, including properties that will be filled in by the user in Fuse Online after uploading the extension and adding its custom step to an integration:
							
{
  "actions": [
    {
      "actionType": "extension",
      "id": "${actionId}",
      "name": "Action Name",
      "description": "Action Description",
      "tags": [
           "xml"
      ],
      "descriptor": {
        "kind": "ENDPOINT|BEAN|STEP",
        "entrypoint": "direct:${actionId}",
        "inputDataShape": {
          "kind": "any"
        },
        "outputDataShape": {
          "kind": "any"
        },
        "propertyDefinitionSteps": []
      }
    }
  ],
  "tags": [
    "feature",
    "experimental"
  ]
}
Note

									The tags are ignored in this release. They are reserved for future use.
								


	
								To edit the extension dependencies, open the `pom.xml `file in the editor. If you add a dependency, you must define its scope.
							



						When you finish writing the code for the custom step(s), build the .jar file as described in the section called “Building the Fuse Online extension JAR file”.
					


Building the Fuse Online extension JAR file




					To build the .jar file for the extension:
				
	
							In the Project Explorer view, right-click the project.
						
	
							From the context menu, select Run As → Maven clean verify.
						
	
							In the Console view, you can monitor the progress of the build.
						
	
							When the build is complete, refresh the target folder in the Project Explorer view (select the project and then press F5).
						
	
							In the Project Explorer view, open the target folder to see the generated .jar file:
						

							The name of the .jar file follows Maven defaults: ${artifactId}-${version}.jar
						

							For example: custom:step-camel-1.0.0.jar
						

							This .jar file defines the extension, its required dependencies, and its metadata: Extension Id, Name, Version, Tags, and Description. For example:
						
{
    "schemaVersion" : "v1",
    "name" : "Example Fuse Online Extension",
    "description" : "Logs a message body with a prefix",
    "extensionId" : "fuse.online.extension.example",
    "version" : "1.0.0",
    "actions" : [ {
        "id" : "Log-body",
        "name" : "Log Body",
        "description" : "A simple xml Body Log with a prefix",
        "descriptor" : {
            "kind" : "ENDPOINT",
            "entrypoint" : "direct:log-xml",
            "resource" : "classpath:META-INF/syndesis/extensions/log-body-action.xml",
            "inputDataShape" : {
                "kind" : "any"
            },
            "outputDataShape" : {
                "kind" : "any"
            },
            "propertyDefinitionSteps" : [ {
                "description" : "Define your Log message",
                "name" : "Log Body",
                "properties" : {
                    "prefix" : {
                        "componentProperty" : false,
                        "deprecated" : false,
                        "description" : "The Log body prefix message",
                        "displayName" : "Log Prefix",
                        "javaType" : "String",
                        "kind" : "parameter",
                        "required" : false,
                        "secret" : false,
                        "type" : "string"
                    }
                }
            } ]
        },
        "tags" : [ "xml" ],
        "actionType" : "step"
    } ],
    "dependencies" : [ {
        "type" : "MAVEN",
        "id" : "io.syndesis.extension:extension-api:jar:1.3.0.fuse-000014"
    } ],
    "extensionType" : "Steps"
}




Providing the JAR file to the Fuse Online user




					Provide the following to the Fuse Online user:
				
	
							The .jar file
						
	
							A document that describes the extension. For a step extension, include information about data shapes that each action in the step extension requires as input or provides as output (for data mapping).
						



					In Fuse Online, the user uploads the .jar file as described in Integrating Applications with Fuse Online.
				


Chapter 11. Creating a New Camel XML file



Overview




				Apache Camel stores routes in an XML file that contains a camelContext element. When you create a new Fuse Integration project, the tooling provides an Apache Camel context (XML) file as part of the project by default.
			

				You can also add a new Camel XML file that includes all of the required namespaces preconfigured and a template camelContext element.
			

Procedure




				To add a new Apache Camel context file to your project:
			
	
						Select File → New → Camel XML File from the main menu to open the Camel XML File wizard, as shown in Figure 11.1, “Camel XML File wizard”.
					
Figure 11.1. Camel XML File wizard
[image: Camel XML file wizard]



	
						In RouteContainer, enter the location for the new file, or accept the default.
					

						You can click 
						[image: Browse…​ button]
						 to search for an appropriate location.
					
Important

							The Spring framework and the OSGi Blueprint framework require that all Apache Camel files be placed in specific locations under the project’s META-INF or OSGI-INF folder:
						
	
									Spring - projectName/src/main/resources/META-INF/spring/
								
	
									OSGi Blueprint - projectName/src/main/resources/OSGI-INF/blueprint/
								




	
						In File Name, enter a name for the new context file, or accept the default (camelContext.xml).
					

						The file’s name cannot contain spaces or special characters, and it must be unique within the JVM.
					

	
						In Framework, accept the default, or select which framework the routes will use:
					
	
								Spring — [default] for routes that will be deployed in Spring containers, non-OSGi containers, or as standalone applications
							
	
								OSGi Blueprint — for routes that will be deployed in OSGi containers
							
	
								Routes — for routes that you can load and add into existing camelContexts
							



	
						Click Finish.
					

						The new context file is added to the project and opened in the route editor.
					





Chapter 12. Changing the Camel version




				As you work with a Fuse tooling project, you might want to change the Camel version that it uses. This can be helpful, for example, if you want to use a feature supported in a more recent Camel version or if you want to use a community version.
			

				To change the Camel version that a project uses:
			
	
						In Project Explorer, right-click the project for which you want to change the Camel version and select Configure → Change Camel Version.
					
	
						In the Change Camel Version window, to the right of the Camel Version field, click the down caret to display available Camel versions.
					

						To use a community version of Apache Camel, you enter its version number, for example, 2.19.2.
					

	
						Select or enter the version you want and click Finish.
					



				Fuse Tooling checks whether the version you selected is available and supported by Fuse Tooling. If it is then Fuse Tooling changes the Camel version and saves the project’s updated pom.xml file. You receive an error message if the Camel version that you select is not available or not supported.
			

				You can check the project’s Camel version in its pom.xml file, in the <camel.version> element.
			

Chapter 13. Importing an existing Maven project



Overview




				You might want to import an existing project, for example, to use as a template or starting point for developing an application.
			

				For example, the New Fuse Integration Project wizard points to the following Github repositories as sources for examples:
			
	
						https://github.com/apache/camel/tree/master/examples
					
	
						https://github.com/fabric8-quickstarts
					
	
						https://github.com/wildfly-extras/wildfly-camel-examples
					
	
						https://github.com/jboss-fuse/quickstarts
					



				After you download an example project, you import it into CodeReady Studio.
			

Procedure




				To import an existing Maven project:
			
	
						Select File → Import → Maven → Existing Maven Projects, and then click Next.
					
	
						For the Root Directory, select the folder that contains the downloaded example projects.
					
	
						In the list of Projects, check the projects that you want to import and then click Finish.
					




Part II. Debugging Routing Contexts





				The Camel debugger includes many features for debugging locally and remotely running routing contexts:
			
	
						Setting conditional and unconditional breakpoints on nodes in the route editor
					
	
						Autolaunching the debugger and switching to the Debug perspective
					
	
						Interacting with the running routing context:
					
	
								Switch between breakpoints to quickly compare variable values of message instances
							
	
								Examine and change the value of variables of interest
							
	
								Add variables of interest to the watch list to track them throughout the debug session
							
	
								Disable and re-enable breakpoints on-the-fly
							
	
								Track message flow graphically in the routing context runtime
							
	
								Examine console logs to track Camel and debugger actions
							





Note

					Before you can run the Camel debugger, you must set breakpoints on the nodes of interest displayed on the route editor’s canvas. Then you can run the Camel debugger on a project’s routing context .xml file to find the logic errors in it and fix them. Invoking the Camel debugger runs the routing context in debug mode and opens the Debug Perspective.
				



Chapter 14. Setting Breakpoints



Overview




				To set breakpoints, your project’s routing context .xml file must be open in the route editor’s Design tab.
			

				The Camel debugger supports two types of breakpoints:
			
	
						Unconditional breakpoints — triggered whenever one is encountered during a debugging session
					
	
						Conditional breakpoints — triggered only when the breakpoint’s specified condition is met during a debugging session
					


Note

					You cannot set breakpoints on consumer endpoints or on when or otherwise nodes.
				


Setting unconditional breakpoints




				With your routing context displayed on the canvas in the Design tab:
			
	
						Select a node whose state you want to examine during the debugging session.
					
	
						Click its 
						[image: red dot]
						 icon to set an unconditional breakpoint.
					
	
						Repeat these steps for each node on which you want to set an unconditional breakpoint.
					



Setting conditional breakpoints




				With your routing context displayed on the canvas in the Design tab:
			
	
						Select a node whose state you want to examine during the debugging session.
					
	
						Click its 
						[image: yellow dot]
						 icon to set a conditional breakpoint and to open the Edit the condition and language of your breakpoint…​ dialog:
					
[image: debug CondBPCnfg]


	
						Click the Language drop-down menu and select the expression language to use to create the condition that will trigger the breakpoint.
					

						Fuse Tooling supports twenty-four expression languages. Some of these languages provide variables for creating conditional expressions, while others do not.
					

	
						Click Variables to display a list of the selected language’s supported variables.
					

						If a list appears, select in sequence one or more of the variables to create the condition for triggering the breakpoint. The variables you select appear in the Condition text box.
					

						If 
						[image: expressLangNoVars]
						 appears, enter the expression directly into the Condition text box.
					

	
						Repeat steps [condBpFirst] through [condBpLast] for each node on which you want to set a conditional breakpoint.
					



Disabling breakpoints




				You can temporarily disable a breakpoint, leaving it in place, then enable it again later. The 
				[image: resume co]
				 button skips over disabled breakpoints during debugging sessions.
			

				To disable a breakpoint, select the node on the canvas and click its 
				[image: gray dot]
				 icon. The breakpoint turns gray, indicating that it has been disabled.
			

				To enable a disabled breakpoint, select the node on the canvas and click its 
				[image: green dot]
				 icon. Depending on whether the disabled breakpoint is conditional or unconditional, it turns yellow or red, respectively, to indicate that it has been re-enabled.
			
Note

					You can also disable and re-enable breakpoints during debugging sessions. For details, see Chapter 19, Disabling Breakpoints in a Running Context.
				


Deleting breakpoints




				You can delete individual breakpoints or all breakpoints.
			
	
						To delete individual breakpoints — in a route container, select the node whose breakpoint you want to delete, and click its 
						[image: delete bp]
						 icon.
					
	
						To delete all breakpoints in a particular route — right-click the target route’s container, and select  [image: gray dot]
						 Delete all breakpoints.
					
	
						To delete all breakpoints in all routes — right-click the canvas, and select  [image: gray dot]
						 Delete all breakpoints.
					



Related topics



	
						Chapter 15, Running the Camel Debugger
					




Chapter 15. Running the Camel Debugger




				You can run the Camel debugger on locally running routing contexts.
			
Note
	
							Remote debugging is no longer supported. For remote debugging, you must configure Jolokia and create a specific JMX connection through Jolokia.
						
	
							If your project contains Java code, you can use the standard Eclipse Java debugging tools to debug it.
						




				You must set breakpoints in your routing context file before you can start the Camel debugger.
			
Procedure



	
						In the Project Explorer view, select the routing context file you want to debug.
					
	
						Right-click the selected file to open the context menu, and then select Debug As → Local Camel Context.
					

						Fuse Tooling builds the Camel route, starts Apache Camel, starts the routing context, enables JMX, starts the route(s) in the routing context, adds the breakpoints to the nodes, and enables the Camel debugger.
					

						The Camel debugger suspends execution of the routing context at the first breakpoint hit (received a message), and prompts you to indicate whether you want it to open the Debug perspective.
					
[image: DBCnfrmSwitchToDBView]


	
						Click Yes to open the Debug perspective.
					

						The Debug perspective opens with the routing context suspended at the first breakpoint encountered in the running routing context.
					
Important

							Breakpoints are held for a maximum of five minutes, after which debugging automatically resumes, moving on to the next breakpoint or to the end of the routing context.
						

[image: openDBPerspective]

Note

							To see the console output, open the Console view if it was not open when you switched perspectives.
						

Note

							By default, the Debug perspective displays the Outline view, which provides the means to switch between separate routes in a running routing context. If your routing context contains a single route, closing the Outline view frees space to expand the other views, making it easier to access and examine debugger output.
						





Watching message exchanges progress through the routing context




				Click 
				[image: stepover co]
				 (Step Over) to jump to the next node of execution in the routing context. Click 
				[image: resume co]
				 (Resume) to continue execution at the next active breakpoint in the routing context.
			
[image: debug StateChange]


Related topics



	
						Chapter 16, Stopping the Camel Debugger
					




Chapter 16. Stopping the Camel Debugger



Overview




				To stop the Camel debugger, click 
				[image: Terminate button]
				 on the menu bar once if the debugging session has ended. Otherwise, click 
				[image: Terminate button]
				 twice: once to terminate the currently running node thread and once to terminate the Camel Context thread (both displayed in the Debug view).
			

				+
			
Note

					Terminating the Camel debugger also terminates the console but does not clear its output. To clear the output, click 
					[image: clear co]
					 (Clear Console) on the Console view’s menu bar.
				


Closing the Camel debugger




				After you have finished debugging your project, you may want to close the Debug perspective to make more space for your workbench.
			

				To do so, right-click 
				[image: Debug perspective icon]
				 on the right side of the CodeReady Studio toolbar, and then select Close.
			

Related topics



	
						Chapter 15, Running the Camel Debugger
					




Chapter 17. Changing Variable Values



Overview




				When the Camel debugger hits a breakpoint, the Variables view displays the values of all variables available at that point in the routing context. Some variables are editable, allowing you to change their value. This enables you to see how the application handles changes in program state.
			
Note

					Not all variables are editable. The context menu of editable variables displays the Change Value…​ option.
				


Procedure




				To change the value of a variable:
			
	
						If necessary, start the debugger. See Chapter 15, Running the Camel Debugger.
					
	
						In the Variables view, select a variable whose value you want to change, and then click its Value field.
					
[image: editBPvars1]


						The variable’s value field turns a lighter shade of blue, indicating that it is in edit mode.
					
Note

							Alternatively, you can right-click the variable to open its context menu, and select Change Value…​ to edit its value.
						


	
						Enter the new value and then click Enter.
					

						The Console view displays an INFO level log entry noting the change in the variable’s value (for example, Breakpoint at node to1 is updating message header on exchangeId: ID-dhcp-97-16-bos-redhat-com-52574-1417298894070-0-2 with header: Destination and value: UNITED KINGDOM).
					

	
						Continue stepping through the breakpoints and check whether the message is processed as expected. At each step, check the Debug view, the Variables view, and the Console output.
					



Related topics



	
						Chapter 19, Disabling Breakpoints in a Running Context
					
	
						Chapter 18, Adding Variables to the Watch List
					




Chapter 18. Adding Variables to the Watch List



Overview




				By adding variables to the watch list, you can focus on particular variables to see whether their values change as expected as they flow through the routing context.
			

Procedure




				To add a variable to the watch list:
			
	
						If necessary, start the debugger. See Chapter 15, Running the Camel Debugger.
					
	
						In the Variables view, right-click a variable you want to track to open the context menu.
					
[image: UGaddVarWatchList]


	
						Select Watch.
					

						A new view, Expressions, opens next to the Breakpoints view. The Expressions view displays the name of the variable being watched and its current value, for example:
					
[image: UGwatchList]


	
						Repeat [watch1] and [watch2] to add additional variables to the watch list.
					
Note

							The variables you add remain in the watch list until you remove them. To stop watching a variable, right-click it in the list to open the context menu, and then click Remove.
						


	
						With the Expressions view open, step through the routing context to track how the value of each variable in the watch list changes as it reaches each step in the route.
					



Related topics



	
						Chapter 17, Changing Variable Values
					




Chapter 19. Disabling Breakpoints in a Running Context



Overview




				You can disable and re-enable breakpoints in a running routing context in the Breakpoints view.
			

				When a breakpoint is disabled, the 
				[image: resume co]
				 button causes the debugger to skip over it during the debugging session.
			

Disabling and enabling breakpoints in Breakpoints view




				The Breakpoints view opens with all set breakpoints enabled.
			
[image: BPviewEnabled]


				To disable a breakpoint, clear its check box.
			
[image: BPviewDisabled]


				For each breakpoint you disable, the Console view displays an INFO level log entry noting that it has been disabled (for example, Removing breakpoint log2). Likewise, for each breakpoint you re-enable, the Console view displays an INFO level log entry noting that it has been enabled (for example, Adding breakpoint log2).
			
Note

					To re-enable a disabled breakpoint, click its check box. The Console view displays an INFO level log entry noting that the breakpoint has been added to the selected node.
				



Part III. Monitoring and Testing Applications





				The JMX Navigator view provides numerous ways to monitor and test your Fuse applications.
			
Note

					You can also monitor your Fuse applications with the Fuse Console as described in Managing Fuse.
				



Chapter 20. JMX Navigator




				The JMX Navigator view, shown in Figure 20.1, “JMX Navigator view”, displays all processes that are running in your application and it drives all interactions with the monitoring and testing features. Other areas of the Fuse Integration perspective adapt to display information related to the node selected in the JMX Navigator view. In the JMX Navigator view, its context menu provides the commands needed to activate route tracing and to add JMS destinations.
			
Figure 20.1. JMX Navigator view
[image: JMX Navigator view]



				By default, the JMX Navigator view discovers all JMX servers running on the local machine and lists them under the following categories:
			
	
						Local Processes
					
	
						Server Connections
					
	
						User-Defined Connections
					


Note

					You can add other JMX servers by using a server’s JMX URL. For details, see the section called “Adding a JMX server”.
				

Viewing Processes in JMX



Overview




					The JMX Navigator view lists all known processes in a series of trees. The root for each tree is a JMX server.
				

					The first tree in the list is a special Local Processes tree that contains all JMX servers that are running on the local machine. You must connect to one of the JMX servers to see the processes it contains.
				

Viewing processes in a local JMX server




					To view information about processes in a local JMX server:
				
	
							In the JMX Navigator view, expand Local Processes.
						
	
							Under Local Processes, double-click one of the top-level entries to connect to it.
						
	
							Click the 
							[image: expansion arrow]
							 icon that appears next to the entry to display a list of its components that are running in the JVM.
						



Viewing processes in alternate JMX servers




					To view information about processes in an alternate JMX server:
				
	
							the section called “Adding a JMX server” the JMX server to the JMX Navigator view.
						
	
							In the JMX Navigator view, expand the server’s entry by using the 
							[image: expansion arrow]
							 icon that appears next to the entry. This displays a list of that JMX server’s components that are running in the JVM.
						




Adding a JMX server



Overview




					In the JMX Navigator view, under the Local Processes branch of the tree, you can see a list of all local JMX servers. You may need to connect to specific JMX servers to see components deployed on other machines.
				

					To add a JMX server, you must know the JMX URL of the server you want to add.
				

Procedure




					To add a JMX server to the JMX Navigator view:
				
	
							In the JMX Navigator view, click New Connection [image: new server wiz]
							 .
						
	
							In the Create a new JMX connection wizard, select Default JMX Connection.
						
	
							Click Next.
						
	
							Select the Advanced tab.
						
	
							In the Name field, enter a name for the JMX server.
						

							The name can be any string. It is used to label the entry in the JMX Navigator tree.
						

	
							In the JMX URL field, enter the JMX URL of the server.
						
	
							If the JMX server requires authentication, enter your user name and password in the Username and Password fields.
						
	
							Click Finish.
						

							The new JMX server appears as a branch in the User-Defined Connections tree.
						






Chapter 21. Viewing a component’s JMX statistics



Overview




				The tooling collects all JMX statistics reported by Fuse components and displays them in the Properties view. This statistical information can provide significant insight into what is happening in your integration application.
			

				JMX statistics are grouped into three categories: Properties, Processor, and Profile.
			

Procedure




				To see a Fuse component’s statistics:
			
	
						In the JMX Navigator view, locate the node for the component.
					

						You may have to expand nodes on the tree to locate low-level components.
					

	
						Select the node of the Fuse component whose statistics you want to review.
					
	
						Open the Properties view.
					
	
						The Properties page displays the JMX properties for the selected component:
					
[image: JMXchoiceNodeProps]


	
						Click Processors to check exchange metrics for the selected component:
					
[image: JMXchoiceNodeProcs]


	
						Click Profile to check message metrics for the selected node and its subnodes:
					
[image: JMXchoiceNodeProfile]






Chapter 22. Browsing messages



Overview




				A key tool in debugging applications in a distributed environment is seeing all of the messages stored in the JMS destinations and route endpoints in the application. The tooling can browse the following:
			
	
						JMS destinations
					
	
						JMS routing endpoints
					
	
						Apache Camel routing endpoints
					
	
						SEDA routing endpoints
					
	
						Browse routing endpoints
					
	
						Mock routing endpoints
					
	
						VM routing endpoints
					
	
						DataSet routing endpoints
					



Procedure




				To browse messages:
			
	
						In the JMX Navigator view, select the JMS destination or endpoint you want to browse.
					

						The list of messages appears in the Messages View.
					

	
						In the Messages View, select an individual message to inspect.
					
[image: browseMsgView]


						Message details and content are displayed in the Properties view:
					
[image: browseMsgPropertiesV]





Related topics



	
						the section called “Tracing messages through a routing context”
					




Chapter 23. Tracing Routes




				Debugging a route often involves solving one of two problems:
			
	
						A message was improperly transformed.
					
	
						A message failed to reach its destination endpoint.
					



				Tracing one or more test messages through the route is the easiest way to discover the source of such problems.
			

				The tooling’s route tracing feature enables you to monitor the path a message takes through a route and see how the message is transformed as it passes from processor to processor.
			

				The Diagram View displays a graphical representation of the route, which enables you to see the path a message takes through it. For each processor in a route, it also displays the average processing time, in milliseconds, for all messages processed since route start-up and the number of messages processed since route start-up.
			

				The Messages View displays the messages processed by a JMS destination or route endpoint selected in the JMX Navigator tree. Selecting an individual message trace in the Messages View displays the full details and content of the message in the Properties view and highlights the correspoding node in the Diagram View.
			

				Tracing messages through a route involves the following steps:
			
	
						the section called “Creating test messages for route tracing”
					
	
						the section called “Activating route tracing”
					
	
						the section called “Tracing messages through a routing context”
					
	
						the section called “Deactivating route tracing”
					


Creating test messages for route tracing



Overview




					Route tracing works with any kind of message structure. The Fuse Message wizard creates an empty .xml message, leaving the structuring of the message entirely up to you.
				
Note

						If the folder where you want to store the test messages does not exist, you need to create it before you create the messages.
					


Creating a new folder to store test messages




					To create a new folder:
				
	
							In the Project Explorer view, right-click the project root to open the context menu.
						
	
							Select New → Folder to open the New Folder wizard.
						

							The project root appears in the Enter or select the parent folder field.
						

	
							Expand the nodes in the graphical representation of the project’s hierarchy, and select the node you want to be the parent folder.
						
	
							In the Folder name field, enter a name for the new folder.
						
	
							Click Finish.
						

							The new folder appears in the Project Explorer view, under the selected parent folder.
						
Note

								If the new folder does not appear, right-click the parent foler and select Refresh.
							





Creating a test message




					To create a test message:
				
	
							In the Project Explorer view, right-click the project to open the context menu.
						
	
							Select New → Fuse Message to open the New File wizard.
						
	
							Expand the nodes in the graphical representation of the project’s hierarchy, and select the folder in which you want to store the new test message.
						
	
							In the File name field, enter a name for the message, or accept the default (message.xml).
						
	
							Click Finish.
						

							The new message opens in the XML editor.
						

	
							Enter the message contents, both body and header text.
						
Note

								You may see the warning, No grammar constraints (DTD or XML Schema) referenced in the document, depending on the header text you entered. You can safely ignore this warning.
							





Related topics



	
							the section called “Tracing messages through a routing context”
						




Activating route tracing



Overview




					You must activate route tracing for the routing context before you can trace messages through that routing context.
				

Procedure




					To activate tracing on a routing context:
				
	
							In the JMX Navigator view, select the running routing context on which you want to start tracing.
						
Note

								You can select any route in the context to start tracing on the entire context.
							


	
							Right-click the selected routing context to open the context menu, and then select Start Tracing to start the trace.
						

							If Stop Tracing Context is enabled on the context menu, then tracing is already active.
						




Related topics



	
							the section called “Tracing messages through a routing context”
						
	
							the section called “Deactivating route tracing”
						




Tracing messages through a routing context



Overview




					The best way to see what is happening in a routing context is to watch what happens to a message at each stop along the way. The tooling provides a mechanism for dropping messages into a running routing context and tracing the path the messages take through it.
				

Procedure




					To trace messages through a routing context:
				
	
							Create one or more test messages as described in the section called “Creating test messages for route tracing”.
						
	
							In the Project Explorer view, right-click the project’s Camel context file to open the context menu, and select Run As → Local Camel Context (without Tests).
						
Note

								Do not run it as Local Camel Context unless you have created a comprehensive JUnit test for the project.
							


	
							Activate tracing for the running routing context as described in the section called “Activating route tracing”.
						
	
							Drag one of the test messages from the Project Explorer view onto the routing context’s starting point in the JMX Navigator view.
						
	
							In the JMX Navigator view, select the routing context being traced.
						

							The tooling populates the Messages View with message instances that represent the message at each stage in the traced context.
						

							The Diagram View displays a graphical representation of the selected routing context.
						

	
							In the Messages View, select one of the message instances.
						

							The Properties view displays the details and content of the message instance.
						

							In the Diagram View, the route step corresponding to the selected message instance is highlighted. If the route step is a processing step, the tooling tags the exiting path with timing and processing metrics.
						

	
							Repeat this prodedure as needed.
						



Related topics



	
							the section called “Creating test messages for route tracing”
						
	
							the section called “Activating route tracing”
						
	
							the section called “Deactivating route tracing”
						




Deactivating route tracing



Overview




					When you are finished debugging the routes in a routing context, you should deactivate tracing.
				
Important

						Deactivating tracing stops tracing and flushes the trace data for all of the routes in the routing context. This means that you cannot review any past tracing sessions.
					


Procedure




					To stop tracing for a routing context:
				
	
							In the JMX Navigator view, select the running routing context for which you want to deactivate tracing.
						
Note

								You can select any route in the context to stop tracing for the context.
							


	
							Right-click the selected routing context to open the context menu, and then select Stop Tracing Context.
						

							If Start Tracing appears on the context menu, tracing is not activated for the routing context.
						




Related topics



	
							the section called “Activating route tracing”
						
	
							the section called “Tracing messages through a routing context”
						





Chapter 24. Managing JMS destinations




				The JMX Navigator view lets you add or delete JMS destinations in a running instance of Red Hat Fuse.
			
Important

					These changes are not persistent across broker restarts.
				

Adding a JMS destination



Overview




					When testing a new scenario, it is convenient to add a new JMS destination to one of your brokers.
				

Procedure




					To add a JMS destination to a broker:
				
	
							In the JMX Navigator view, under the broker node for which you want to add a destination, select either the Queues child or the Topics child.
						
	
							Right-click the selected node to open the context menu, and then select either Create Queue or Create Topic.
						
	
							In either the Create Queue or Create Topic dialog, enter a name for the new destination.
						
	
							Click OK.
						
	
							Right-click either the Queues or the Topics child, and then select Refresh.
						

							The new destination appears in the JMX Navigator view under the Queues child or the Topics child.
						




Related topics



	
							the section called “Deleting a JMS destination”
						




Deleting a JMS destination



Overview




					When testing failover scenarios or other scenarios that involve handling failures, it is helpful to be able to easily remove a JMS destination.
				

Procedure




					To delete a JMS destination:
				
	
							In the JMX Navigator view, under the Queues child or the Topics child, select the JMS destination you want to delete.
						
	
							Right-click the selected destination to open the context menu, and then select Delete Queue/Topic.
						



Related topics



	
							the section called “Adding a JMS destination”
						





Chapter 25. Managing routing endpoints




				The JMX Navigator view lets you add or delete routing endpoints.
			
Important

					These changes are not persistent across routing context restarts.
				

Adding a routing endpoint



Overview




					When testing a new scenario, you might want to add a new endpoint to a routing context.
				

Procedure




					To add an endpoint to a routing context:
				
	
							In the JMX Navigator view, under the routing context node, select the Endpoints child to which you want to add an endpoint.
						
	
							Right-click the selected node to open the context menu, and then select Create Endpoint.
						
	
							In the Create Endpoint dialog, enter a URL that defines the new endpoint, for example, file://target/messages/validOrders.
						
	
							Click OK.
						
	
							Right-click the routing context node, and select Refresh.
						

							The new destination appears in the JMX Navigator view under the Endpoints node, in a folder that corresponds to the type of endpoint it is, for example, file.
						




Related topics



	
							the section called “Deleting a routing endpoint”
						




Deleting a routing endpoint



Overview




					When testing failover scenarios or other scenarios that involve handling failures, it is helpful to be able to remove an endpoint from a routing context.
				

Procedure




					To delete a routing endpoint:
				
	
							In the JMX Navigator view, select the endpoint you want delete.
						
	
							Right-click the selected endpoint to open the context menu, and then select Delete Endpoint.
						

							The tooling deletes the endpoint.
						

	
							To remove the deleted endpoint from the view, right-click the Endpoints node, and select Refresh.
						

							The endpoint disappears from the JMX Navigator view.
						
Note

								To remove the endpoint’s node from the Project Explorer view without rerunning the project, you need to explicitly delete it by right-clicking the node and selecting Delete. To remove it from view, refresh the project display.
							





Related topics



	
							the section called “Adding a routing endpoint”
						





Chapter 26. Editing running routes



Overview




				You can experiment with changes to a running route without changing your project’s routing context.
			

				To do so:
			
	
						In the JMX Navigator view, enable the Edit Routes option on the running routing context.
					

						This opens an in-memory model of it — Remote CamelContext:<camelContextId> — in the route editor.
					

	
						In the route editor, make your changes to the in-memory model of the routing context. At the same time, you can set breakpoints on relevant nodes to use the Camel debugger and all of its features.
					

						You can edit the in-memory model to add, remove, or rearrange nodes; to add or remove properties of existing nodes; and to modify property values set on existing nodes. You must save changes made to the in-memory model to update the running context and to see results in the Debug perspective if you set breakpoints.
					

	
						In the JMX Navigator view, drop messages on the running routing context, or wait for messages to arrive from a timer, ActiveMQ, file, or other continuous input node.
					
	
						In the Debug perspective, evaluate results and use the Camel debugger to gain deeper insight into your routing context.
					



Modifying a running route and evaluating results



	
						In the JMX Navigator view, select the routing context that contains the routes you want to edit.
					
	
						Right-click the selected routing context to open the context menu, and select Edit Routes.
					

						The route editor opens an in-memory model of the routing context, Remote CamelContext:<contextId>, and displays all routes in the context, for example:
					
[image: CanvasPalette]

Note

							<contextId> is the ID of the camelContext element in the project’s routing context .xml file. In this example, which is based on the Fuse → Content Based Router built-in template, the ID is cbr-example-context.
						


	
						Edit the route as described in Chapter 2, Editing a routing context in the route editor, then select File → Save to save the changes you made to the in-memory model and to update the running routing context.
					
	
						Set breakpoints on the relevant nodes as described in Chapter 14, Setting Breakpoints.
					
	
						In the JMX Navigator view, drop a message on the running routing context’s input node.
					

						If your project does not include test messages, you can create them as described in the section called “Creating test messages for route tracing”.
					

	
						Click Yes to confirm the switch to the Debug perspective.
					
	
						In the Camel debugger, step the message through the breakpoints as you normally would (see Chapter 15, Running the Camel Debugger) to see the results your changes generated.
					

						The Camel debugger behaves the same in Edit Routes mode as in normal debug mode, so you can use any of the Camel debugger’s features while a message is transiting the routing context.
					
Note

							When a message reaches the end of the routing context, the debugger is suspended. To continue debugging, switch back to the Fuse Integration perspective and drop another message on the input node in the JMX Navigator view. Each time you do so, the tooling asks you to confirm the switch to the Debug perspective.
						

Note

							During a route editing session, it is possible to lose the connection to the running routing context. If this happens, then in the JMX Navigator view, you would see something like this: Local Processes → maven[xxxx][Disconnected]. To continue the session, you must reconnect to the running routing context, select it in the JMX Navigator view, and then re-select Edit Routes.
						





Terminating the route editing session



	
						In the Debug perspective’s Debug view, select the Remote Camel Debug - camelContext--<contextId>--xxxxxxxxxxxxxxxxxx.xml [Remote Camel Context] thread, and then click 
						[image: Terminate button]
						 on the menu bar to terminate the debugging session.
					
	
						On Console view’s menu bar, click 
						[image: Terminate button]
						 to terminate the routing context.
					
	
						If you want to clear console output, click 
						[image: clear co]
						 on the Console view’s menu bar.
					
	
						Switch to the Fuse Integration perspective, and in the route editor, click 
						[image: close]
						 on the Remote CamelContext:<contextId> tab to close the in-memory model of the routing context file.
					



Related topics



	
						Chapter 2, Editing a routing context in the route editor
					
	
						Part II, “Debugging Routing Contexts”
					




Chapter 27. Managing routing contexts




				The JMX Navigator view lets you suspend and resume running routing contexts.
			
Suspending operation of a routing context



Overview




					The tooling enables you to suspend the operation of a routing context in the JMX Navigator view. Suspending context operation gracefully shuts down all routes in the context, but keeps them loaded in memory, so that they can resume operation.
				

Procedure




					To suspend operation of a routing context:
				
	
							In the JMX Navigator view, expand the project’s Camel Contexts node, and select the routing context whose operation you want to suspend.
						
	
							Right-click the selected routing context to open the context menu, and then select Suspend Camel Context.
						
Note

								If Resume Camel Context appears on the context menu, operation of the context is already suspended.
							





Related topics



	
							the section called “Resuming operation of a routing context”
						




Resuming operation of a routing context



Overview




					The tooling lets you resume operation of a suspended routing context in the JMX Navigator view. Resuming operation of a context restarts all of the routes in it so that they can process messages.
				

Procedure




					To resume operation of a routing context:
				
	
							In the JMX Navigator view, expand the project’s Camel Contexts node, and select the routing context whose operation you want to resume.
						
	
							Right-click the selected context to open the context menu, and then select Resume Camel Context.
						
Note

								If Suspend Camel Context appears in the context menu, the context and its routes are running.
							





Related topics



	
							the section called “Suspending operation of a routing context”
						





Part IV. Publishing Applications to a Container





				To publish Fuse Integration projects to a server container, you must first add the server and its runime definition to the tooling’s Servers list. Then you can assign projects to the server runtime and set the publishing options for it.
			


Chapter 28. Managing servers




				The Servers view lets you run and manage servers in your Red Hat CodeReady Studio environment.
			
Note

					For step by step instructions on how to publish a Camel project to Red Hat Fuse, see Chapter 29, Publishing Fuse Integration Projects to a Server.
				

Adding a Server



Overview




					For the tooling to manage a server, you need to add the server to the Servers list. Once added, the server appears in the Servers view, where you can connect to it and publish your Fuse Integration projects.
				
Note

						If adding a Red Hat Fuse server, it is recommended that you edit its installDir/etc/users.properties file and add user information, in the form of user=password,role, to enable the tooling to establish an SSH connection to the server.
					


Procedure




					There are three ways to add a new server to the Servers view:
				
	
							In the Servers view, click No servers are available. Click this link to create a new server…​.
						
Note

								This link appears in the Servers view only when no server has been defined. If you defined and added a server when you first created your project, the Servers view displays that server.
							


	
							In the Servers view, right-click to open the context menu and select New → Server.
						
	
							On the menu bar, select File → New → Other → Server → Server.
						



					In the Define a New Server dialog, to add a new server:
				
	
							Expand the Red Hat JBoss Middleware node to expose the list of available server options:
						
[image: List of servers]


	
							Click the server that you want to add.
						
	
							In the Server’s host name field, accept the default (localhost).
						
Note

								The address of localhost is 0.0.0.0.
							


	
							In the Server name field, accept the default, or enter a different name for the runtime server.
						
	
							For Server runtime environment, accept the default or click Add to open the server’s runtime definition page:
						
[image: Add server]

Note

								If the server is not already installed on your machine, you can install it now by clicking Download and install runtime…​ and following the site’s download instructions. Depending on the site, you might be required to provide valid credentials before you can continue the download process.
							


	
							Accept the default for the installation Name.
						
	
							In the Home Directory field, enter the path where the server runtime is installed, or click Browse to find and select it.
						
	
							Next to Execution Environment, select the runtime JRE from the drop-down menu.
						

							If the version you want does not appear in the list, click Environments and select the version from the list that appears. The JRE version you select must be installed on your machine.
						
Note

								See Red Hat Fuse Supported Configurations for the required Java version.
							


	
							Leave the Alternate JRE option as is.
						
	
							Click Next to save the server’s runtime definition and open its Configuration details page:
						
[image: UGJBFserverConfigDetails]


	
							Accept the default for SSH Port (8101).
						

							The runtime uses the SSH port to connect to the server’s Karaf shell. If this default is incorrect for your setup, you can discover the correct port number by looking in the server’s installDir/etc/org.apache.karaf.shell.cfg file.
						

	
							In the User Name field, enter the name used to log into the server.
						

							For Red Hat Fuse, this is a user name stored in the Red Hat Fuse installDir/etc/users.properties file.
						
Note

								If the default user has been activated (uncommented) in the /etc/users.properties file, the tooling autofills the User Name and Password fields with the default user’s name and password, as shown in [servCnfigDetails].
							


							If a user has not been set up, you can either add one to that file by using the format user=password,role (for example, joe=secret,Administrator), or you can set one using the karaf jaas command set:
						
	
									jaas:realms — to list the realms
								
	
									jaas:manage --index 1 — to edit the first (server) realm
								
	
									jaas:useradd <username> <password> — to add a user and associated password
								
	
									jaas:roleadd <username> Administrator — to specify the new user’s role
								
	
									jaas:update — to update the realm with the new user information
								



							If a jaas realm has already been selected for the server, you can discover the user name by issuing the command JBossFuse:karaf@root>jaas:users.
						

	
							In the Password field, enter the password required for User Name to log into the server.
						
	
							Click Finish to save the server’s configuration details.
						

							The server runtime appears in the Servers view.
						

							Expanding the server node exposes the server’s JMX node:
						
[image: UGnewServrInstalledExpand]






Starting a Server



Overview




					When you start a configured server, the tooling opens the server’s remote management console in the Terminal view. This allows you to easily manage the container while testing your application.
				

Procedure




					To start a server:
				
	
							In the Servers view, select the server you want to start.
						
	
							Click 
							[image: run button]
							 .
						
	
									The Console view opens and displays a message asking you to wait while the container is starting, for example:
								
[image: UGservrStartConsoleV]

Note

										If you did not properly configure the user name and password for opening the remote console, a dialog opens asking you to enter the proper credentials. See the section called “Adding a Server”.
									


	
									After the container has started up, the Terminal view opens to display the container’s management console.
								
	
									The running server appears in the Servers view:
								
[image: UGservrStartServrsView]


	
									The running server also appears in the JMX Navigator view under Server Connections:
								
[image: UGservStartJMXNavView]

Note

										If the server is running on the same machine as the tooling, the server also has an entry under Local Processes.
									









Connecting to a Running Server



Overview




					After you start a configured server, it appears in the Servers view and in the JMX Navigator view under the Server Connections node. You may need to expand the Server Connections node to see the server.
				

					To publish and test your Fuse project application on the running server, you must first connect to it. You can connect to a running server either in the Servers view or in the JMX Navigator view.
				
Note

						The Servers view and the JMX Navigator view are synchronized with regards to server connections. That is, connecting to a server in the Servers view also connects it in the JMX Navigator view, and vice versa.
					


Connecting to a running server in the Servers view



	
							In the Servers view, expand the server runtime to expose its JMX[Disconnected] node.
						
	
							Double-click the JMX[Disconnected] node:
						
[image: UGservrStartServrsView]





Connecting to a running server in the JMX Navigator view



	
							In the JMX Navigator view, under the Server Connections node, select the server to which you want to connect.
						
	
							Double-click the selected server:
						
[image: UGservConnectJMXNav]





Viewing bundles installed on the connected server



	
							In either the Servers view or the JMX Navigator view, expand the server runtime tree to expose the Bundles node, and select it.
						
	
							The tooling populates the Properties view with a list of bundles that are installed on the server:
						
[image: UGservBundles]


							Using the Properties view’s Search tool, you can search for bundles by their Symbolic Name or by their Identifier, if you know it. As you type the symbolic name or the identifier, the list updates, showing only the bundles that match the current search string.
						
Note

								Alternatively, you can issue the osgi:list command in the Terminal view to see a generated list of bundles installed on the Red Hat Fuse server runtime. The tooling uses a different naming scheme for OSGi bundles displayed by the osgi:list command.
							

								In the <build> section of project’s pom.xml file, you can find the bundle’s symbolic name and its bundle name (OSGi) listed in the maven-bundle-plugin entry. For more details, see the section called “Verifying the project was published to the server”.
							






Disconnecting from a Server



Overview




					When you are done testing your application, you can disconnect from the server without stopping it.
				
Note

						The Servers view and the JMX Navigator view are synchronized with regards to server connections. That is, disconnecting from a server in the Servers view also disconnects it in the JMX Navigator view, and vice versa.
					


Disconnecting from a server in the Servers view



	
							In the Servers view, expand the server runtime to expose its JMX[Connected] node.
						
	
							Right-click the JMX[Connected] node to open the context menu, and then select Disconnect.
						
[image: Disconnect]





Disconnecting from a server in the JMX Navigator view



	
							In the JMX Navigator view, under Server Connections, select the server from which you want to disconnect.
						
	
							Right-click the selected server to open the context menu, and then select Disconnect.
						
[image: Disconnect JMX]






Stopping a Server



Overview




					You can shut down a server in the Servers view or in the server’s remote console in the Terminal view.
				

Using the Servers view




					To stop a server:
				
	
							In the Servers view, select the server you want to stop.
						
	
							Click 
							[image: stop button]
							 .
						



Using the remote console




					To stop a server:
				
	
							Open the Terminal view that is hosting the server’s remote console.
						
	
							Press: CTRL+D
						




Deleting a Server



Overview




					When you are finished with a configured server, or if you misconfigure a server, you can delete it and its configuration.
				

					First, delete the server from the Servers view or from the JMX Navigator view. Next, delete the server’s configuration.
				

Deleting a server



	
							In the Servers view, right-click the server you want to delete to open the context menu.
						
	
							Select Delete.
						
	
							Click OK.
						



Deleting the server’s configuration



	
							On the menu bar, select CodeReady Studio → Preferences → Server.
						
Note

								On Linux and Windows machines, select Window → Preferences.
							


	
							Expand the Server folder, and then select Runtime Environments to open the Server Runtime Environments page.
						
	
							From the list, select the runtime environment of the server that you previously deleted from the Servers view, and then click Remove.
						
	
							Click OK.
						





Chapter 29. Publishing Fuse Integration Projects to a Server




				You deploy Fuse Integration projects into a server runtime using the Eclipse publishing mechanism. To do so, you must have defined and added the server to the Servers view in the Fuse Integration perspective. For a step-by-step demonstration, see .
			
Overview




				You can set up supported servers to publish assigned Fuse projects automatically or to publish them only when you manually invoke the publish command.
			

				Each server runtime added to the Servers view has its own Overview page that contains its configuration, connection, and publishing details:
			
[image: UGservRuntimeOverviewTab]


				You might need to expand Publishing to expose the server runtime publishing options and default settings:
			
	
						Never publish automatically — You must select this option to manually publish projects.
					
Important

							You must also disable the If server started, publish changes immediately option on the server’s Add and Remove page (for details see, the section called “Publishing Fuse projects manually”.
						


	
						Automatically publish when resources change — [default] Enable this option to automatically publish or republish a Fuse project when you save changes made to it. How quickly projects are published depends on the Publishing interval (default is 15 seconds).
					
	
						Automatically publish after a build event — For Fuse projects, works the same as Automatically publish when resources change.
					



Publishing Fuse projects automatically when resources change




				The default publishing option for server runtimes is Automatically publish when resources change.
			
	
						If necessary, start the server runtime to which you want to publish a Fuse project. For details, see the section called “Starting a Server”.
					
	
						In the Servers view, double-click the server runtime to open its Overview page.
					
	
						Expand Publishing, and then select Automatically publish when resources change.
					
	
						To increase or decrease the interval between publishing cycles, click the radio button next to Publishing interval (in seconds) up or down, as appropriate.
					
	
						In the Servers view, right-click the server runtime to open the context menu, and then select Add and Remove.
					
[image: UGservAddRemove1]


						All resources available for publishing appear in the Available column.
					

	
						To assign a resource (in this case, the CBRroute Fuse project) to the server runtime:
					
	
								Double-click it, or
							
	
								Select it, and click Add.
							

								The selected resource moves to the Configured column:
							
[image: UGservAddRemove2]


								At this stage, the time at which the assigned resource would actually be published depends on whether the server runtime was running and on the Publishing interval setting. However, if the server was stopped, you would have to manually publish the project after you started the server (for details, see the section called “Publishing Fuse projects manually”).
							




	
						Click the If server started, publish changes immediately option to enable it:
					
[image: UGservAddRemove3]


						This option ensures that the configured project is published immediately once you click Finish. The Automatically publish when resources change option on the server runtime Overview page ensures that the configured project is republished whenever changes made to the local project are saved.
					

	
						Click Finish.
					

						The project appears in the Servers view under the server runtime node, and the server runtime status reports [Started,Publishing…​].
					

						When publishing is done, the status of both the server runtime and the project report is [Started,Synchronized]:
					
[image: UGservPublishSynched]

Note

							For a server runtime, Synchronized means that all published resources on the server are identical to their local counterparts. For a published resource, Synchronized means that it is identical to its local counterpart.
						





Publishing Fuse projects manually



	
						If necessary, start the server runtime to which you want to publish a Fuse project. For details, see the section called “Starting a Server”.
					
	
						In the Servers view, double-click the server runtime to open its Overview page.
					
	
						Expand Publishing, and then select Never publish automatically.
					
	
						Click File → Save to save the publishing option changes.
					
	
						If the Fuse project has already been assigned to the server runtime, make sure this option is disabled: If server started, publish changes immediately:
					
	
								In the Servers view, right-click the server runtime to open the context menu.
							
	
								Click Add and Remove…​ to open the server’s Add and Remove page.
							
	
								If the following option is enabled, disable it: If server started, publish changes immediately.
							
	
								Skip to [finish].
							



	
						If the Fuse project has not been assigned to the server runtime, assign it now:
					
	
								Follow [startAssignResource] through [stopAssignResource] in the section called “Publishing Fuse projects automatically when resources change”.
							
	
								Do not enable the If server started, publish changes immediately option.
							



	
						 Click Finish.
					

						The project appears in the Servers view under the server runtime node, and the server runtime status reports [Started]:
					
[image: UGservPublishSynched]


	
						In the Servers view, right-click the project’s node. In this example, select the CBRroute Fuse project to open the context menu:
					
[image: UGassgnProjSrvViewCntxtMnu]


	
						Select Full Publish.
					

						During the publishing operation, the status of both the server runtime and the project report [Started,Republish].
					

						When publishing is done, the status of both the server runtime and the project report [Started,Synchronized]:
					
Note

							The tooling does not support the Incremental Publish option. Clicking Incremental Publish results in a full publish.
						





Verifying the project was published to the server




				After you have published a Fuse project to a server runtime, you can connect to the server and check that the project’s bundle was installed on it.
			
	
						Connect to the server runtime. For details see the section called “Connecting to a running server in the Servers view”.
					
	
						In the Servers view, expand the server runtime tree to expose the Bundles node and select it.
					

						The tooling populates the Properties view with a list of bundles that are installed on the server:
					
[image: UGsrvVerifyPublishedProj]


	
						To find your project’s bundle, either scroll down to the bottom of the list, or start typing the bundle’s Symbolic Name in the Properties view’s Search box. The bundle’s Symbolic Name is the name you gave your project when you created it.
					
Note

							Alternatively, you can issue the osgi:list command in the Terminal view to see a generated list of bundles installed on the Fuse server runtime. The tooling uses a different naming scheme for OSGi bundles displayed by the osgi:list command.
						

							In the <build> section of project’s pom.xml file, you can find the bundle’s symbolic name and its bundle name (OSGi) listed in the maven-bundle-plugin entry; for example:
						
[image: ugBundleNamesPomFile]







Appendix A. Fuse Integration Perspective




			Use the Fuse Integration perspective to design, monitor, test, and publish your integration application.
		
[image: Fuse Integration perspective]


			You can open the Fuse Integration perspective in the following ways:
		
	
					When you create a new Fuse Integration project (see Chapter 1, Creating a New Fuse Integration Project), the tooling switches to the Fuse Integration perspective.
				
	
					Click 
					[image: integration perspective]
					 on the right side of the CodeReady Studio tool bar. If the 
					[image: integration perspective]
					 icon is not available on the tool bar, click 
					[image: new persp]
					 and then select Fuse Integration from the list of available perspectives.
				
	
					Select Window → Perspective → Open Perspective → Fuse Integration.
				



			The Fuse Integration perspective consists of nine main areas:
		
	
					Project Explorer view
				

					Displays all projects known to the tooling. You can view all artifacts that make up each project. The Project Explorer view also displays all routing context .xml. files for a project under its Camel Contexts node. This enables you to find and open a routing context file included in a project. Under each routing context .xml file, the Project Explorer view displays all routes defined within the context. For multiroute contexts, this lets you focus on a specific route on the canvas.
				
[image: ProjectExplorerFIP]


	
					The route editor
				

					Provides the main design-time tooling and consists of three tabs:
				
	
							Design — Displays a large grid area on which routes are constructed and a palette from which Enterprise Integration Patterns (EIPs) and Camel components are selected and then connected on the canvas to form routes.
						
[image: CanvasPalette]


							The canvas is the route editor’s workbench and where you do most of your work. It displays a graphical representation of one or more routes, which are made up of connected EIPs and Camel components (called nodes once they are placed on the canvas).
						

							Selecting a node on the canvas populates the Properties view with the properties that apply to the selected node, so you can edit them.
						

							The Palette contains all of the patterns and Camel components needed to construct a route and groups them according to function — Components, Routing, Control Flow, Transformation, and Miscellaneous.
						

	
							Source
						

							Displays the contents of the .xml file for the routes constructed on the route editor’s canvas.
						

							You can edit the routing context in the Source tab as well as in the Design tab. The Source tab is useful for editing and adding any configuration, comments, or beans to the routing context file. The content assist feature helps you when working with configuration files. In the Source tab, press Ctrl+Space to see a list of possible values that can be inserted into your project.
						
[image: SourceView]


	
							Configurations
						

							Provides an easy way to add shared configuration (global endpoints, data formats, beans) to a multi-route routing context. For details see the section called “Adding global endpoints, data formats, or beans”.
						
[image: CnfigsVAddButton]


	
							REST
						

							Provides a graphical representation of Rest DSL components.
						
[image: RESTtab]





	
					Properties view
				

					Displays the properties of the node selected on the canvas.
				

	
					JMX Navigator view
				

					Lists the JMX servers and the infrastructure they monitor. It enables you to browse JMX servers and the pocesses they are monitoring. It also identifies instances of Red Hat processes.
				

					The JMX Navigator view drives all monitoring and testing activities in the Fuse Integration perspective. It determines which routes are displayed in the Diagram View, the Properties view, and the Messages View. It is also provides menu commands for activating route tracing, adding and deleting JMS destinations, and starting and suspending routes. It is also the target for dragging and dropping messages onto a route.
				

					By default, the JMX Navigator view shows all Java processes that are running on your local machine. You can add JMX servers as needed to view infrastructure on other machines.
				

	
					Diagram View
				

					Displays a graphical tree representing the node selected in the JMX Navigator view. When you select a process, server, endpoint, or other node, the Diagram View shows the selected node as the root with branches down to its children and grandchildren.
				

					When you select a broker, the Diagram View displays up to three children: connections, topics, and queues. It also shows configured connections and destinations as grandchildren.
				

					When you select a route, the Diagram View displays all nodes in the route and shows the different paths that messages can take through the route. It also displays timing metrics for each processing step in the route when route tracing is enabled.
				

	
					Messages View
				

					Lists the messages that have passed through the selected JMS destination or through Apache Camel endpoints when route tracing is enabled.
				

					When a JMS destination is selected in the JMX Navigator view, the view lists all messages that are at the destination.
				

					When route tracing is enabled, the Messages View lists all messages that passed through the nodes in the route since tracing started. You can configure the Messages View to display only the data in which you are interested and in your preferred sequence.
				

					When a message trace in the Messages View is selected, its details (message body and all message headers) appear in the Properties view. In the Diagram View, the step in the route associated with the selected message trace is highlighted.
				

	
					Servers view
				

					Displays a list of servers managed by the tooling. It displays their runtime status and provides controls for adding, starting and stopping them and for publishing projects to them.
				

	
					Terminal view
				

					Displays the command console of the connected container. You can control the container by entering commands in the Terminal view.
				

	
					Console view
				

					Displays the console output for recently executed actions.
				




Appendix B. Debug Perspective




			Use the Debug perspective to monitor and debug a running Camel context.
		
[image: Camel Context debugger]

	
					Debug view
				

					For the running Camel context, the Debug view displays the debug stack.
				

					You can switch between breakpoints within the same message flow, listed under the Camel Context at service:jmx:rmi://jndi/rmi://localhost:1099/jmxrmi/camel entry, to review and compare variable values in the Variables view.
				

					Messages flows are identified by their unique breadcrumb ID, and the breadcrumb ID of each subsequent message flow is incremented by 2. For example, if the breadcrumb ID for the first message flow is ID-janemurpheysmbp-home-54620-1470949590275-0-1, the breadcrumbID for the second message flow would be ID-janemurpheysmbp-home-54620-1470949590275-0-3.
				

	
					Variables view
				

					For each node in the routing context that has a breakpoint set, the Variables view displays the value of the available variables when the breakpoint is hit. Each variable who’s value changed since the preceding breakpoint is highlighted in yellow.
				

					You can change the value of editable variables to check whether such changes produce the expected results and to test the robustness of your routing context.
				

					You can also add variables to the watch list, so you can quickly and easily see whether their values change as expected at the expected point in the message flow.
				

	
					Breakpoints view
				

					Displays a list of the breakpoints set in the routing context, and shows whether they are enabled or disabled. You can enable and disable individual breakpoints by checking (enabling) or unchecking (disabling) them. This enables you to temporarily focus on nodes in your routing context that are behaving problematically.
				

					The 
					[image: resume co]
					 button skips over disabled breakpoints to jump to the next active breakpoint in the routing context. In contrast, the 
					[image: stepover co]
					 button jumps to the next node of execution in the routing context, regardless of breakpoints.
				

	
					camel Context.xml view
				

					Displays the running routing context file in graphical mode. For nodes set with breakpoints, it shows the type of breakpoint set and whether the breakpoint is enabled or disabled. When a breakpoint is hit, its corresponding node on the canvas is outlined in red.
				

					To check a node’s configuration, open the Properties view and then select the node on the canvas in camel Context.xml.
				

	
					Console view
				

					Displays the log output generated by the Camel debugger as it executes the routing context.
				

	
					Properties view
				

					Displays the properties set for the node selected on the canvas in CamelContext.xml.
				




OEBPS/images/topics/images/BPviewDisabled.png
4
4
4

ARRARRD QR EQRRC

QARR!

Variables |9 Breakpoints 53 RE %
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid=settead 1, project=CBRroute, filsName=cameContext.xml, contextid=blueprintContext]

Sonemana.

lueprintContext]

B[4

CBRroute, fileName=camelContext.xml, contextid:

CBRroute, fileName=camelContext.xml, contextid=blueprintContext]

1, project=CBRroute, fileName =camelContext.xr, contextl

62, project=CBRroute, fileName =camelContext.xr, contextl

_fr, project=CBRroute, fileName=camelContext.xml, contextld

9_ger, project=CBRroute, fileName=camelContext.xml, contextld=blueprintContext]

9_uk, project=CBRroute, fleName:

-amelContext.xrml, contextid=blueprintContext]

g _usa, project=CBRroute, fleName=camelContext.xm, contextid=blueprintContex]

@ Camel Breakpoint [endpointid=settead?, project=CBRroute, filsName~camelContext.xml, contextid=blueprintContext]
@ Camel Breakpoint [endpointic
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid=toGR, project=CBRroute, fileName:
@ Camel Breakpoint [endpointid:
@ Camel Breakpoint [endpointid=toUK, project=CBRroute, fileName ~camelContext.xml, contextid=blueprintContext]

tHead_f, project=CBRroute, fileName=camelContext.xml, contextid=blueprintContext]

tHead_ger, project=CBRroute, fileName

umelContext xmi, contextid =blueprintContext]

tHead_uk, proje

CBRroute, fleName=camelContext.xml, contextld:
BRroute, fileName

FR, project=CBRroute, fileName=camelContext.xml, contex

lueprintContext]

thead_usa, project:

imelContext xml, contextid=blueprintContext]

lueprintContext]

Fulfil, project=CBRroute, fileName=camelContext.xml, contextid=blueprintContex]

melContext.xml, contextid=blueprintContext]

project=CBRroute, fileName =camelContext.xml, contextid=blueprintContext]

@ camel Breakpoint [endpointid=toUs, project=CBRroute, fileName=camelContext.xml, contextid=blueprintContext]





OEBPS/images/topics/images/nfpRuntimeDefJBF1.png
Red Hat Fuse Runtime
Runtime definition for Red Hat Fuse 7+

Please point to a Red Hat Fuse installation.
Name
Red Hat Fuse 7+ Runtime 1

Home Directory in
Runtime JRE

* Execution Environment JavasE-1.8 o Environments...

Alternate JRE: JavaSEB(1.80171) O Installed JRES...

@ e Cance i





OEBPS/images/topics/images/terminatedlaunch_obj.png





OEBPS/images/topics/images/BrowseButton.jpg





OEBPS/Common_Content/fonts/overpass_light-web.woff


OEBPS/Common_Content/fonts/redhat/text/RedHatText-Regular.woff


OEBPS/images/topics/images/FinishButton.jpg





OEBPS/images/topics/images/ExpandArrow.jpg





OEBPS/images/topics/images/DTCamFeatsInstalled.png
e e e P e | camel-2.17.0. redhat-630159
linstatted 1 Tedhat-630159] cameCexse Canel2.17.0. redhat-630150
linstatted 1 Tedhat-630159] canel-fip Canel2.17.0. redhat-630150
[installed 1 Tedhat_630159] [caneljackson] Canel-2.17.0. redhat-630159
[installed ] redhat-630159] camel-jasypt camel-2. redhat-630159
linstalled ] redhat-630159] [canel=jaxb | camel-2.17.0. redhat-630159






OEBPS/images/topics/images/DTsourceType1.png
Source Type (XML)
€ A source file path must be supplied for the transformation.

XML Type Definition

@ XML Schema
©) XML instance Document

Source File:

Element Root:

XML Structure Preview.

@ [ <Back ) [ Nea> | [ cancel ] [ Finish





OEBPS/images/topics/images/new_persp.png





OEBPS/Common_Content/images/rhlogo.png
& RedHat





OEBPS/images/topics/images/remove_exc.png





OEBPS/images/topics/images/openDBPerspective.png
45 Debug 37 4t Servers

i (U e

W

4 Daemon Thread [CM Configuration Updater] (Running)
+® Dacmon Thread [CM Event Dispatcher] (Running)
4@ Daemon Thread [Blueprint Extender: 1] Running)
4@ Daemon Thread [Blucprint Extender: 2] Running)
4@ Daemon Thread [Blueprint Extender: 3] Running)
4@ Daemon Thread [fleinstall-/load] (Running)
4@ Daemon Thread [Blucprint Event Dispatcher. 1] (Running)
+® Dacmon Thread [Camel (_context1) thread #2 - il://src/data] (Running)
V) Camel Context at service:jmxrmi:/ /indi/rmi:/ localhost: 1099 jmxrmi /camel

7y ID-janemurpheysmbp-home-53332-1471280054270-

5 LbraryJava/ JavaVitualMachins;dk1.8.0.45 dk/ ContentsHome/bin/java (Aug 15, 2016, 12:53:47 PM)

) blueprintxml 52

1

. JBoss ¥ Fuse Integration |45 Debug
¥ = O | (0= Variables %% % Breakpoints ELEER G
Name [Value
» ) CamelDebugger ‘CamelDebuggerSettings (id=-2025998969)
_choicel
CamelProcessor (id=-1185022607)
» B Exchange CamelExchange (id=-1732430247)
¥ s Message CamelMessage d=-1732430247)

MessageBody.
Messageteaders
CamelFileAbsolute
CamelFileAbsolutePath
CamelFileLastModified

<7l version="L0" encoding="UTF-8"7>\n\n<order>\n <customer>\n <name>
CamelFileAbsolute = false\nCamelFileAbsolutePath = /Users/jmurphey/workspace08
false

JUsers/jmurphey/workspace0804/CBRroutesrc/data/message Lxml
1470351074000

messagel.xml

v[@]choice choic
v (@ when _whe
fLog los
[#setteac
7o inet
v[#otherwise

[#7o_rult
v & Route Routez
[@From _direct«

Design| Source | Configurations [ REST |

B Console 88 | Tasks

] |aBRE®re-o =0

Run blueprint.xm as Local CamelContext (2) [Local Camel Context] /Library/Java/JavaVirtualMachines jdk1.8.0_45 jdk/Contents /Home/bin/java (Aug 15, 2016, 12:53:47 PM)

[ TCP Connection(4)-192.168.1.3] BacklogDebugger. INFO Adding breakpoint _US

[ TCP Connection(4)-192.168.1.3] BacklogDebugger. INFO  Adding breakpoint _usa

[ TCP Connection(4)-192.168.1.3] BacklogDebugger. INFO  Adding breakpoint _setHead_usa

[ TCP Connection(4)-192.168.1.3] BacklogDebugger. INFO  Enabling debugger

[1) thread #2 - file://src/data] BacklogDebugger INFO  NodeBreakpoint at node _choicel is waiting to continue for exchangeld: I0-janemurpheysmbp-home-53332-1471280054270-0-2
[ TCP Connection(4)-192.168.1.3] BacklogDebugger. INFO Dump trace message from breakpoint _choicel

[ TCP Connection(4)-192.168.1.3]

BacklogDebugger

INFO

Dump trace message from breakpoint _choicel





OEBPS/images/topics/images/integration_perspective.png





OEBPS/images/topics/images/ConnectorArrow.jpg





OEBPS/images/topics/images/red-dot.png





OEBPS/Common_Content/images/dot.png





OEBPS/Common_Content/images/30.png





OEBPS/Common_Content/images/22.png





OEBPS/Common_Content/images/5.png





OEBPS/images/topics/images/CnfigsVEditGlobalDFprops1.png
M *camelContext.xml &

~ @ Red Hat Fuse
{3 myJMS (Endpoint)

& myDataFormat (Data Format)

Add

Edit

Delete

Design | Source |Configurations | REST |

Element Name

Encoding

[ Properties 32 | o’ v =
]
Details Xmljson myDataFormat
Documentation | Guneral
Array Name
Content Type Header &)

Expandable Properties

Remove Namespace Prefixes [ |
Root Name

Skip Namespaces
Skip Whitespace

0ooo

Trim Spaces

Type Hints

Force Top Level Object o
14 myDataFormat
Namespace Lenient o






OEBPS/images/topics/images/DTaddCustFunc2.png
header

0 customerNun

7o csug
Set property
Set variable

Set expression

Add transformation

Add custom transformation





OEBPS/images/topics/images/nfpTemplateExamples.png
Where can | find more examples?

More examples maintained by various communities are available on the
Following Github repositories:

- https://github.com/apache/camel/tree/master/examples
- https://github.com/Fabric8-quickstarts

- https://github.com /wildfly-extras/wildfly-camel-examples
- https://github.com/jboss-fuse/quickstarts

oK





OEBPS/Common_Content/images/note.png





OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-MediumItalic.woff2


OEBPS/images/topics/images/terminate_co.png





OEBPS/images/topics/images/NFT_camxmlPropsDetails.png
] Propertes 52 =0

- property Value
Details Aanotations
Buids. fabrics foiconur ima/icons/camel.svg
8uid Configs s

Creation Timestamp 2017-10-10T18:57:262
Deployments King Service
Deployment Configs Name camel-ose-springboot.xmi
— Namespace rewtest

Resource Version 3252
Routes iabels

oxpose trve

aroup org.mycompany

project camel-ose-springbaot-ami

provider fabrict

version 1.0.0-SNAPSHOT

vmisc

Container Port 8080

w 17230122129

Port 80

Selector orou mel-ose-springbaot-xm,provider=fabric

rg.mycompany, project





OEBPS/images/topics/images/m2RunConfig.png
Edit configuration and launch.
T Q

e

(B Main @ JRE| & Refresh| &, Source | I Environment | (] Common |

Base directory.
Goats:
Profles:
User settings:

() offine () Update Snapshots

() Debug Output (] Skip Tests (] Non-recursive

(0] Resolve Workspace artifacts

(1 ¢) Threads
Parameter Name  Value

[ Remove |

Maven Runtime: [ EMBEDDED (3.3.3/L.6.3.20160209-1444)

(CRever ] [_aooy |






OEBPS/Common_Content/images/37.png





OEBPS/images/topics/images/JMXchoiceNodeProps.png
] properties 58 M=o

ies | Propenty. Value
Properties Camel 1d blueprintContext
Processors, Exchanges Completed 6
profile Exchanges Failed 0

External Redeliveries 0

Failures Handled 0

Last Processing Time 14
Max Processing Time 211
Mean Processing Time 46

Min Processing Time 5
Processor Id choicel
Redeliveries 0

Route Id Routel.

Total Processing Time 276





OEBPS/images/topics/images/DTtransformEditor8.png
. Create a new mapping below by dragging a variable from the list of variables on the left to
& 2 propenty in target XyzOrder on the right.

Tansformatons
567 Target Xyzorder
[cmomend — [t & 8% (

[ordertum] = [orderid ]| @ xyzorcer
™ smms] =l @ origin

itemid

cost

price

‘quantity

header

amount

‘approvalCod

L

ABCOrder XyzOrder
-
header| approvalCode





OEBPS/images/topics/images/ProjectExplorerFIP.png
(25 Project Explorer 5% & v=0
v carroute
v 65 Camel Contexts
[/ Route Route1
[cRoute Route2
> (3 src/main/java
> (3 src/main/resources
> B srcjtest/java
» (3 srcftestresources
» B Maven Dependencies
» B\ IRE System Library (avase-1.8]
> G
> Garget
® pom.xmi
ReadMe.txt





OEBPS/images/topics/images/DTsourceType2.png
e o New Fuse Transformation
Source Type (XML) [sg

‘Speciy detail for the source XML for this transformation.

XML Type Definition

© X schema
XL instance Document

souce e

Element Root:  ABCOrder B
XML Structure Preview

<2ami version="1.0" encoding="UTF-8"2>
‘<xs:schema attributeFormDefault="unqualifed elementFormDefaults"qualfed xmins:xs="nt
<xsielement name="ABCOrder*>
<xsicomplexType>
xsisequence>

® <sacx

Cancel





OEBPS/images/topics/images/PreferredLabelsList.png
Select preferred labels for specific components (except endpoints)

omponent  Parameter

choice whenClauses

log message






OEBPS/Common_Content/fonts/overpass_regular-web.woff


OEBPS/Common_Content/images/green.png





OEBPS/images/topics/images/DTmyCustMapperJavaFile1.png
backage example;
public class MyCustonMapper {
public String brackets(String input) {

return null;

b





OEBPS/Common_Content/fonts/overpass_light-web.ttf


OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Regular.woff2


OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Bold.woff2


OEBPS/images/topics/images/DTtransfomEditor1.png
Create a new mapping below by dragging a property from source ABCOrder on the left to a property in target XyzOrder on the right.

Source: ABCOrder | $0 Variables Mappings Target: XyzOrder|

» @ ABCOrder: generated ABCOrder » @ XyzOrder: xyzorder.XyzOrder






OEBPS/images/topics/images/UGnewServrInstalledExpand.png
['§ Messages View 4 Servers 52 £ Console

¥ 5 Red Hat Fuse 7+ Runtime Server [Stopped]
@ JMX[Disconnected]





OEBPS/images/topics/images/DBCnfrmSwitchToDBView.png
| 800 Confirm Perspective Switch

§ ) This kind of launch is configured to open the Debug perspective when it suspends.

“This Debug perspective is designed to support application debugging. It

incorporates views for displaying the debug stack, variables and breakpoint
management.

Do you want to open this perspective now?

() Remember my decision






OEBPS/images/topics/images/nfpDefNewServRuntimeJBF.png
New Server Runtime Environment
Define a new server runtime environment

Select the type of runtime environment:

» 1> JBoss Community

> ow2

» (= Openshift

» (= Oracle

¥ (= Red Hat JBoss Middleware
4. Red Hat Fuse 7+
@ Red Hat JBoss Enterprise Application Platform 4.3 Runtime
@ Red Hat JBoss Enterprise Application Platform 5.x Runtime
@ Red Hat JBoss Enterprise Application Platform 6.0 Runtime
@ Red Hat JBoss Enterprise Application Platform 6.1+ Runtime
@ Red Hat JBoss Enterprise Application Platform 7.0 Runtime

Runtime definition for Red Hat Fuse 7+

Create a new local server

®@ Next > Cancel





OEBPS/images/topics/images/ConfigurationsView.png
R =

Add

Edit

Delete

Desin]Source | Contguraions REST|






OEBPS/Common_Content/scripts/highlight.js/README.ru.md
# Highlight.js

Highlight.js — это подсветчик синтаксиса, написанный на JavaScript. Он работает
и в браузере, и на сервере. Он работает с практически любой HTML разметкой, не
зависит от каких-либо фреймворков и умеет автоматически определять язык.


## Начало работы

Минимум, что нужно сделать для использования highlight.js на веб-странице — это
подключить библиотеку, CSS-стили и вызывать [`initHighlightingOnLoad`][1]:

```html
<link rel="stylesheet" href="/path/to/styles/default.css">
<script src="/path/to/highlight.pack.js"></script>
<script>hljs.initHighlightingOnLoad();</script>
```

Библиотека найдёт и раскрасит код внутри тегов `<pre><code>`, попытавшись
автоматически определить язык. Когда автоопределение не срабатывает, можно явно
указать язык в атрибуте class:

```html
<pre><code class="html">...</code></pre>
```

Список поддерживаемых классов языков доступен в [справочнике по классам][8].
Класс также можно предваоить префиксами `language-` или `lang-`.

Чтобы отключить подсветку для какого-то блока, используйте класс `nohighlight`:

```html
<pre><code class="nohighlight">...</code></pre>
```

## Инициализация вручную

Чтобы иметь чуть больше контроля за инициализацией подсветки, вы можете
использовать функции [`highlightBlock`][2] и [`configure`][3]. Таким образом
можно управлять тем, *что* подсвечивать и *когда*.

Вот пример инициализация, эквивалентной вызову [`initHighlightingOnLoad`][1], но
с использованием jQuery:

```javascript
$(document).ready(function() {
  $('pre code').each(function(i, block) {
    hljs.highlightBlock(block);
  });
});
```

Вы можете использовать любые теги разметки вместо `<pre><code>`. Если
используете контейнер, не сохраняющий переводы строк, вам нужно сказать
highlight.js использовать для них тег `<br>`:

```javascript
hljs.configure({useBR: true});

$('div.code').each(function(i, block) {
  hljs.highlightBlock(block);
});
```

Другие опции можно найти в документации функции [`configure`][3].


## Установка библиотеки

Highlight.js можно использовать в браузере прямо с CDN хостинга или скачать
индивидуальную сборку, а также установив модуль на сервере. На
[страница загрузки][4] подробно описаны все варианты.

Обратите внимание, что библиотека не предназначена для использования в виде
исходного кода на GitHub, а требует отдельной сборки. Если вам не подходит ни
один из готовых вариантов, читайте [документацию по сборке][5].


## Лицензия

Highlight.js распространяется под лицензией BSD. Подробнее читайте файл
[LICENSE][10].


## Ссылки

Официальный сайт билиотеки расположен по адресу <https://highlightjs.org/>.

Более подробная документация по API и другим темам расположена на
<http://highlightjs.readthedocs.org/>.

Авторы и контрибьютора перечислена в файле [AUTHORS.ru.txt][9] file.

[1]: http://highlightjs.readthedocs.org/en/latest/api.html#inithighlightingonload
[2]: http://highlightjs.readthedocs.org/en/latest/api.html#highlightblock-block
[3]: http://highlightjs.readthedocs.org/en/latest/api.html#configure-options
[4]: https://highlightjs.org/download/
[5]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[8]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[9]: https://github.com/isagalaev/highlight.js/blob/master/AUTHORS.ru.txt
[10]: https://github.com/isagalaev/highlight.js/blob/master/LICENSE
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## Version 8.4

We've got the new [demo page][]! The obvious new feature is the new look, but
apart from that it's got smarter: by presenting languages in groups it avoids
running 10000 highlighting attempts after first load which was slowing it down
and giving bad overall impression. It is now also being generated from test
code snippets so the authors of new languages don't have to update both tests
and the demo page with the same thing.

Other notable changes:

- The `template_comment` class is gone in favor of the more general `comment`.
- Number parsing unified and improved across languages.
- C++, Java and C# now use unified grammar to highlight titles in
  function/method definitions.
- The browser build is now usable as an AMD module, there's no separate build
  target for that anymore.
- OCaml has got a [comprehensive overhaul][ocaml] by [Mickaël Delahaye][].
- Clojure's data structures and literals are now highlighted outside of lists
  and we can now highlight Clojure's REPL sessions.

New languages:

- *AspectJ* by [Hakan Özler][]
- *STEP Part 21* by [Adam Joseph Cook][]
- *SML* derived by [Edwin Dalorzo][] from OCaml definition
- *Mercury* by [mucaho][]
- *Smali* by [Dennis Titze][]
- *Verilog* by [Jon Evans][]
- *Stata* by [Brian Quistorff][]

[Hakan Özler]: https://github.com/ozlerhakan
[Adam Joseph Cook]: https://github.com/adamjcook
[demo page]: https://highlightjs.org/static/demo/
[Ivan Sagalaev]: https://github.com/isagalaev
[Edwin Dalorzo]: https://github.com/edalorzo
[mucaho]: https://github.com/mucaho
[Dennis Titze]: https://github.com/titze
[Jon Evans]: https://github.com/craftyjon
[Brian Quistorff]: https://github.com/bquistorff
[ocaml]: https://github.com/isagalaev/highlight.js/pull/608#issue-46190207
[Mickaël Delahaye]: https://github.com/polazarus


## Version 8.3

We streamlined our tool chain, it is now based entirely on node.js instead of
being a mix of node.js, Python and Java. The build script options and arguments
remained the same, and we've noted all the changes in the [documentation][b].
Apart from reducing complexity, the new build script is also faster from not
having to start Java machine repeatedly. The credits for the work go to [Jeremy
Hull][].

Some notable fixes:

- PHP and JavaScript mixed in HTML now live happily with each other.
- JavaScript regexes now understand ES6 flags "u" and "y".
- `throw` keyword is no longer detected as a method name in Java.
- Fixed parsing of numbers and symbols in Clojure thanks to [input from Ivan
  Kleshnin][ik].

New languages in this release:

- *Less* by [Max Mikhailov][]
- *Stylus* by [Bryant Williams][]
- *Tcl* by [Radek Liska][]
- *Puppet* by [Jose Molina Colmenero][]
- *Processing* by [Erik Paluka][]
- *Twig* templates by [Luke Holder][]
- *PowerShell* by [David Mohundro][], based on [the work of Nicholas
  Blumhardt][ps]
- *XL* by [Christophe de Dinechin][]
- *LiveScript* by [Taneli Vatanen][] and [Jen Evers-Corvina][]
- *ERB* (Ruby in HTML) by [Lucas Mazza][]
- *Roboconf* by [Vincent Zurczak][]

[b]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[Jeremy Hull]: https://github.com/sourrust
[ik]: https://twitter.com/IvanKleshnin/status/514041599484231680
[Max Mikhailov]: https://github.com/seven-phases-max
[Bryant Williams]: https://github.com/scien
[Radek Liska]: https://github.com/Nindaleth
[Jose Molina Colmenero]: https://github.com/Moliholy
[Erik Paluka]: https://github.com/paluka
[Luke Holder]: https://github.com/lukeholder
[David Mohundro]: https://github.com/drmohundro
[ps]: https://github.com/OctopusDeploy/Library/blob/master/app/shared/presentation/highlighting/powershell.js
[Christophe de Dinechin]: https://github.com/c3d
[Taneli Vatanen]: https://github.com/Daiz-
[Jen Evers-Corvina]: https://github.com/sevvie
[Lucas Mazza]: https://github.com/lucasmazza
[Vincent Zurczak]: https://github.com/vincent-zurczak

## Version 8.2

We've finally got [real tests][test] and [continuous testing on Travis][ci]
thanks to [Jeremy Hull][] and [Chris Eidhof][]. The tests designed to cover
everything: language detection, correct parsing of individual language features
and various special cases. This is a very important change that gives us
confidence in extending language definitions and refactoring library core.

We're going to redesign the old [demo/test suite][demo] into an interactive
demo web app. If you're confident front-end developer or designer and want to
help us with it, drop a comment into [the issue][#542] on GitHub.

[test]: https://github.com/isagalaev/highlight.js/tree/master/test
[demo]: https://highlightjs.org/static/test.html
[#542]: https://github.com/isagalaev/highlight.js/issues/542
[ci]: https://travis-ci.org/isagalaev/highlight.js
[Jeremy Hull]: https://github.com/sourrust
[Chris Eidhof]: https://github.com/chriseidhof

As usually there's a handful of new languages in this release:

- *Groovy* by [Guillaume Laforge][]
- *Dart* by [Maxim Dikun][]
- *Dust* by [Michael Allen][]
- *Scheme* by [JP Verkamp][]
- *G-Code* by [Adam Joseph Cook][]
- *Q* from Kx Systems by [Sergey Vidyuk][]

[Guillaume Laforge]: https://github.com/glaforge
[Maxim Dikun]: https://github.com/dikmax
[Michael Allen]: https://github.com/bfui
[JP Verkamp]: https://github.com/jpverkamp
[Adam Joseph Cook]: https://github.com/adamjcook
[Sergey Vidyuk]: https://github.com/sv

Other improvements:

- [Erik Osheim][] heavily reworked Scala definitions making it richer.
- [Lucas Mazza][] fixed Ruby hashes highlighting
- Lisp variants (Lisp, Clojure and Scheme) are unified in regard to naming
  the first symbol in parentheses: it's "keyword" in general case and also
  "built_in" for built-in functions in Clojure and Scheme.

[Erik Osheim]: https://github.com/non
[Lucas Mazza]: https://github.com/lucasmazza

## Version 8.1

New languages:

- *Gherkin* by [Sam Pikesley][]
- *Elixir* by [Josh Adams][]
- *NSIS* by [Jan T. Sott][]
- *VIM script* by [Jun Yang][]
- *Protocol Buffers* by [Dan Tao][]
- *Nix* by [Domen Kožar][]
- *x86asm* by [innocenat][]
- *Cap’n Proto* and *Thrift* by [Oleg Efimov][]
- *Monkey* by [Arthur Bikmullin][]
- *TypeScript* by [Panu Horsmalahti][]
- *Nimrod* by [Flaviu Tamas][]
- *Gradle* by [Damian Mee][]
- *Haxe* by [Christopher Kaster][]
- *Swift* by [Chris Eidhof][] and [Nate Cook][]

New styles:

- *Kimbie*, light and dark variants by [Jan T. Sott][]
- *Color brewer* by [Fabrício Tavares de Oliveira][]
- *Codepen.io embed* by [Justin Perry][]
- *Hybrid* by [Nic West][]

[Sam Pikesley]: https://github.com/pikesley
[Sindre Sorhus]: https://github.com/sindresorhus
[Josh Adams]: https://github.com/knewter
[Jan T. Sott]: https://github.com/idleberg
[Jun Yang]: https://github.com/harttle
[Dan Tao]: https://github.com/dtao
[Domen Kožar]: https://github.com/iElectric
[innocenat]: https://github.com/innocenat
[Oleg Efimov]: https://github.com/Sannis
[Arthur Bikmullin]: https://github.com/devolonter
[Panu Horsmalahti]: https://github.com/panuhorsmalahti
[Flaviu Tamas]: https://github.com/flaviut
[Damian Mee]: https://github.com/chester1000
[Christopher Kaster]: http://christopher.kaster.ws
[Fabrício Tavares de Oliveira]: https://github.com/fabriciotav
[Justin Perry]: https://github.com/ourmaninamsterdam
[Nic West]: https://github.com/nicwest
[Chris Eidhof]: https://github.com/chriseidhof
[Nate Cook]: https://github.com/natecook1000

Other improvements:

- The README is heavily reworked and brought up to date by [Jeremy Hull][].
- Added [`listLanguages()`][ll] method in the API.
- Improved C/C++/C# detection.
- Added a bunch of new language aliases, documented the existing ones. Thanks to
  [Sindre Sorhus][] for background research.
- Added phrasal English words to boost relevance in comments.
- Many improvements to SQL definition made by [Heiko August][],
  [Nikolay Lisienko][] and [Travis Odom][].
- The shorter `lang-` prefix for language names in HTML classes supported
  alongside `language-`. Thanks to [Jeff Escalante][].
- Ruby's got support for interactive console sessions. Thanks to
  [Pascal Hurni][].
- Added built-in functions for R language. Thanks to [Artem A. Klevtsov][].
- Rust's got definition for lifetime parameters and improved string syntax.
  Thanks to [Roman Shmatov][].
- Various improvements to Objective-C definition by [Matt Diephouse][].
- Fixed highlighting of generics in Java.

[ll]: http://highlightjs.readthedocs.org/en/latest/api.html#listlanguages
[Sindre Sorhus]: https://github.com/sindresorhus
[Heiko August]: https://github.com/auge8472
[Nikolay Lisienko]: https://github.com/neor-ru
[Travis Odom]: https://github.com/Burstaholic
[Jeff Escalante]: https://github.com/jenius
[Pascal Hurni]: https://github.com/phurni
[Jiyin Yiyong]: https://github.com/jiyinyiyong
[Artem A. Klevtsov]: https://github.com/unikum
[Roman Shmatov]: https://github.com/shmatov
[Jeremy Hull]: https://github.com/sourrust
[Matt Diephouse]: https://github.com/mdiep


## Version 8.0

This new major release is quite a big overhaul bringing both new features and
some backwards incompatible changes. However, chances are that the majority of
users won't be affected by the latter: the basic scenario described in the
README is left intact.

Here's what did change in an incompatible way:

- We're now prefixing all classes located in [CSS classes reference][cr] with
  `hljs-`, by default, because some class names would collide with other
  people's stylesheets. If you were using an older version, you might still want
  the previous behavior, but still want to upgrade. To suppress this new
  behavior, you would initialize like so:

  ```html
  <script type="text/javascript">
    hljs.configure({classPrefix: ''});
    hljs.initHighlightingOnLoad();
  </script>
  ```

- `tabReplace` and `useBR` that were used in different places are also unified
  into the global options object and are to be set using `configure(options)`.
  This function is documented in our [API docs][]. Also note that these
  parameters are gone from `highlightBlock` and `fixMarkup` which are now also
  rely on `configure`.

- We removed public-facing (though undocumented) object `hljs.LANGUAGES` which
  was used to register languages with the library in favor of two new methods:
  `registerLanguage` and `getLanguage`. Both are documented in our [API docs][].

- Result returned from `highlight` and `highlightAuto` no longer contains two
  separate attributes contributing to relevance score, `relevance` and
  `keyword_count`. They are now unified in `relevance`.

Another technically compatible change that nonetheless might need attention:

- The structure of the NPM package was refactored, so if you had installed it
  locally, you'll have to update your paths. The usual `require('highlight.js')`
  works as before. This is contributed by [Dmitry Smolin][].

New features:

- Languages now can be recognized by multiple names like "js" for JavaScript or
  "html" for, well, HTML (which earlier insisted on calling it "xml"). These
  aliases can be specified in the class attribute of the code container in your
  HTML as well as in various API calls. For now there are only a few very common
  aliases but we'll expand it in the future. All of them are listed in the
  [class reference][cr].

- Language detection can now be restricted to a subset of languages relevant in
  a given context — a web page or even a single highlighting call. This is
  especially useful for node.js build that includes all the known languages.
  Another example is a StackOverflow-style site where users specify languages
  as tags rather than in the markdown-formatted code snippets. This is
  documented in the [API reference][] (see methods `highlightAuto` and
  `configure`).

- Language definition syntax streamlined with [variants][] and
  [beginKeywords][].

New languages and styles:

- *Oxygene* by [Carlo Kok][]
- *Mathematica* by [Daniel Kvasnička][]
- *Autohotkey* by [Seongwon Lee][]
- *Atelier* family of styles in 10 variants by [Bram de Haan][]
- *Paraíso* styles by [Jan T. Sott][]

Miscellaneous improvements:

- Highlighting `=>` prompts in Clojure.
- [Jeremy Hull][] fixed a lot of styles for consistency.
- Finally, highlighting PHP and HTML [mixed in peculiar ways][php-html].
- Objective C and C# now properly highlight titles in method definition.
- Big overhaul of relevance counting for a number of languages. Please do report
  bugs about mis-detection of non-trivial code snippets!

[API reference]: http://highlightjs.readthedocs.org/en/latest/api.html

[cr]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[api docs]: http://highlightjs.readthedocs.org/en/latest/api.html
[variants]: https://groups.google.com/d/topic/highlightjs/VoGC9-1p5vk/discussion
[beginKeywords]: https://github.com/isagalaev/highlight.js/commit/6c7fdea002eb3949577a85b3f7930137c7c3038d
[php-html]: https://twitter.com/highlightjs/status/408890903017689088

[Carlo Kok]: https://github.com/carlokok
[Bram de Haan]: https://github.com/atelierbram
[Daniel Kvasnička]: https://github.com/dkvasnicka
[Dmitry Smolin]: https://github.com/dimsmol
[Jeremy Hull]: https://github.com/sourrust
[Seongwon Lee]: https://github.com/dlimpid
[Jan T. Sott]: https://github.com/idleberg


## Version 7.5

A catch-up release dealing with some of the accumulated contributions. This one
is probably will be the last before the 8.0 which will be slightly backwards
incompatible regarding some advanced use-cases.

One outstanding change in this version is the addition of 6 languages to the
[hosted script][d]: Markdown, ObjectiveC, CoffeeScript, Apache, Nginx and
Makefile. It now weighs about 6K more but we're going to keep it under 30K.

New languages:

- OCaml by [Mehdi Dogguy][mehdid] and [Nicolas Braud-Santoni][nbraud]
- [LiveCode Server][lcs] by [Ralf Bitter][revig]
- Scilab by [Sylvestre Ledru][sylvestre]
- basic support for Makefile by [Ivan Sagalaev][isagalaev]

Improvements:

- Ruby's got support for characters like `?A`, `?1`, `?\012` etc. and `%r{..}`
  regexps.
- Clojure now allows a function call in the beginning of s-expressions
  `(($filter "myCount") (arr 1 2 3 4 5))`.
- Haskell's got new keywords and now recognizes more things like pragmas,
  preprocessors, modules, containers, FFIs etc. Thanks to [Zena Treep][treep]
  for the implementation and to [Jeremy Hull][sourrust] for guiding it.
- Miscellaneous fixes in PHP, Brainfuck, SCSS, Asciidoc, CMake, Python and F#.

[mehdid]: https://github.com/mehdid
[nbraud]: https://github.com/nbraud
[revig]: https://github.com/revig
[lcs]: http://livecode.com/developers/guides/server/
[sylvestre]: https://github.com/sylvestre
[isagalaev]: https://github.com/isagalaev
[treep]: https://github.com/treep
[sourrust]: https://github.com/sourrust
[d]: http://highlightjs.org/download/


## New core developers

The latest long period of almost complete inactivity in the project coincided
with growing interest to it led to a decision that now seems completely obvious:
we need more core developers.

So without further ado let me welcome to the core team two long-time
contributors: [Jeremy Hull][] and [Oleg
Efimov][].

Hope now we'll be able to work through stuff faster!

P.S. The historical commit is [here][1] for the record.

[Jeremy Hull]: https://github.com/sourrust
[Oleg Efimov]: https://github.com/sannis
[1]: https://github.com/isagalaev/highlight.js/commit/f3056941bda56d2b72276b97bc0dd5f230f2473f


## Version 7.4

This long overdue version is a snapshot of the current source tree with all the
changes that happened during the past year. Sorry for taking so long!

Along with the changes in code highlight.js has finally got its new home at
<http://highlightjs.org/>, moving from its cradle on Software Maniacs which it
outgrew a long time ago. Be sure to report any bugs about the site to
<mailto:info@highlightjs.org>.

On to what's new…

New languages:

- Handlebars templates by [Robin Ward][]
- Oracle Rules Language by [Jason Jacobson][]
- F# by [Joans Follesø][]
- AsciiDoc and Haml by [Dan Allen][]
- Lasso by [Eric Knibbe][]
- SCSS by [Kurt Emch][]
- VB.NET by [Poren Chiang][]
- Mizar by [Kelley van Evert][]

[Robin Ward]: https://github.com/eviltrout
[Jason Jacobson]: https://github.com/jayce7
[Joans Follesø]: https://github.com/follesoe
[Dan Allen]: https://github.com/mojavelinux
[Eric Knibbe]: https://github.com/EricFromCanada
[Kurt Emch]: https://github.com/kemch
[Poren Chiang]: https://github.com/rschiang
[Kelley van Evert]: https://github.com/kelleyvanevert

New style themes:

- Monokai Sublime by [noformnocontent][]
- Railscasts by [Damien White][]
- Obsidian by [Alexander Marenin][]
- Docco by [Simon Madine][]
- Mono Blue by [Ivan Sagalaev][] (uses a single color hue for everything)
- Foundation by [Dan Allen][]

[noformnocontent]: http://nn.mit-license.org/
[Damien White]: https://github.com/visoft
[Alexander Marenin]: https://github.com/ioncreature
[Simon Madine]: https://github.com/thingsinjars
[Ivan Sagalaev]: https://github.com/isagalaev

Other notable changes:

- Corrected many corner cases in CSS.
- Dropped Python 2 version of the build tool.
- Implemented building for the AMD format.
- Updated Rust keywords (thanks to [Dmitry Medvinsky][]).
- Literal regexes can now be used in language definitions.
- CoffeeScript highlighting is now significantly more robust and rich due to
  input from [Cédric Néhémie][].

[Dmitry Medvinsky]: https://github.com/dmedvinsky
[Cédric Néhémie]: https://github.com/abe33


## Version 7.3

- Since this version highlight.js no longer works in IE version 8 and older.
  It's made it possible to reduce the library size and dramatically improve code
  readability and made it easier to maintain. Time to go forward!

- New languages: AppleScript (by [Nathan Grigg][ng] and [Dr. Drang][dd]) and
  Brainfuck (by [Evgeny Stepanischev][bolk]).

- Improvements to existing languages:

    - interpreter prompt in Python (`>>>` and `...`)
    - @-properties and classes in CoffeeScript
    - E4X in JavaScript (by [Oleg Efimov][oe])
    - new keywords in Perl (by [Kirk Kimmel][kk])
    - big Ruby syntax update (by [Vasily Polovnyov][vast])
    - small fixes in Bash

- Also Oleg Efimov did a great job of moving all the docs for language and style
  developers and contributors from the old wiki under the source code in the
  "docs" directory. Now these docs are nicely presented at
  <http://highlightjs.readthedocs.org/>.

[ng]: https://github.com/nathan11g
[dd]: https://github.com/drdrang
[bolk]: https://github.com/bolknote
[oe]: https://github.com/Sannis
[kk]: https://github.com/kimmel
[vast]: https://github.com/vast


## Version 7.2

A regular bug-fix release without any significant new features. Enjoy!


## Version 7.1

A Summer crop:

- [Marc Fornos][mf] made the definition for Clojure along with the matching
  style Rainbow (which, of course, works for other languages too).
- CoffeeScript support continues to improve getting support for regular
  expressions.
- Yoshihide Jimbo ported to highlight.js [five Tomorrow styles][tm] from the
  [project by Chris Kempson][tm0].
- Thanks to [Casey Duncun][cd] the library can now be built in the popular
  [AMD format][amd].
- And last but not least, we've got a fair number of correctness and consistency
  fixes, including a pretty significant refactoring of Ruby.

[mf]: https://github.com/mfornos
[tm]: http://jmblog.github.com/color-themes-for-highlightjs/
[tm0]: https://github.com/ChrisKempson/Tomorrow-Theme
[cd]: https://github.com/caseman
[amd]: http://requirejs.org/docs/whyamd.html


## Version 7.0

The reason for the new major version update is a global change of keyword syntax
which resulted in the library getting smaller once again. For example, the
hosted build is 2K less than at the previous version while supporting two new
languages.

Notable changes:

- The library now works not only in a browser but also with [node.js][]. It is
  installable with `npm install highlight.js`. [API][] docs are available on our
  wiki.

- The new unique feature (apparently) among syntax highlighters is highlighting
  *HTTP* headers and an arbitrary language in the request body. The most useful
  languages here are *XML* and *JSON* both of which highlight.js does support.
  Here's [the detailed post][p] about the feature.

- Two new style themes: a dark "south" *[Pojoaque][]* by Jason Tate and an
  emulation of*XCode* IDE by [Angel Olloqui][ao].

- Three new languages: *D* by [Aleksandar Ružičić][ar], *R* by [Joe Cheng][jc]
  and *GLSL* by [Sergey Tikhomirov][st].

- *Nginx* syntax has become a million times smaller and more universal thanks to
  remaking it in a more generic manner that doesn't require listing all the
  directives in the known universe.

- Function titles are now highlighted in *PHP*.

- *Haskell* and *VHDL* were significantly reworked to be more rich and correct
  by their respective maintainers [Jeremy Hull][sr] and [Igor Kalnitsky][ik].

And last but not least, many bugs have been fixed around correctness and
language detection.

Overall highlight.js currently supports 51 languages and 20 style themes.

[node.js]: http://nodejs.org/
[api]: http://softwaremaniacs.org/wiki/doku.php/highlight.js:api
[p]: http://softwaremaniacs.org/blog/2012/05/10/http-and-json-in-highlight-js/en/
[pojoaque]: http://web-cms-designs.com/ftopict-10-pojoaque-style-for-highlight-js-code-highlighter.html
[ao]: https://github.com/angelolloqui
[ar]: https://github.com/raleksandar
[jc]: https://github.com/jcheng5
[st]: https://github.com/tikhomirov
[sr]: https://github.com/sourrust
[ik]: https://github.com/ikalnitsky


## Version 6.2

A lot of things happened in highlight.js since the last version! We've got nine
new contributors, the discussion group came alive, and the main branch on GitHub
now counts more than 350 followers. Here are most significant results coming
from all this activity:

- 5 (five!) new languages: Rust, ActionScript, CoffeeScript, MatLab and
  experimental support for markdown. Thanks go to [Andrey Vlasovskikh][av],
  [Alexander Myadzel][am], [Dmytrii Nagirniak][dn], [Oleg Efimov][oe], [Denis
  Bardadym][db] and [John Crepezzi][jc].

- 2 new style themes: Monokai by [Luigi Maselli][lm] and stylistic imitation of
  another well-known highlighter Google Code Prettify by [Aahan Krish][ak].

- A vast number of [correctness fixes and code refactorings][log], mostly made
  by [Oleg Efimov][oe] and [Evgeny Stepanischev][es].

[av]: https://github.com/vlasovskikh
[am]: https://github.com/myadzel
[dn]: https://github.com/dnagir
[oe]: https://github.com/Sannis
[db]: https://github.com/btd
[jc]: https://github.com/seejohnrun
[lm]: http://grigio.org/
[ak]: https://github.com/geekpanth3r
[es]: https://github.com/bolknote
[log]: https://github.com/isagalaev/highlight.js/commits/


## Version 6.1 — Solarized

[Jeremy Hull][jh] has implemented my dream feature — a port of [Solarized][]
style theme famous for being based on the intricate color theory to achieve
correct contrast and color perception. It is now available for highlight.js in
both variants — light and dark.

This version also adds a new original style Arta. Its author pumbur maintains a
[heavily modified fork of highlight.js][pb] on GitHub.

[jh]: https://github.com/sourrust
[solarized]: http://ethanschoonover.com/solarized
[pb]: https://github.com/pumbur/highlight.js


## Version 6.0

New major version of the highlighter has been built on a significantly
refactored syntax. Due to this it's even smaller than the previous one while
supporting more languages!

New languages are:

- Haskell by [Jeremy Hull][sourrust]
- Erlang in two varieties — module and REPL — made collectively by [Nikolay
  Zakharov][desh], [Dmitry Kovega][arhibot] and [Sergey Ignatov][ignatov]
- Objective C by [Valerii Hiora][vhbit]
- Vala by [Antono Vasiljev][antono]
- Go by [Stephan Kountso][steplg]

[sourrust]: https://github.com/sourrust
[desh]: http://desh.su/
[arhibot]: https://github.com/arhibot
[ignatov]: https://github.com/ignatov
[vhbit]: https://github.com/vhbit
[antono]: https://github.com/antono
[steplg]: https://github.com/steplg

Also this version is marginally faster and fixes a number of small long-standing
bugs.

Developer overview of the new language syntax is available in a [blog post about
recent beta release][beta].

[beta]: http://softwaremaniacs.org/blog/2011/04/25/highlight-js-60-beta/en/

P.S. New version is not yet available on a Yandex CDN, so for now you have to
download [your own copy][d].

[d]: /soft/highlight/en/download/


## Version 5.14

Fixed bugs in HTML/XML detection and relevance introduced in previous
refactoring.

Also test.html now shows the second best result of language detection by
relevance.


## Version 5.13

Past weekend began with a couple of simple additions for existing languages but
ended up in a big code refactoring bringing along nice improvements for language
developers.

### For users

- Description of C++ has got new keywords from the upcoming [C++ 0x][] standard.
- Description of HTML has got new tags from [HTML 5][].
- CSS-styles have been unified to use consistent padding and also have lost
  pop-outs with names of detected languages.
- [Igor Kalnitsky][ik] has sent two new language descriptions: CMake & VHDL.

This makes total number of languages supported by highlight.js to reach 35.

Bug fixes:

- Custom classes on `<pre>` tags are not being overridden anymore
- More correct highlighting of code blocks inside non-`<pre>` containers:
  highlighter now doesn't insist on replacing them with its own container and
  just replaces the contents.
- Small fixes in browser compatibility and heuristics.

[c++ 0x]: http://ru.wikipedia.org/wiki/C%2B%2B0x
[html 5]: http://en.wikipedia.org/wiki/HTML5
[ik]: http://kalnitsky.org.ua/

### For developers

The most significant change is the ability to include language submodes right
under `contains` instead of defining explicit named submodes in the main array:

    contains: [
      'string',
      'number',
      {begin: '\\n', end: hljs.IMMEDIATE_RE}
    ]

This is useful for auxiliary modes needed only in one place to define parsing.
Note that such modes often don't have `className` and hence won't generate a
separate `<span>` in the resulting markup. This is similar in effect to
`noMarkup: true`. All existing languages have been refactored accordingly.

Test file test.html has at last become a real test. Now it not only puts the
detected language name under the code snippet but also tests if it matches the
expected one. Test summary is displayed right above all language snippets.


## CDN

Fine people at [Yandex][] agreed to host highlight.js on their big fast servers.
[Link up][l]!

[yandex]: http://yandex.com/
[l]: http://softwaremaniacs.org/soft/highlight/en/download/


## Version 5.10 — "Paris".

Though I'm on a vacation in Paris, I decided to release a new version with a
couple of small fixes:

- Tomas Vitvar discovered that TAB replacement doesn't always work when used
  with custom markup in code
- SQL parsing is even more rigid now and doesn't step over SmallTalk in tests


## Version 5.9

A long-awaited version is finally released.

New languages:

- Andrew Fedorov made a definition for Lua
- a long-time highlight.js contributor [Peter Leonov][pl] made a definition for
  Nginx config
- [Vladimir Moskva][vm] made a definition for TeX

[pl]: http://kung-fu-tzu.ru/
[vm]: http://fulc.ru/

Fixes for existing languages:

- [Loren Segal][ls] reworked the Ruby definition and added highlighting for
  [YARD][] inline documentation
- the definition of SQL has become more solid and now it shouldn't be overly
  greedy when it comes to language detection

[ls]: http://gnuu.org/
[yard]: http://yardoc.org/

The highlighter has become more usable as a library allowing to do highlighting
from initialization code of JS frameworks and in ajax methods (see.
readme.eng.txt).

Also this version drops support for the [WordPress][wp] plugin. Everyone is
welcome to [pick up its maintenance][p] if needed.

[wp]: http://wordpress.org/
[p]: http://bazaar.launchpad.net/~isagalaev/+junk/highlight/annotate/342/src/wp_highlight.js.php


## Version 5.8

- Jan Berkel has contributed a definition for Scala. +1 to hotness!
- All CSS-styles are rewritten to work only inside `<pre>` tags to avoid
  conflicts with host site styles.


## Version 5.7.

Fixed escaping of quotes in VBScript strings.


## Version 5.5

This version brings a small change: now .ini-files allow digits, underscores and
square brackets in key names.


## Version 5.4

Fixed small but upsetting bug in the packer which caused incorrect highlighting
of explicitly specified languages. Thanks to Andrew Fedorov for precise
diagnostics!


## Version 5.3

The version to fulfil old promises.

The most significant change is that highlight.js now preserves custom user
markup in code along with its own highlighting markup. This means that now it's
possible to use, say, links in code. Thanks to [Vladimir Dolzhenko][vd] for the
[initial proposal][1] and for making a proof-of-concept patch.

Also in this version:

- [Vasily Polovnyov][vp] has sent a GitHub-like style and has implemented
  support for CSS @-rules and Ruby symbols.
- Yura Zaripov has sent two styles: Brown Paper and School Book.
- Oleg Volchkov has sent a definition for [Parser 3][p3].

[1]: http://softwaremaniacs.org/forum/highlightjs/6612/
[p3]: http://www.parser.ru/
[vp]: http://vasily.polovnyov.ru/
[vd]: http://dolzhenko.blogspot.com/


## Version 5.2

- at last it's possible to replace indentation TABs with something sensible
  (e.g. 2 or 4 spaces)
- new keywords and built-ins for 1C by Sergey Baranov
- a couple of small fixes to Apache highlighting


## Version 5.1

This is one of those nice version consisting entirely of new and shiny
contributions!

- [Vladimir Ermakov][vooon] created highlighting for AVR Assembler
- [Ruslan Keba][rukeba] created highlighting for Apache config file. Also his
  original visual style for it is now available for all highlight.js languages
  under the name "Magula".
- [Shuen-Huei Guan][drake] (aka Drake) sent new keywords for RenderMan
  languages. Also thanks go to [Konstantin Evdokimenko][ke] for his advice on
  the matter.

[vooon]: http://vehq.ru/about/
[rukeba]: http://rukeba.com/
[drake]: http://drakeguan.org/
[ke]: http://k-evdokimenko.moikrug.ru/


## Version 5.0

The main change in the new major version of highlight.js is a mechanism for
packing several languages along with the library itself into a single compressed
file. Now sites using several languages will load considerably faster because
the library won't dynamically include additional files while loading.

Also this version fixes a long-standing bug with Javascript highlighting that
couldn't distinguish between regular expressions and division operations.

And as usually there were a couple of minor correctness fixes.

Great thanks to all contributors! Keep using highlight.js.


## Version 4.3

This version comes with two contributions from [Jason Diamond][jd]:

- language definition for C# (yes! it was a long-missed thing!)
- Visual Studio-like highlighting style

Plus there are a couple of minor bug fixes for parsing HTML and XML attributes.

[jd]: http://jason.diamond.name/weblog/


## Version 4.2

The biggest news is highlighting for Lisp, courtesy of Vasily Polovnyov. It's
somewhat experimental meaning that for highlighting "keywords" it doesn't use
any pre-defined set of a Lisp dialect. Instead it tries to highlight first word
in parentheses wherever it makes sense. I'd like to ask people programming in
Lisp to confirm if it's a good idea and send feedback to [the forum][f].

Other changes:

- Smalltalk was excluded from DEFAULT_LANGUAGES to save traffic
- [Vladimir Epifanov][voldmar] has implemented javascript style switcher for
  test.html
- comments now allowed inside Ruby function definition
- [MEL][] language from [Shuen-Huei Guan][drake]
- whitespace now allowed between `<pre>` and `<code>`
- better auto-detection of C++ and PHP
- HTML allows embedded VBScript (`<% .. %>`)

[f]: http://softwaremaniacs.org/forum/highlightjs/
[voldmar]: http://voldmar.ya.ru/
[mel]: http://en.wikipedia.org/wiki/Maya_Embedded_Language
[drake]: http://drakeguan.org/


## Version 4.1

Languages:

- Bash from Vah
- DOS bat-files from Alexander Makarov (Sam)
- Diff files from Vasily Polovnyov
- Ini files from myself though initial idea was from Sam

Styles:

- Zenburn from Vladimir Epifanov, this is an imitation of a
  [well-known theme for Vim][zenburn].
- Ascetic from myself, as a realization of ideals of non-flashy highlighting:
  just one color in only three gradations :-)

In other news. [One small bug][bug] was fixed, built-in keywords were added for
Python and C++ which improved auto-detection for the latter (it was shame that
[my wife's blog][alenacpp] had issues with it from time to time). And lastly
thanks go to Sam for getting rid of my stylistic comments in code that were
getting in the way of [JSMin][].

[zenburn]: http://en.wikipedia.org/wiki/Zenburn
[alenacpp]: http://alenacpp.blogspot.com/
[bug]: http://softwaremaniacs.org/forum/viewtopic.php?id=1823
[jsmin]: http://code.google.com/p/jsmin-php/


## Version 4.0

New major version is a result of vast refactoring and of many contributions.

Visible new features:

- Highlighting of embedded languages. Currently is implemented highlighting of
  Javascript and CSS inside HTML.
- Bundled 5 ready-made style themes!

Invisible new features:

- Highlight.js no longer pollutes global namespace. Only one object and one
  function for backward compatibility.
- Performance is further increased by about 15%.

Changing of a major version number caused by a new format of language definition
files. If you use some third-party language files they should be updated.


## Version 3.5

A very nice version in my opinion fixing a number of small bugs and slightly
increased speed in a couple of corner cases. Thanks to everybody who reports
bugs in he [forum][f] and by email!

There is also a new language — XML. A custom XML formerly was detected as HTML
and didn't highlight custom tags. In this version I tried to make custom XML to
be detected and highlighted by its own rules. Which by the way include such
things as CDATA sections and processing instructions (`<? ... ?>`).

[f]: http://softwaremaniacs.org/forum/viewforum.php?id=6


## Version 3.3

[Vladimir Gubarkov][xonix] has provided an interesting and useful addition.
File export.html contains a little program that shows and allows to copy and
paste an HTML code generated by the highlighter for any code snippet. This can
be useful in situations when one can't use the script itself on a site.


[xonix]: http://xonixx.blogspot.com/


## Version 3.2 consists completely of contributions:

- Vladimir Gubarkov has described SmallTalk
- Yuri Ivanov has described 1C
- Peter Leonov has packaged the highlighter as a Firefox extension
- Vladimir Ermakov has compiled a mod for phpBB

Many thanks to you all!


## Version 3.1

Three new languages are available: Django templates, SQL and Axapta. The latter
two are sent by [Dmitri Roudakov][1]. However I've almost entirely rewrote an
SQL definition but I'd never started it be it from the ground up :-)

The engine itself has got a long awaited feature of grouping keywords
("keyword", "built-in function", "literal"). No more hacks!

[1]: http://roudakov.ru/


## Version 3.0

It is major mainly because now highlight.js has grown large and has become
modular. Now when you pass it a list of languages to highlight it will
dynamically load into a browser only those languages.

Also:

- Konstantin Evdokimenko of [RibKit][] project has created a highlighting for
  RenderMan Shading Language and RenderMan Interface Bytestream. Yay for more
  languages!
- Heuristics for C++ and HTML got better.
- I've implemented (at last) a correct handling of backslash escapes in C-like
  languages.

There is also a small backwards incompatible change in the new version. The
function initHighlighting that was used to initialize highlighting instead of
initHighlightingOnLoad a long time ago no longer works. If you by chance still
use it — replace it with the new one.

[RibKit]: http://ribkit.sourceforge.net/


## Version 2.9

Highlight.js is a parser, not just a couple of regular expressions. That said
I'm glad to announce that in the new version 2.9 has support for:

- in-string substitutions for Ruby -- `#{...}`
- strings from from numeric symbol codes (like #XX) for Delphi


## Version 2.8

A maintenance release with more tuned heuristics. Fully backwards compatible.


## Version 2.7

- Nikita Ledyaev presents highlighting for VBScript, yay!
- A couple of bugs with escaping in strings were fixed thanks to Mickle
- Ongoing tuning of heuristics

Fixed bugs were rather unpleasant so I encourage everyone to upgrade!


## Version 2.4

- Peter Leonov provides another improved highlighting for Perl
- Javascript gets a new kind of keywords — "literals". These are the words
  "true", "false" and "null"

Also highlight.js homepage now lists sites that use the library. Feel free to
add your site by [dropping me a message][mail] until I find the time to build a
submit form.

[mail]: mailto:Maniac@SoftwareManiacs.Org


## Version 2.3

This version fixes IE breakage in previous version. My apologies to all who have
already downloaded that one!


## Version 2.2

- added highlighting for Javascript
- at last fixed parsing of Delphi's escaped apostrophes in strings
- in Ruby fixed highlighting of keywords 'def' and 'class', same for 'sub' in
  Perl


## Version 2.0

- Ruby support by [Anton Kovalyov][ak]
- speed increased by orders of magnitude due to new way of parsing
- this same way allows now correct highlighting of keywords in some tricky
  places (like keyword "End" at the end of Delphi classes)

[ak]: http://anton.kovalyov.net/


## Version 1.0

Version 1.0 of javascript syntax highlighter is released!

It's the first version available with English description. Feel free to post
your comments and question to [highlight.js forum][forum]. And don't be afraid
if you find there some fancy Cyrillic letters -- it's for Russian users too :-)

[forum]: http://softwaremaniacs.org/forum/viewforum.php?id=6
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440 <route id="cbr-route">
45 <from id="_from1" uri="file:work/cbr/input"/>
<log id="_Togl" message="Receiving order ${file:name}"/>
<choice id="_choicel">
<vhen 1d="_when1">
<xpath id="_xpathl">/order/customer/country = 'LK'</xpath>
<log 1d="_l0g2" message="Sending order ${file:name} to the UK'/>
<to id="_Fol* uri="file:work/chr/output/uk' />
</uhen>
<when id="_when2>
<xpath id="_xpath2">/order /customer/country = 'US'</xpath>
<log 1d="_l0g3" message="Sending order ${file:name} to the US'/>
<to id="_Fo2* uri="file:work/chr/output/us' />
</uhen>
<otherwise id="_otherwisel">
<log id="_l0g4" message="Sending order ${file:name} to another cot
<to id="_Fo3* uri="file:work/cbr/output/others"/>
</otherwise>]
</choice>
<log id="_log5" message='Done processing ${file:name}"/>
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<terminated> Deploy myFiSproject on OpenShift [Maven Build) LibrarylJavalJavaVirtualMachines(jdk1.8.0_102.jdContentsfH
INrU]

INFO] - fabric8-maven-plugin:3.1.80.redhat-800013:deploy (default-cli) @ canel-ose-springboot-xnil -
INFO) FB: Using OpenShift at https://192.168.99.100:8443/ in namespace newtest with manifest /Users/tc
INFO] OpenShift platform detected

INFO] Using project: newtest

INFO] Creating a Service from openshift.yml namespace newtest name camel-ose-springboot-xnl

INFO] Created Service: target/fabric8/apply)son/nentest/service-canel-ose-springboot-xrl . json

INFO] Creating a DeploymentConfig from openshift.yml namespace newtest name canel-ose-springboot-xml

INFO] Created DeploynentConfig: target/fabric8/applyJson/newtest/deploymentconfig-canel-ose-springboot
INFO] F8: HINT: Use the conmand “oc get pods -w' to watch your pods start up

NFO)
INFO] BUILD SUCCESS
INFO] --

INFO] Total time: 12:27 min

INFO] Finished ot: 2017-10-10T16:50:12-04:00
INFO] Final Memory: 61M/657M

NFO)
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Select component

Select a Camel component type and provide basic information. You will configure it later sing the Properties view.

s [myms
Camel component seection
type filter text (filters on name, description and categories) () Grouped by categories.
S\ Atom - The atom component is used for consaring Atom RSS feeds. o Show only palette components

[ Control Bus - The controlbus component provides easy management of Camel applications based on the Control Bus EIP pattern.
\ CXF - The cxf component is used for SOAP WebServices using Apache CXF.

(& CXF-R - The cxfrs component s used for JAX-RS REST services using Apache CXF.

2] Direct - The direct component provides direct synchronous call to another endpoint from the same CamelContext.

[ADirect vM - The direct-vm component provides direct synchronous callto another endpoint from any CamelCantext i the same JVM.
BB - The ejb component is for invoking EJB Java beans from Camel.

[ JFile - The file component is used for reading or witing files.

I FTP - The ftp component is used for uploading or downloading files from FTP servers.

(=1 FTPS - The ftps (FTP secure SSL/TLS) component is used for uploading or downloading files from FTP servers.

[EIMAP - To send or receive emails using imap/pop3 or stmp protocols.

[EIMAPS - To send or receive emails using imap/pop3 or stmp protocols.

(-4 JDBC - The jdbc component enables you to access databases through JDBC where SQL queries are sent in the message body.

The jgroups component provides exchange of messages between Camel and JGroups cluster
VS~ The jms

Language - The language component allows you to send a message to an endpoint which executes a script by any of the supported Languages in Camel.
(B inkedin - The linkedin component i uses for retrieving Linkedin user profles connections companies groups poss etc.

Mina2 - Socket level networking using TCP or UDP with the Apache Mina 2.x library.

MQTT - Component for communicating with MQTT M2M message brokers using FuseSource MQTT Client.

[BJMVEL - Transforms the message using a MVEL templte.

3 Netty - Socket level networking using TCP or UDP with the Netty 3. libary.

3 Netty HTTP - Netty HTTP server and client using the Netty 3.x ibrary.

©) (Cancel )
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Create a global Data Format

Select a Data Format and provide basic information. You will configure It using properties view.

Data Format: [ avro - Camel Avro data format

we  C—————— ]
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B 1 Foxml version="1.0" encoding="UTF-8"7>
3% Copyright 2014-2017, Red Hat, Inc. and/or its affiliates, and individuall]

176 This is the 0SGi Blueprint XML file defining the Camel context and routes. Because the file is in the[]

235 <blueprint xmlns="http: //www.0sgi. org/xmlns/blueprint/v1.0.0"

24 xmlns:xsi="http://waw. w3.org/2601/XM.Schema-instance" xsi:schemalocation=" http://war. 0sgi. org/xr
268 The. namespace for the cancleontext slomnt in Blucprint 15 hetpes//canel .apache.ora/schanayblusprint’ -0
516 <camelContext id="cbr-example-context" xmlns="http://camel.apache. org/schema/blueprint">

33 when this route is started, it will automatically create the work/cbr/input directory where you can drop
440 <route id="cbr-route">

45 <from id="_from1" uri="file:work/cbr/input"/>

26 _Togl" message="Receiving order ${file:name}"/>

478 choicel">

489 _when1">

49 <xpath id="_xpathl">/order/customer/country = 'LK'</xpath>

50 <log 1d="_l0g2" message="Sending order ${file:name} to the UK'/>

s1 <to id="_Fol* uri="file:work/chr/output/uk' />

52 </uhen>

539 <when id="_when2">

54 <xpath id="_xpath2">/order /customer/country = 'US'</xpath>

s5 <log 1d="_l0g3" message="Sending order ${file:name} to the US'/>

56 <to id="_Fo2" uri="file:work/chr/output/us"/>

57 </uhen>

se2 <otherwise id="_otherwisel">

s9 <log 1d="_l0g4" message="Sending order ${file:name} to another country"/>

0 <to id="_Fo3* uri="file:work/cbr/output/others"/>

61 </otherwise>]

62 </choice>

63 <log id="_log5" message='Done processing ${file:name}"/>

4 </route>

65 </camelContext>

66 </blueprint>
———
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OEBPS/Common_Content/scripts/jquery-1.7.1.min.js
/*! jQuery v1.7.1 jquery.com | jquery.org/license */
(function(a,b){function cy(a){return f.isWindow(a)?a:a.nodeType===9?a.defaultView||a.parentWindow:!1}function cv(a){if(!ck[a]){var b=c.body,d=f("<"+a+">").appendTo(b),e=d.css("display");d.remove();if(e==="none"||e===""){cl||(cl=c.createElement("iframe"),cl.frameBorder=cl.width=cl.height=0),b.appendChild(cl);if(!cm||!cl.createElement)cm=(cl.contentWindow||cl.contentDocument).document,cm.write((c.compatMode==="CSS1Compat"?"<!doctype html>":"")+"<html><body>"),cm.close();d=cm.createElement(a),cm.body.appendChild(d),e=f.css(d,"display"),b.removeChild(cl)}ck[a]=e}return ck[a]}function cu(a,b){var c={};f.each(cq.concat.apply([],cq.slice(0,b)),function(){c[this]=a});return c}function ct(){cr=b}function cs(){setTimeout(ct,0);return cr=f.now()}function cj(){try{return new a.ActiveXObject("Microsoft.XMLHTTP")}catch(b){}}function ci(){try{return new a.XMLHttpRequest}catch(b){}}function cc(a,c){a.dataFilter&&(c=a.dataFilter(c,a.dataType));var d=a.dataTypes,e={},g,h,i=d.length,j,k=d[0],l,m,n,o,p;for(g=1;g<i;g++){if(g===1)for(h in a.converters)typeof h=="string"&&(e[h.toLowerCase()]=a.converters[h]);l=k,k=d[g];if(k==="*")k=l;else if(l!=="*"&&l!==k){m=l+" "+k,n=e[m]||e["* "+k];if(!n){p=b;for(o in e){j=o.split(" ");if(j[0]===l||j[0]==="*"){p=e[j[1]+" "+k];if(p){o=e[o],o===!0?n=p:p===!0&&(n=o);break}}}}!n&&!p&&f.error("No conversion from "+m.replace(" "," to ")),n!==!0&&(c=n?n(c):p(o(c)))}}return c}function cb(a,c,d){var e=a.contents,f=a.dataTypes,g=a.responseFields,h,i,j,k;for(i in g)i in d&&(c[g[i]]=d[i]);while(f[0]==="*")f.shift(),h===b&&(h=a.mimeType||c.getResponseHeader("content-type"));if(h)for(i in e)if(e[i]&&e[i].test(h)){f.unshift(i);break}if(f[0]in d)j=f[0];else{for(i in d){if(!f[0]||a.converters[i+" "+f[0]]){j=i;break}k||(k=i)}j=j||k}if(j){j!==f[0]&&f.unshift(j);return d[j]}}function ca(a,b,c,d){if(f.isArray(b))f.each(b,function(b,e){c||bE.test(a)?d(a,e):ca(a+"["+(typeof e=="object"||f.isArray(e)?b:"")+"]",e,c,d)});else if(!c&&b!=null&&typeof b=="object")for(var e in b)ca(a+"["+e+"]",b[e],c,d);else d(a,b)}function b_(a,c){var d,e,g=f.ajaxSettings.flatOptions||{};for(d in c)c[d]!==b&&((g[d]?a:e||(e={}))[d]=c[d]);e&&f.extend(!0,a,e)}function b$(a,c,d,e,f,g){f=f||c.dataTypes[0],g=g||{},g[f]=!0;var h=a[f],i=0,j=h?h.length:0,k=a===bT,l;for(;i<j&&(k||!l);i++)l=h[i](c,d,e),typeof l=="string"&&(!k||g[l]?l=b:(c.dataTypes.unshift(l),l=b$(a,c,d,e,l,g)));(k||!l)&&!g["*"]&&(l=b$(a,c,d,e,"*",g));return l}function bZ(a){return function(b,c){typeof b!="string"&&(c=b,b="*");if(f.isFunction(c)){var d=b.toLowerCase().split(bP),e=0,g=d.length,h,i,j;for(;e<g;e++)h=d[e],j=/^\+/.test(h),j&&(h=h.substr(1)||"*"),i=a[h]=a[h]||[],i[j?"unshift":"push"](c)}}}function bC(a,b,c){var d=b==="width"?a.offsetWidth:a.offsetHeight,e=b==="width"?bx:by,g=0,h=e.length;if(d>0){if(c!=="border")for(;g<h;g++)c||(d-=parseFloat(f.css(a,"padding"+e[g]))||0),c==="margin"?d+=parseFloat(f.css(a,c+e[g]))||0:d-=parseFloat(f.css(a,"border"+e[g]+"Width"))||0;return d+"px"}d=bz(a,b,b);if(d<0||d==null)d=a.style[b]||0;d=parseFloat(d)||0;if(c)for(;g<h;g++)d+=parseFloat(f.css(a,"padding"+e[g]))||0,c!=="padding"&&(d+=parseFloat(f.css(a,"border"+e[g]+"Width"))||0),c==="margin"&&(d+=parseFloat(f.css(a,c+e[g]))||0);return d+"px"}function bp(a,b){b.src?f.ajax({url:b.src,async:!1,dataType:"script"}):f.globalEval((b.text||b.textContent||b.innerHTML||"").replace(bf,"/*$0*/")),b.parentNode&&b.parentNode.removeChild(b)}function bo(a){var b=c.createElement("div");bh.appendChild(b),b.innerHTML=a.outerHTML;return b.firstChild}function bn(a){var b=(a.nodeName||"").toLowerCase();b==="input"?bm(a):b!=="script"&&typeof a.getElementsByTagName!="undefined"&&f.grep(a.getElementsByTagName("input"),bm)}function bm(a){if(a.type==="checkbox"||a.type==="radio")a.defaultChecked=a.checked}function bl(a){return typeof a.getElementsByTagName!="undefined"?a.getElementsByTagName("*"):typeof a.querySelectorAll!="undefined"?a.querySelectorAll("*"):[]}function bk(a,b){var c;if(b.nodeType===1){b.clearAttributes&&b.clearAttributes(),b.mergeAttributes&&b.mergeAttributes(a),c=b.nodeName.toLowerCase();if(c==="object")b.outerHTML=a.outerHTML;else if(c!=="input"||a.type!=="checkbox"&&a.type!=="radio"){if(c==="option")b.selected=a.defaultSelected;else if(c==="input"||c==="textarea")b.defaultValue=a.defaultValue}else a.checked&&(b.defaultChecked=b.checked=a.checked),b.value!==a.value&&(b.value=a.value);b.removeAttribute(f.expando)}}function bj(a,b){if(b.nodeType===1&&!!f.hasData(a)){var c,d,e,g=f._data(a),h=f._data(b,g),i=g.events;if(i){delete h.handle,h.events={};for(c in i)for(d=0,e=i[c].length;d<e;d++)f.event.add(b,c+(i[c][d].namespace?".":"")+i[c][d].namespace,i[c][d],i[c][d].data)}h.data&&(h.data=f.extend({},h.data))}}function bi(a,b){return f.nodeName(a,"table")?a.getElementsByTagName("tbody")[0]||a.appendChild(a.ownerDocument.createElement("tbody")):a}function U(a){var b=V.split("|"),c=a.createDocumentFragment();if(c.createElement)while(b.length)c.createElement(b.pop());return c}function T(a,b,c){b=b||0;if(f.isFunction(b))return f.grep(a,function(a,d){var e=!!b.call(a,d,a);return e===c});if(b.nodeType)return f.grep(a,function(a,d){return a===b===c});if(typeof b=="string"){var d=f.grep(a,function(a){return a.nodeType===1});if(O.test(b))return f.filter(b,d,!c);b=f.filter(b,d)}return f.grep(a,function(a,d){return f.inArray(a,b)>=0===c})}function S(a){return!a||!a.parentNode||a.parentNode.nodeType===11}function K(){return!0}function J(){return!1}function n(a,b,c){var d=b+"defer",e=b+"queue",g=b+"mark",h=f._data(a,d);h&&(c==="queue"||!f._data(a,e))&&(c==="mark"||!f._data(a,g))&&setTimeout(function(){!f._data(a,e)&&!f._data(a,g)&&(f.removeData(a,d,!0),h.fire())},0)}function m(a){for(var b in a){if(b==="data"&&f.isEmptyObject(a[b]))continue;if(b!=="toJSON")return!1}return!0}function l(a,c,d){if(d===b&&a.nodeType===1){var e="data-"+c.replace(k,"-$1").toLowerCase();d=a.getAttribute(e);if(typeof d=="string"){try{d=d==="true"?!0:d==="false"?!1:d==="null"?null:f.isNumeric(d)?parseFloat(d):j.test(d)?f.parseJSON(d):d}catch(g){}f.data(a,c,d)}else d=b}return d}function h(a){var b=g[a]={},c,d;a=a.split(/\s+/);for(c=0,d=a.length;c<d;c++)b[a[c]]=!0;return b}var c=a.document,d=a.navigator,e=a.location,f=function(){function J(){if(!e.isReady){try{c.documentElement.doScroll("left")}catch(a){setTimeout(J,1);return}e.ready()}}var e=function(a,b){return new e.fn.init(a,b,h)},f=a.jQuery,g=a.$,h,i=/^(?:[^#<]*(<[\w\W]+>)[^>]*$|#([\w\-]*)$)/,j=/\S/,k=/^\s+/,l=/\s+$/,m=/^<(\w+)\s*\/?>(?:<\/\1>)?$/,n=/^[\],:{}\s]*$/,o=/\\(?:["\\\/bfnrt]|u[0-9a-fA-F]{4})/g,p=/"[^"\\\n\r]*"|true|false|null|-?\d+(?:\.\d*)?(?:[eE][+\-]?\d+)?/g,q=/(?:^|:|,)(?:\s*\[)+/g,r=/(webkit)[ \/]([\w.]+)/,s=/(opera)(?:.*version)?[ \/]([\w.]+)/,t=/(msie) ([\w.]+)/,u=/(mozilla)(?:.*? rv:([\w.]+))?/,v=/-([a-z]|[0-9])/ig,w=/^-ms-/,x=function(a,b){return(b+"").toUpperCase()},y=d.userAgent,z,A,B,C=Object.prototype.toString,D=Object.prototype.hasOwnProperty,E=Array.prototype.push,F=Array.prototype.slice,G=String.prototype.trim,H=Array.prototype.indexOf,I={};e.fn=e.prototype={constructor:e,init:function(a,d,f){var g,h,j,k;if(!a)return this;if(a.nodeType){this.context=this[0]=a,this.length=1;return this}if(a==="body"&&!d&&c.body){this.context=c,this[0]=c.body,this.selector=a,this.length=1;return this}if(typeof a=="string"){a.charAt(0)!=="<"||a.charAt(a.length-1)!==">"||a.length<3?g=i.exec(a):g=[null,a,null];if(g&&(g[1]||!d)){if(g[1]){d=d instanceof e?d[0]:d,k=d?d.ownerDocument||d:c,j=m.exec(a),j?e.isPlainObject(d)?(a=[c.createElement(j[1])],e.fn.attr.call(a,d,!0)):a=[k.createElement(j[1])]:(j=e.buildFragment([g[1]],[k]),a=(j.cacheable?e.clone(j.fragment):j.fragment).childNodes);return e.merge(this,a)}h=c.getElementById(g[2]);if(h&&h.parentNode){if(h.id!==g[2])return f.find(a);this.length=1,this[0]=h}this.context=c,this.selector=a;return this}return!d||d.jquery?(d||f).find(a):this.constructor(d).find(a)}if(e.isFunction(a))return f.ready(a);a.selector!==b&&(this.selector=a.selector,this.context=a.context);return e.makeArray(a,this)},selector:"",jquery:"1.7.1",length:0,size:function(){return this.length},toArray:function(){return F.call(this,0)},get:function(a){return a==null?this.toArray():a<0?this[this.length+a]:this[a]},pushStack:function(a,b,c){var d=this.constructor();e.isArray(a)?E.apply(d,a):e.merge(d,a),d.prevObject=this,d.context=this.context,b==="find"?d.selector=this.selector+(this.selector?" ":"")+c:b&&(d.selector=this.selector+"."+b+"("+c+")");return d},each:function(a,b){return e.each(this,a,b)},ready:function(a){e.bindReady(),A.add(a);return this},eq:function(a){a=+a;return a===-1?this.slice(a):this.slice(a,a+1)},first:function(){return this.eq(0)},last:function(){return this.eq(-1)},slice:function(){return this.pushStack(F.apply(this,arguments),"slice",F.call(arguments).join(","))},map:function(a){return this.pushStack(e.map(this,function(b,c){return a.call(b,c,b)}))},end:function(){return this.prevObject||this.constructor(null)},push:E,sort:[].sort,splice:[].splice},e.fn.init.prototype=e.fn,e.extend=e.fn.extend=function(){var a,c,d,f,g,h,i=arguments[0]||{},j=1,k=arguments.length,l=!1;typeof i=="boolean"&&(l=i,i=arguments[1]||{},j=2),typeof i!="object"&&!e.isFunction(i)&&(i={}),k===j&&(i=this,--j);for(;j<k;j++)if((a=arguments[j])!=null)for(c in a){d=i[c],f=a[c];if(i===f)continue;l&&f&&(e.isPlainObject(f)||(g=e.isArray(f)))?(g?(g=!1,h=d&&e.isArray(d)?d:[]):h=d&&e.isPlainObject(d)?d:{},i[c]=e.extend(l,h,f)):f!==b&&(i[c]=f)}return i},e.extend({noConflict:function(b){a.$===e&&(a.$=g),b&&a.jQuery===e&&(a.jQuery=f);return e},isReady:!1,readyWait:1,holdReady:function(a){a?e.readyWait++:e.ready(!0)},ready:function(a){if(a===!0&&!--e.readyWait||a!==!0&&!e.isReady){if(!c.body)return setTimeout(e.ready,1);e.isReady=!0;if(a!==!0&&--e.readyWait>0)return;A.fireWith(c,[e]),e.fn.trigger&&e(c).trigger("ready").off("ready")}},bindReady:function(){if(!A){A=e.Callbacks("once memory");if(c.readyState==="complete")return setTimeout(e.ready,1);if(c.addEventListener)c.addEventListener("DOMContentLoaded",B,!1),a.addEventListener("load",e.ready,!1);else if(c.attachEvent){c.attachEvent("onreadystatechange",B),a.attachEvent("onload",e.ready);var b=!1;try{b=a.frameElement==null}catch(d){}c.documentElement.doScroll&&b&&J()}}},isFunction:function(a){return e.type(a)==="function"},isArray:Array.isArray||function(a){return e.type(a)==="array"},isWindow:function(a){return a&&typeof a=="object"&&"setInterval"in a},isNumeric:function(a){return!isNaN(parseFloat(a))&&isFinite(a)},type:function(a){return a==null?String(a):I[C.call(a)]||"object"},isPlainObject:function(a){if(!a||e.type(a)!=="object"||a.nodeType||e.isWindow(a))return!1;try{if(a.constructor&&!D.call(a,"constructor")&&!D.call(a.constructor.prototype,"isPrototypeOf"))return!1}catch(c){return!1}var d;for(d in a);return d===b||D.call(a,d)},isEmptyObject:function(a){for(var b in a)return!1;return!0},error:function(a){throw new Error(a)},parseJSON:function(b){if(typeof b!="string"||!b)return null;b=e.trim(b);if(a.JSON&&a.JSON.parse)return a.JSON.parse(b);if(n.test(b.replace(o,"@").replace(p,"]").replace(q,"")))return(new Function("return "+b))();e.error("Invalid JSON: "+b)},parseXML:function(c){var d,f;try{a.DOMParser?(f=new DOMParser,d=f.parseFromString(c,"text/xml")):(d=new ActiveXObject("Microsoft.XMLDOM"),d.async="false",d.loadXML(c))}catch(g){d=b}(!d||!d.documentElement||d.getElementsByTagName("parsererror").length)&&e.error("Invalid XML: "+c);return d},noop:function(){},globalEval:function(b){b&&j.test(b)&&(a.execScript||function(b){a.eval.call(a,b)})(b)},camelCase:function(a){return a.replace(w,"ms-").replace(v,x)},nodeName:function(a,b){return a.nodeName&&a.nodeName.toUpperCase()===b.toUpperCase()},each:function(a,c,d){var f,g=0,h=a.length,i=h===b||e.isFunction(a);if(d){if(i){for(f in a)if(c.apply(a[f],d)===!1)break}else for(;g<h;)if(c.apply(a[g++],d)===!1)break}else if(i){for(f in a)if(c.call(a[f],f,a[f])===!1)break}else for(;g<h;)if(c.call(a[g],g,a[g++])===!1)break;return a},trim:G?function(a){return a==null?"":G.call(a)}:function(a){return a==null?"":(a+"").replace(k,"").replace(l,"")},makeArray:function(a,b){var c=b||[];if(a!=null){var d=e.type(a);a.length==null||d==="string"||d==="function"||d==="regexp"||e.isWindow(a)?E.call(c,a):e.merge(c,a)}return c},inArray:function(a,b,c){var d;if(b){if(H)return H.call(b,a,c);d=b.length,c=c?c<0?Math.max(0,d+c):c:0;for(;c<d;c++)if(c in b&&b[c]===a)return c}return-1},merge:function(a,c){var d=a.length,e=0;if(typeof c.length=="number")for(var f=c.length;e<f;e++)a[d++]=c[e];else while(c[e]!==b)a[d++]=c[e++];a.length=d;return a},grep:function(a,b,c){var d=[],e;c=!!c;for(var f=0,g=a.length;f<g;f++)e=!!b(a[f],f),c!==e&&d.push(a[f]);return d},map:function(a,c,d){var f,g,h=[],i=0,j=a.length,k=a instanceof e||j!==b&&typeof j=="number"&&(j>0&&a[0]&&a[j-1]||j===0||e.isArray(a));if(k)for(;i<j;i++)f=c(a[i],i,d),f!=null&&(h[h.length]=f);else for(g in a)f=c(a[g],g,d),f!=null&&(h[h.length]=f);return h.concat.apply([],h)},guid:1,proxy:function(a,c){if(typeof c=="string"){var d=a[c];c=a,a=d}if(!e.isFunction(a))return b;var f=F.call(arguments,2),g=function(){return a.apply(c,f.concat(F.call(arguments)))};g.guid=a.guid=a.guid||g.guid||e.guid++;return g},access:function(a,c,d,f,g,h){var i=a.length;if(typeof c=="object"){for(var j in c)e.access(a,j,c[j],f,g,d);return a}if(d!==b){f=!h&&f&&e.isFunction(d);for(var k=0;k<i;k++)g(a[k],c,f?d.call(a[k],k,g(a[k],c)):d,h);return a}return i?g(a[0],c):b},now:function(){return(new Date).getTime()},uaMatch:function(a){a=a.toLowerCase();var b=r.exec(a)||s.exec(a)||t.exec(a)||a.indexOf("compatible")<0&&u.exec(a)||[];return{browser:b[1]||"",version:b[2]||"0"}},sub:function(){function a(b,c){return new a.fn.init(b,c)}e.extend(!0,a,this),a.superclass=this,a.fn=a.prototype=this(),a.fn.constructor=a,a.sub=this.sub,a.fn.init=function(d,f){f&&f instanceof e&&!(f instanceof a)&&(f=a(f));return e.fn.init.call(this,d,f,b)},a.fn.init.prototype=a.fn;var b=a(c);return a},browser:{}}),e.each("Boolean Number String Function Array Date RegExp Object".split(" "),function(a,b){I["[object "+b+"]"]=b.toLowerCase()}),z=e.uaMatch(y),z.browser&&(e.browser[z.browser]=!0,e.browser.version=z.version),e.browser.webkit&&(e.browser.safari=!0),j.test(" ")&&(k=/^[\s\xA0]+/,l=/[\s\xA0]+$/),h=e(c),c.addEventListener?B=function(){c.removeEventListener("DOMContentLoaded",B,!1),e.ready()}:c.attachEvent&&(B=function(){c.readyState==="complete"&&(c.detachEvent("onreadystatechange",B),e.ready())});return e}(),g={};f.Callbacks=function(a){a=a?g[a]||h(a):{};var c=[],d=[],e,i,j,k,l,m=function(b){var d,e,g,h,i;for(d=0,e=b.length;d<e;d++)g=b[d],h=f.type(g),h==="array"?m(g):h==="function"&&(!a.unique||!o.has(g))&&c.push(g)},n=function(b,f){f=f||[],e=!a.memory||[b,f],i=!0,l=j||0,j=0,k=c.length;for(;c&&l<k;l++)if(c[l].apply(b,f)===!1&&a.stopOnFalse){e=!0;break}i=!1,c&&(a.once?e===!0?o.disable():c=[]:d&&d.length&&(e=d.shift(),o.fireWith(e[0],e[1])))},o={add:function(){if(c){var a=c.length;m(arguments),i?k=c.length:e&&e!==!0&&(j=a,n(e[0],e[1]))}return this},remove:function(){if(c){var b=arguments,d=0,e=b.length;for(;d<e;d++)for(var f=0;f<c.length;f++)if(b[d]===c[f]){i&&f<=k&&(k--,f<=l&&l--),c.splice(f--,1);if(a.unique)break}}return this},has:function(a){if(c){var b=0,d=c.length;for(;b<d;b++)if(a===c[b])return!0}return!1},empty:function(){c=[];return this},disable:function(){c=d=e=b;return this},disabled:function(){return!c},lock:function(){d=b,(!e||e===!0)&&o.disable();return this},locked:function(){return!d},fireWith:function(b,c){d&&(i?a.once||d.push([b,c]):(!a.once||!e)&&n(b,c));return this},fire:function(){o.fireWith(this,arguments);return this},fired:function(){return!!e}};return o};var i=[].slice;f.extend({Deferred:function(a){var b=f.Callbacks("once memory"),c=f.Callbacks("once memory"),d=f.Callbacks("memory"),e="pending",g={resolve:b,reject:c,notify:d},h={done:b.add,fail:c.add,progress:d.add,state:function(){return e},isResolved:b.fired,isRejected:c.fired,then:function(a,b,c){i.done(a).fail(b).progress(c);return this},always:function(){i.done.apply(i,arguments).fail.apply(i,arguments);return this},pipe:function(a,b,c){return f.Deferred(function(d){f.each({done:[a,"resolve"],fail:[b,"reject"],progress:[c,"notify"]},function(a,b){var c=b[0],e=b[1],g;f.isFunction(c)?i[a](function(){g=c.apply(this,arguments),g&&f.isFunction(g.promise)?g.promise().then(d.resolve,d.reject,d.notify):d[e+"With"](this===i?d:this,[g])}):i[a](d[e])})}).promise()},promise:function(a){if(a==null)a=h;else for(var b in h)a[b]=h[b];return a}},i=h.promise({}),j;for(j in g)i[j]=g[j].fire,i[j+"With"]=g[j].fireWith;i.done(function(){e="resolved"},c.disable,d.lock).fail(function(){e="rejected"},b.disable,d.lock),a&&a.call(i,i);return i},when:function(a){function m(a){return function(b){e[a]=arguments.length>1?i.call(arguments,0):b,j.notifyWith(k,e)}}function l(a){return function(c){b[a]=arguments.length>1?i.call(arguments,0):c,--g||j.resolveWith(j,b)}}var b=i.call(arguments,0),c=0,d=b.length,e=Array(d),g=d,h=d,j=d<=1&&a&&f.isFunction(a.promise)?a:f.Deferred(),k=j.promise();if(d>1){for(;c<d;c++)b[c]&&b[c].promise&&f.isFunction(b[c].promise)?b[c].promise().then(l(c),j.reject,m(c)):--g;g||j.resolveWith(j,b)}else j!==a&&j.resolveWith(j,d?[a]:[]);return k}}),f.support=function(){var b,d,e,g,h,i,j,k,l,m,n,o,p,q=c.createElement("div"),r=c.documentElement;q.setAttribute("className","t"),q.innerHTML="   <link/><table></table><a href='/a' style='top:1px;float:left;opacity:.55;'>a</a><input type='checkbox'/>",d=q.getElementsByTagName("*"),e=q.getElementsByTagName("a")[0];if(!d||!d.length||!e)return{};g=c.createElement("select"),h=g.appendChild(c.createElement("option")),i=q.getElementsByTagName("input")[0],b={leadingWhitespace:q.firstChild.nodeType===3,tbody:!q.getElementsByTagName("tbody").length,htmlSerialize:!!q.getElementsByTagName("link").length,style:/top/.test(e.getAttribute("style")),hrefNormalized:e.getAttribute("href")==="/a",opacity:/^0.55/.test(e.style.opacity),cssFloat:!!e.style.cssFloat,checkOn:i.value==="on",optSelected:h.selected,getSetAttribute:q.className!=="t",enctype:!!c.createElement("form").enctype,html5Clone:c.createElement("nav").cloneNode(!0).outerHTML!=="<:nav></:nav>",submitBubbles:!0,changeBubbles:!0,focusinBubbles:!1,deleteExpando:!0,noCloneEvent:!0,inlineBlockNeedsLayout:!1,shrinkWrapBlocks:!1,reliableMarginRight:!0},i.checked=!0,b.noCloneChecked=i.cloneNode(!0).checked,g.disabled=!0,b.optDisabled=!h.disabled;try{delete q.test}catch(s){b.deleteExpando=!1}!q.addEventListener&&q.attachEvent&&q.fireEvent&&(q.attachEvent("onclick",function(){b.noCloneEvent=!1}),q.cloneNode(!0).fireEvent("onclick")),i=c.createElement("input"),i.value="t",i.setAttribute("type","radio"),b.radioValue=i.value==="t",i.setAttribute("checked","checked"),q.appendChild(i),k=c.createDocumentFragment(),k.appendChild(q.lastChild),b.checkClone=k.cloneNode(!0).cloneNode(!0).lastChild.checked,b.appendChecked=i.checked,k.removeChild(i),k.appendChild(q),q.innerHTML="",a.getComputedStyle&&(j=c.createElement("div"),j.style.width="0",j.style.marginRight="0",q.style.width="2px",q.appendChild(j),b.reliableMarginRight=(parseInt((a.getComputedStyle(j,null)||{marginRight:0}).marginRight,10)||0)===0);if(q.attachEvent)for(o in{submit:1,change:1,focusin:1})n="on"+o,p=n in q,p||(q.setAttribute(n,"return;"),p=typeof q[n]=="function"),b[o+"Bubbles"]=p;k.removeChild(q),k=g=h=j=q=i=null,f(function(){var a,d,e,g,h,i,j,k,m,n,o,r=c.getElementsByTagName("body")[0];!r||(j=1,k="position:absolute;top:0;left:0;width:1px;height:1px;margin:0;",m="visibility:hidden;border:0;",n="style='"+k+"border:5px solid #000;padding:0;'",o="<div "+n+"><div></div></div>"+"<table "+n+" cellpadding='0' cellspacing='0'>"+"<tr><td></td></tr></table>",a=c.createElement("div"),a.style.cssText=m+"width:0;height:0;position:static;top:0;margin-top:"+j+"px",r.insertBefore(a,r.firstChild),q=c.createElement("div"),a.appendChild(q),q.innerHTML="<table><tr><td style='padding:0;border:0;display:none'></td><td>t</td></tr></table>",l=q.getElementsByTagName("td"),p=l[0].offsetHeight===0,l[0].style.display="",l[1].style.display="none",b.reliableHiddenOffsets=p&&l[0].offsetHeight===0,q.innerHTML="",q.style.width=q.style.paddingLeft="1px",f.boxModel=b.boxModel=q.offsetWidth===2,typeof q.style.zoom!="undefined"&&(q.style.display="inline",q.style.zoom=1,b.inlineBlockNeedsLayout=q.offsetWidth===2,q.style.display="",q.innerHTML="<div style='width:4px;'></div>",b.shrinkWrapBlocks=q.offsetWidth!==2),q.style.cssText=k+m,q.innerHTML=o,d=q.firstChild,e=d.firstChild,h=d.nextSibling.firstChild.firstChild,i={doesNotAddBorder:e.offsetTop!==5,doesAddBorderForTableAndCells:h.offsetTop===5},e.style.position="fixed",e.style.top="20px",i.fixedPosition=e.offsetTop===20||e.offsetTop===15,e.style.position=e.style.top="",d.style.overflow="hidden",d.style.position="relative",i.subtractsBorderForOverflowNotVisible=e.offsetTop===-5,i.doesNotIncludeMarginInBodyOffset=r.offsetTop!==j,r.removeChild(a),q=a=null,f.extend(b,i))});return b}();var j=/^(?:\{.*\}|\[.*\])$/,k=/([A-Z])/g;f.extend({cache:{},uuid:0,expando:"jQuery"+(f.fn.jquery+Math.random()).replace(/\D/g,""),noData:{embed:!0,object:"clsid:D27CDB6E-AE6D-11cf-96B8-444553540000",applet:!0},hasData:function(a){a=a.nodeType?f.cache[a[f.expando]]:a[f.expando];return!!a&&!m(a)},data:function(a,c,d,e){if(!!f.acceptData(a)){var g,h,i,j=f.expando,k=typeof c=="string",l=a.nodeType,m=l?f.cache:a,n=l?a[j]:a[j]&&j,o=c==="events";if((!n||!m[n]||!o&&!e&&!m[n].data)&&k&&d===b)return;n||(l?a[j]=n=++f.uuid:n=j),m[n]||(m[n]={},l||(m[n].toJSON=f.noop));if(typeof c=="object"||typeof c=="function")e?m[n]=f.extend(m[n],c):m[n].data=f.extend(m[n].data,c);g=h=m[n],e||(h.data||(h.data={}),h=h.data),d!==b&&(h[f.camelCase(c)]=d);if(o&&!h[c])return g.events;k?(i=h[c],i==null&&(i=h[f.camelCase(c)])):i=h;return i}},removeData:function(a,b,c){if(!!f.acceptData(a)){var d,e,g,h=f.expando,i=a.nodeType,j=i?f.cache:a,k=i?a[h]:h;if(!j[k])return;if(b){d=c?j[k]:j[k].data;if(d){f.isArray(b)||(b in d?b=[b]:(b=f.camelCase(b),b in d?b=[b]:b=b.split(" ")));for(e=0,g=b.length;e<g;e++)delete d[b[e]];if(!(c?m:f.isEmptyObject)(d))return}}if(!c){delete j[k].data;if(!m(j[k]))return}f.support.deleteExpando||!j.setInterval?delete j[k]:j[k]=null,i&&(f.support.deleteExpando?delete a[h]:a.removeAttribute?a.removeAttribute(h):a[h]=null)}},_data:function(a,b,c){return f.data(a,b,c,!0)},acceptData:function(a){if(a.nodeName){var b=f.noData[a.nodeName.toLowerCase()];if(b)return b!==!0&&a.getAttribute("classid")===b}return!0}}),f.fn.extend({data:function(a,c){var d,e,g,h=null;if(typeof a=="undefined"){if(this.length){h=f.data(this[0]);if(this[0].nodeType===1&&!f._data(this[0],"parsedAttrs")){e=this[0].attributes;for(var i=0,j=e.length;i<j;i++)g=e[i].name,g.indexOf("data-")===0&&(g=f.camelCase(g.substring(5)),l(this[0],g,h[g]));f._data(this[0],"parsedAttrs",!0)}}return h}if(typeof a=="object")return this.each(function(){f.data(this,a)});d=a.split("."),d[1]=d[1]?"."+d[1]:"";if(c===b){h=this.triggerHandler("getData"+d[1]+"!",[d[0]]),h===b&&this.length&&(h=f.data(this[0],a),h=l(this[0],a,h));return h===b&&d[1]?this.data(d[0]):h}return this.each(function(){var b=f(this),e=[d[0],c];b.triggerHandler("setData"+d[1]+"!",e),f.data(this,a,c),b.triggerHandler("changeData"+d[1]+"!",e)})},removeData:function(a){return this.each(function(){f.removeData(this,a)})}}),f.extend({_mark:function(a,b){a&&(b=(b||"fx")+"mark",f._data(a,b,(f._data(a,b)||0)+1))},_unmark:function(a,b,c){a!==!0&&(c=b,b=a,a=!1);if(b){c=c||"fx";var d=c+"mark",e=a?0:(f._data(b,d)||1)-1;e?f._data(b,d,e):(f.removeData(b,d,!0),n(b,c,"mark"))}},queue:function(a,b,c){var d;if(a){b=(b||"fx")+"queue",d=f._data(a,b),c&&(!d||f.isArray(c)?d=f._data(a,b,f.makeArray(c)):d.push(c));return d||[]}},dequeue:function(a,b){b=b||"fx";var c=f.queue(a,b),d=c.shift(),e={};d==="inprogress"&&(d=c.shift()),d&&(b==="fx"&&c.unshift("inprogress"),f._data(a,b+".run",e),d.call(a,function(){f.dequeue(a,b)},e)),c.length||(f.removeData(a,b+"queue "+b+".run",!0),n(a,b,"queue"))}}),f.fn.extend({queue:function(a,c){typeof a!="string"&&(c=a,a="fx");if(c===b)return f.queue(this[0],a);return this.each(function(){var b=f.queue(this,a,c);a==="fx"&&b[0]!=="inprogress"&&f.dequeue(this,a)})},dequeue:function(a){return this.each(function(){f.dequeue(this,a)})},delay:function(a,b){a=f.fx?f.fx.speeds[a]||a:a,b=b||"fx";return this.queue(b,function(b,c){var d=setTimeout(b,a);c.stop=function(){clearTimeout(d)}})},clearQueue:function(a){return this.queue(a||"fx",[])},promise:function(a,c){function m(){--h||d.resolveWith(e,[e])}typeof a!="string"&&(c=a,a=b),a=a||"fx";var d=f.Deferred(),e=this,g=e.length,h=1,i=a+"defer",j=a+"queue",k=a+"mark",l;while(g--)if(l=f.data(e[g],i,b,!0)||(f.data(e[g],j,b,!0)||f.data(e[g],k,b,!0))&&f.data(e[g],i,f.Callbacks("once memory"),!0))h++,l.add(m);m();return d.promise()}});var o=/[\n\t\r]/g,p=/\s+/,q=/\r/g,r=/^(?:button|input)$/i,s=/^(?:button|input|object|select|textarea)$/i,t=/^a(?:rea)?$/i,u=/^(?:autofocus|autoplay|async|checked|controls|defer|disabled|hidden|loop|multiple|open|readonly|required|scoped|selected)$/i,v=f.support.getSetAttribute,w,x,y;f.fn.extend({attr:function(a,b){return f.access(this,a,b,!0,f.attr)},removeAttr:function(a){return this.each(function(){f.removeAttr(this,a)})},prop:function(a,b){return f.access(this,a,b,!0,f.prop)},removeProp:function(a){a=f.propFix[a]||a;return this.each(function(){try{this[a]=b,delete this[a]}catch(c){}})},addClass:function(a){var b,c,d,e,g,h,i;if(f.isFunction(a))return this.each(function(b){f(this).addClass(a.call(this,b,this.className))});if(a&&typeof a=="string"){b=a.split(p);for(c=0,d=this.length;c<d;c++){e=this[c];if(e.nodeType===1)if(!e.className&&b.length===1)e.className=a;else{g=" "+e.className+" ";for(h=0,i=b.length;h<i;h++)~g.indexOf(" "+b[h]+" ")||(g+=b[h]+" ");e.className=f.trim(g)}}}return this},removeClass:function(a){var c,d,e,g,h,i,j;if(f.isFunction(a))return this.each(function(b){f(this).removeClass(a.call(this,b,this.className))});if(a&&typeof a=="string"||a===b){c=(a||"").split(p);for(d=0,e=this.length;d<e;d++){g=this[d];if(g.nodeType===1&&g.className)if(a){h=(" "+g.className+" ").replace(o," ");for(i=0,j=c.length;i<j;i++)h=h.replace(" "+c[i]+" "," ");g.className=f.trim(h)}else g.className=""}}return this},toggleClass:function(a,b){var c=typeof a,d=typeof b=="boolean";if(f.isFunction(a))return this.each(function(c){f(this).toggleClass(a.call(this,c,this.className,b),b)});return this.each(function(){if(c==="string"){var e,g=0,h=f(this),i=b,j=a.split(p);while(e=j[g++])i=d?i:!h.hasClass(e),h[i?"addClass":"removeClass"](e)}else if(c==="undefined"||c==="boolean")this.className&&f._data(this,"__className__",this.className),this.className=this.className||a===!1?"":f._data(this,"__className__")||""})},hasClass:function(a){var b=" "+a+" ",c=0,d=this.length;for(;c<d;c++)if(this[c].nodeType===1&&(" "+this[c].className+" ").replace(o," ").indexOf(b)>-1)return!0;return!1},val:function(a){var c,d,e,g=this[0];{if(!!arguments.length){e=f.isFunction(a);return this.each(function(d){var g=f(this),h;if(this.nodeType===1){e?h=a.call(this,d,g.val()):h=a,h==null?h="":typeof h=="number"?h+="":f.isArray(h)&&(h=f.map(h,function(a){return a==null?"":a+""})),c=f.valHooks[this.nodeName.toLowerCase()]||f.valHooks[this.type];if(!c||!("set"in c)||c.set(this,h,"value")===b)this.value=h}})}if(g){c=f.valHooks[g.nodeName.toLowerCase()]||f.valHooks[g.type];if(c&&"get"in c&&(d=c.get(g,"value"))!==b)return d;d=g.value;return typeof d=="string"?d.replace(q,""):d==null?"":d}}}}),f.extend({valHooks:{option:{get:function(a){var b=a.attributes.value;return!b||b.specified?a.value:a.text}},select:{get:function(a){var b,c,d,e,g=a.selectedIndex,h=[],i=a.options,j=a.type==="select-one";if(g<0)return null;c=j?g:0,d=j?g+1:i.length;for(;c<d;c++){e=i[c];if(e.selected&&(f.support.optDisabled?!e.disabled:e.getAttribute("disabled")===null)&&(!e.parentNode.disabled||!f.nodeName(e.parentNode,"optgroup"))){b=f(e).val();if(j)return b;h.push(b)}}if(j&&!h.length&&i.length)return f(i[g]).val();return h},set:function(a,b){var c=f.makeArray(b);f(a).find("option").each(function(){this.selected=f.inArray(f(this).val(),c)>=0}),c.length||(a.selectedIndex=-1);return c}}},attrFn:{val:!0,css:!0,html:!0,text:!0,data:!0,width:!0,height:!0,offset:!0},attr:function(a,c,d,e){var g,h,i,j=a.nodeType;if(!!a&&j!==3&&j!==8&&j!==2){if(e&&c in f.attrFn)return f(a)[c](d);if(typeof a.getAttribute=="undefined")return f.prop(a,c,d);i=j!==1||!f.isXMLDoc(a),i&&(c=c.toLowerCase(),h=f.attrHooks[c]||(u.test(c)?x:w));if(d!==b){if(d===null){f.removeAttr(a,c);return}if(h&&"set"in h&&i&&(g=h.set(a,d,c))!==b)return g;a.setAttribute(c,""+d);return d}if(h&&"get"in h&&i&&(g=h.get(a,c))!==null)return g;g=a.getAttribute(c);return g===null?b:g}},removeAttr:function(a,b){var c,d,e,g,h=0;if(b&&a.nodeType===1){d=b.toLowerCase().split(p),g=d.length;for(;h<g;h++)e=d[h],e&&(c=f.propFix[e]||e,f.attr(a,e,""),a.removeAttribute(v?e:c),u.test(e)&&c in a&&(a[c]=!1))}},attrHooks:{type:{set:function(a,b){if(r.test(a.nodeName)&&a.parentNode)f.error("type property can't be changed");else if(!f.support.radioValue&&b==="radio"&&f.nodeName(a,"input")){var c=a.value;a.setAttribute("type",b),c&&(a.value=c);return b}}},value:{get:function(a,b){if(w&&f.nodeName(a,"button"))return w.get(a,b);return b in a?a.value:null},set:function(a,b,c){if(w&&f.nodeName(a,"button"))return w.set(a,b,c);a.value=b}}},propFix:{tabindex:"tabIndex",readonly:"readOnly","for":"htmlFor","class":"className",maxlength:"maxLength",cellspacing:"cellSpacing",cellpadding:"cellPadding",rowspan:"rowSpan",colspan:"colSpan",usemap:"useMap",frameborder:"frameBorder",contenteditable:"contentEditable"},prop:function(a,c,d){var e,g,h,i=a.nodeType;if(!!a&&i!==3&&i!==8&&i!==2){h=i!==1||!f.isXMLDoc(a),h&&(c=f.propFix[c]||c,g=f.propHooks[c]);return d!==b?g&&"set"in g&&(e=g.set(a,d,c))!==b?e:a[c]=d:g&&"get"in g&&(e=g.get(a,c))!==null?e:a[c]}},propHooks:{tabIndex:{get:function(a){var c=a.getAttributeNode("tabindex");return c&&c.specified?parseInt(c.value,10):s.test(a.nodeName)||t.test(a.nodeName)&&a.href?0:b}}}}),f.attrHooks.tabindex=f.propHooks.tabIndex,x={get:function(a,c){var d,e=f.prop(a,c);return e===!0||typeof e!="boolean"&&(d=a.getAttributeNode(c))&&d.nodeValue!==!1?c.toLowerCase():b},set:function(a,b,c){var d;b===!1?f.removeAttr(a,c):(d=f.propFix[c]||c,d in a&&(a[d]=!0),a.setAttribute(c,c.toLowerCase()));return c}},v||(y={name:!0,id:!0},w=f.valHooks.button={get:function(a,c){var d;d=a.getAttributeNode(c);return d&&(y[c]?d.nodeValue!=="":d.specified)?d.nodeValue:b},set:function(a,b,d){var e=a.getAttributeNode(d);e||(e=c.createAttribute(d),a.setAttributeNode(e));return e.nodeValue=b+""}},f.attrHooks.tabindex.set=w.set,f.each(["width","height"],function(a,b){f.attrHooks[b]=f.extend(f.attrHooks[b],{set:function(a,c){if(c===""){a.setAttribute(b,"auto");return c}}})}),f.attrHooks.contenteditable={get:w.get,set:function(a,b,c){b===""&&(b="false"),w.set(a,b,c)}}),f.support.hrefNormalized||f.each(["href","src","width","height"],function(a,c){f.attrHooks[c]=f.extend(f.attrHooks[c],{get:function(a){var d=a.getAttribute(c,2);return d===null?b:d}})}),f.support.style||(f.attrHooks.style={get:function(a){return a.style.cssText.toLowerCase()||b},set:function(a,b){return a.style.cssText=""+b}}),f.support.optSelected||(f.propHooks.selected=f.extend(f.propHooks.selected,{get:function(a){var b=a.parentNode;b&&(b.selectedIndex,b.parentNode&&b.parentNode.selectedIndex);return null}})),f.support.enctype||(f.propFix.enctype="encoding"),f.support.checkOn||f.each(["radio","checkbox"],function(){f.valHooks[this]={get:function(a){return a.getAttribute("value")===null?"on":a.value}}}),f.each(["radio","checkbox"],function(){f.valHooks[this]=f.extend(f.valHooks[this],{set:function(a,b){if(f.isArray(b))return a.checked=f.inArray(f(a).val(),b)>=0}})});var z=/^(?:textarea|input|select)$/i,A=/^([^\.]*)?(?:\.(.+))?$/,B=/\bhover(\.\S+)?\b/,C=/^key/,D=/^(?:mouse|contextmenu)|click/,E=/^(?:focusinfocus|focusoutblur)$/,F=/^(\w*)(?:#([\w\-]+))?(?:\.([\w\-]+))?$/,G=function(a){var b=F.exec(a);b&&(b[1]=(b[1]||"").toLowerCase(),b[3]=b[3]&&new RegExp("(?:^|\\s)"+b[3]+"(?:\\s|$)"));return b},H=function(a,b){var c=a.attributes||{};return(!b[1]||a.nodeName.toLowerCase()===b[1])&&(!b[2]||(c.id||{}).value===b[2])&&(!b[3]||b[3].test((c["class"]||{}).value))},I=function(a){return f.event.special.hover?a:a.replace(B,"mouseenter$1 mouseleave$1")};
f.event={add:function(a,c,d,e,g){var h,i,j,k,l,m,n,o,p,q,r,s;if(!(a.nodeType===3||a.nodeType===8||!c||!d||!(h=f._data(a)))){d.handler&&(p=d,d=p.handler),d.guid||(d.guid=f.guid++),j=h.events,j||(h.events=j={}),i=h.handle,i||(h.handle=i=function(a){return typeof f!="undefined"&&(!a||f.event.triggered!==a.type)?f.event.dispatch.apply(i.elem,arguments):b},i.elem=a),c=f.trim(I(c)).split(" ");for(k=0;k<c.length;k++){l=A.exec(c[k])||[],m=l[1],n=(l[2]||"").split(".").sort(),s=f.event.special[m]||{},m=(g?s.delegateType:s.bindType)||m,s=f.event.special[m]||{},o=f.extend({type:m,origType:l[1],data:e,handler:d,guid:d.guid,selector:g,quick:G(g),namespace:n.join(".")},p),r=j[m];if(!r){r=j[m]=[],r.delegateCount=0;if(!s.setup||s.setup.call(a,e,n,i)===!1)a.addEventListener?a.addEventListener(m,i,!1):a.attachEvent&&a.attachEvent("on"+m,i)}s.add&&(s.add.call(a,o),o.handler.guid||(o.handler.guid=d.guid)),g?r.splice(r.delegateCount++,0,o):r.push(o),f.event.global[m]=!0}a=null}},global:{},remove:function(a,b,c,d,e){var g=f.hasData(a)&&f._data(a),h,i,j,k,l,m,n,o,p,q,r,s;if(!!g&&!!(o=g.events)){b=f.trim(I(b||"")).split(" ");for(h=0;h<b.length;h++){i=A.exec(b[h])||[],j=k=i[1],l=i[2];if(!j){for(j in o)f.event.remove(a,j+b[h],c,d,!0);continue}p=f.event.special[j]||{},j=(d?p.delegateType:p.bindType)||j,r=o[j]||[],m=r.length,l=l?new RegExp("(^|\\.)"+l.split(".").sort().join("\\.(?:.*\\.)?")+"(\\.|$)"):null;for(n=0;n<r.length;n++)s=r[n],(e||k===s.origType)&&(!c||c.guid===s.guid)&&(!l||l.test(s.namespace))&&(!d||d===s.selector||d==="**"&&s.selector)&&(r.splice(n--,1),s.selector&&r.delegateCount--,p.remove&&p.remove.call(a,s));r.length===0&&m!==r.length&&((!p.teardown||p.teardown.call(a,l)===!1)&&f.removeEvent(a,j,g.handle),delete o[j])}f.isEmptyObject(o)&&(q=g.handle,q&&(q.elem=null),f.removeData(a,["events","handle"],!0))}},customEvent:{getData:!0,setData:!0,changeData:!0},trigger:function(c,d,e,g){if(!e||e.nodeType!==3&&e.nodeType!==8){var h=c.type||c,i=[],j,k,l,m,n,o,p,q,r,s;if(E.test(h+f.event.triggered))return;h.indexOf("!")>=0&&(h=h.slice(0,-1),k=!0),h.indexOf(".")>=0&&(i=h.split("."),h=i.shift(),i.sort());if((!e||f.event.customEvent[h])&&!f.event.global[h])return;c=typeof c=="object"?c[f.expando]?c:new f.Event(h,c):new f.Event(h),c.type=h,c.isTrigger=!0,c.exclusive=k,c.namespace=i.join("."),c.namespace_re=c.namespace?new RegExp("(^|\\.)"+i.join("\\.(?:.*\\.)?")+"(\\.|$)"):null,o=h.indexOf(":")<0?"on"+h:"";if(!e){j=f.cache;for(l in j)j[l].events&&j[l].events[h]&&f.event.trigger(c,d,j[l].handle.elem,!0);return}c.result=b,c.target||(c.target=e),d=d!=null?f.makeArray(d):[],d.unshift(c),p=f.event.special[h]||{};if(p.trigger&&p.trigger.apply(e,d)===!1)return;r=[[e,p.bindType||h]];if(!g&&!p.noBubble&&!f.isWindow(e)){s=p.delegateType||h,m=E.test(s+h)?e:e.parentNode,n=null;for(;m;m=m.parentNode)r.push([m,s]),n=m;n&&n===e.ownerDocument&&r.push([n.defaultView||n.parentWindow||a,s])}for(l=0;l<r.length&&!c.isPropagationStopped();l++)m=r[l][0],c.type=r[l][1],q=(f._data(m,"events")||{})[c.type]&&f._data(m,"handle"),q&&q.apply(m,d),q=o&&m[o],q&&f.acceptData(m)&&q.apply(m,d)===!1&&c.preventDefault();c.type=h,!g&&!c.isDefaultPrevented()&&(!p._default||p._default.apply(e.ownerDocument,d)===!1)&&(h!=="click"||!f.nodeName(e,"a"))&&f.acceptData(e)&&o&&e[h]&&(h!=="focus"&&h!=="blur"||c.target.offsetWidth!==0)&&!f.isWindow(e)&&(n=e[o],n&&(e[o]=null),f.event.triggered=h,e[h](),f.event.triggered=b,n&&(e[o]=n));return c.result}},dispatch:function(c){c=f.event.fix(c||a.event);var d=(f._data(this,"events")||{})[c.type]||[],e=d.delegateCount,g=[].slice.call(arguments,0),h=!c.exclusive&&!c.namespace,i=[],j,k,l,m,n,o,p,q,r,s,t;g[0]=c,c.delegateTarget=this;if(e&&!c.target.disabled&&(!c.button||c.type!=="click")){m=f(this),m.context=this.ownerDocument||this;for(l=c.target;l!=this;l=l.parentNode||this){o={},q=[],m[0]=l;for(j=0;j<e;j++)r=d[j],s=r.selector,o[s]===b&&(o[s]=r.quick?H(l,r.quick):m.is(s)),o[s]&&q.push(r);q.length&&i.push({elem:l,matches:q})}}d.length>e&&i.push({elem:this,matches:d.slice(e)});for(j=0;j<i.length&&!c.isPropagationStopped();j++){p=i[j],c.currentTarget=p.elem;for(k=0;k<p.matches.length&&!c.isImmediatePropagationStopped();k++){r=p.matches[k];if(h||!c.namespace&&!r.namespace||c.namespace_re&&c.namespace_re.test(r.namespace))c.data=r.data,c.handleObj=r,n=((f.event.special[r.origType]||{}).handle||r.handler).apply(p.elem,g),n!==b&&(c.result=n,n===!1&&(c.preventDefault(),c.stopPropagation()))}}return c.result},props:"attrChange attrName relatedNode srcElement altKey bubbles cancelable ctrlKey currentTarget eventPhase metaKey relatedTarget shiftKey target timeStamp view which".split(" "),fixHooks:{},keyHooks:{props:"char charCode key keyCode".split(" "),filter:function(a,b){a.which==null&&(a.which=b.charCode!=null?b.charCode:b.keyCode);return a}},mouseHooks:{props:"button buttons clientX clientY fromElement offsetX offsetY pageX pageY screenX screenY toElement".split(" "),filter:function(a,d){var e,f,g,h=d.button,i=d.fromElement;a.pageX==null&&d.clientX!=null&&(e=a.target.ownerDocument||c,f=e.documentElement,g=e.body,a.pageX=d.clientX+(f&&f.scrollLeft||g&&g.scrollLeft||0)-(f&&f.clientLeft||g&&g.clientLeft||0),a.pageY=d.clientY+(f&&f.scrollTop||g&&g.scrollTop||0)-(f&&f.clientTop||g&&g.clientTop||0)),!a.relatedTarget&&i&&(a.relatedTarget=i===a.target?d.toElement:i),!a.which&&h!==b&&(a.which=h&1?1:h&2?3:h&4?2:0);return a}},fix:function(a){if(a[f.expando])return a;var d,e,g=a,h=f.event.fixHooks[a.type]||{},i=h.props?this.props.concat(h.props):this.props;a=f.Event(g);for(d=i.length;d;)e=i[--d],a[e]=g[e];a.target||(a.target=g.srcElement||c),a.target.nodeType===3&&(a.target=a.target.parentNode),a.metaKey===b&&(a.metaKey=a.ctrlKey);return h.filter?h.filter(a,g):a},special:{ready:{setup:f.bindReady},load:{noBubble:!0},focus:{delegateType:"focusin"},blur:{delegateType:"focusout"},beforeunload:{setup:function(a,b,c){f.isWindow(this)&&(this.onbeforeunload=c)},teardown:function(a,b){this.onbeforeunload===b&&(this.onbeforeunload=null)}}},simulate:function(a,b,c,d){var e=f.extend(new f.Event,c,{type:a,isSimulated:!0,originalEvent:{}});d?f.event.trigger(e,null,b):f.event.dispatch.call(b,e),e.isDefaultPrevented()&&c.preventDefault()}},f.event.handle=f.event.dispatch,f.removeEvent=c.removeEventListener?function(a,b,c){a.removeEventListener&&a.removeEventListener(b,c,!1)}:function(a,b,c){a.detachEvent&&a.detachEvent("on"+b,c)},f.Event=function(a,b){if(!(this instanceof f.Event))return new f.Event(a,b);a&&a.type?(this.originalEvent=a,this.type=a.type,this.isDefaultPrevented=a.defaultPrevented||a.returnValue===!1||a.getPreventDefault&&a.getPreventDefault()?K:J):this.type=a,b&&f.extend(this,b),this.timeStamp=a&&a.timeStamp||f.now(),this[f.expando]=!0},f.Event.prototype={preventDefault:function(){this.isDefaultPrevented=K;var a=this.originalEvent;!a||(a.preventDefault?a.preventDefault():a.returnValue=!1)},stopPropagation:function(){this.isPropagationStopped=K;var a=this.originalEvent;!a||(a.stopPropagation&&a.stopPropagation(),a.cancelBubble=!0)},stopImmediatePropagation:function(){this.isImmediatePropagationStopped=K,this.stopPropagation()},isDefaultPrevented:J,isPropagationStopped:J,isImmediatePropagationStopped:J},f.each({mouseenter:"mouseover",mouseleave:"mouseout"},function(a,b){f.event.special[a]={delegateType:b,bindType:b,handle:function(a){var c=this,d=a.relatedTarget,e=a.handleObj,g=e.selector,h;if(!d||d!==c&&!f.contains(c,d))a.type=e.origType,h=e.handler.apply(this,arguments),a.type=b;return h}}}),f.support.submitBubbles||(f.event.special.submit={setup:function(){if(f.nodeName(this,"form"))return!1;f.event.add(this,"click._submit keypress._submit",function(a){var c=a.target,d=f.nodeName(c,"input")||f.nodeName(c,"button")?c.form:b;d&&!d._submit_attached&&(f.event.add(d,"submit._submit",function(a){this.parentNode&&!a.isTrigger&&f.event.simulate("submit",this.parentNode,a,!0)}),d._submit_attached=!0)})},teardown:function(){if(f.nodeName(this,"form"))return!1;f.event.remove(this,"._submit")}}),f.support.changeBubbles||(f.event.special.change={setup:function(){if(z.test(this.nodeName)){if(this.type==="checkbox"||this.type==="radio")f.event.add(this,"propertychange._change",function(a){a.originalEvent.propertyName==="checked"&&(this._just_changed=!0)}),f.event.add(this,"click._change",function(a){this._just_changed&&!a.isTrigger&&(this._just_changed=!1,f.event.simulate("change",this,a,!0))});return!1}f.event.add(this,"beforeactivate._change",function(a){var b=a.target;z.test(b.nodeName)&&!b._change_attached&&(f.event.add(b,"change._change",function(a){this.parentNode&&!a.isSimulated&&!a.isTrigger&&f.event.simulate("change",this.parentNode,a,!0)}),b._change_attached=!0)})},handle:function(a){var b=a.target;if(this!==b||a.isSimulated||a.isTrigger||b.type!=="radio"&&b.type!=="checkbox")return a.handleObj.handler.apply(this,arguments)},teardown:function(){f.event.remove(this,"._change");return z.test(this.nodeName)}}),f.support.focusinBubbles||f.each({focus:"focusin",blur:"focusout"},function(a,b){var d=0,e=function(a){f.event.simulate(b,a.target,f.event.fix(a),!0)};f.event.special[b]={setup:function(){d++===0&&c.addEventListener(a,e,!0)},teardown:function(){--d===0&&c.removeEventListener(a,e,!0)}}}),f.fn.extend({on:function(a,c,d,e,g){var h,i;if(typeof a=="object"){typeof c!="string"&&(d=c,c=b);for(i in a)this.on(i,c,d,a[i],g);return this}d==null&&e==null?(e=c,d=c=b):e==null&&(typeof c=="string"?(e=d,d=b):(e=d,d=c,c=b));if(e===!1)e=J;else if(!e)return this;g===1&&(h=e,e=function(a){f().off(a);return h.apply(this,arguments)},e.guid=h.guid||(h.guid=f.guid++));return this.each(function(){f.event.add(this,a,e,d,c)})},one:function(a,b,c,d){return this.on.call(this,a,b,c,d,1)},off:function(a,c,d){if(a&&a.preventDefault&&a.handleObj){var e=a.handleObj;f(a.delegateTarget).off(e.namespace?e.type+"."+e.namespace:e.type,e.selector,e.handler);return this}if(typeof a=="object"){for(var g in a)this.off(g,c,a[g]);return this}if(c===!1||typeof c=="function")d=c,c=b;d===!1&&(d=J);return this.each(function(){f.event.remove(this,a,d,c)})},bind:function(a,b,c){return this.on(a,null,b,c)},unbind:function(a,b){return this.off(a,null,b)},live:function(a,b,c){f(this.context).on(a,this.selector,b,c);return this},die:function(a,b){f(this.context).off(a,this.selector||"**",b);return this},delegate:function(a,b,c,d){return this.on(b,a,c,d)},undelegate:function(a,b,c){return arguments.length==1?this.off(a,"**"):this.off(b,a,c)},trigger:function(a,b){return this.each(function(){f.event.trigger(a,b,this)})},triggerHandler:function(a,b){if(this[0])return f.event.trigger(a,b,this[0],!0)},toggle:function(a){var b=arguments,c=a.guid||f.guid++,d=0,e=function(c){var e=(f._data(this,"lastToggle"+a.guid)||0)%d;f._data(this,"lastToggle"+a.guid,e+1),c.preventDefault();return b[e].apply(this,arguments)||!1};e.guid=c;while(d<b.length)b[d++].guid=c;return this.click(e)},hover:function(a,b){return this.mouseenter(a).mouseleave(b||a)}}),f.each("blur focus focusin focusout load resize scroll unload click dblclick mousedown mouseup mousemove mouseover mouseout mouseenter mouseleave change select submit keydown keypress keyup error contextmenu".split(" "),function(a,b){f.fn[b]=function(a,c){c==null&&(c=a,a=null);return arguments.length>0?this.on(b,null,a,c):this.trigger(b)},f.attrFn&&(f.attrFn[b]=!0),C.test(b)&&(f.event.fixHooks[b]=f.event.keyHooks),D.test(b)&&(f.event.fixHooks[b]=f.event.mouseHooks)}),function(){function x(a,b,c,e,f,g){for(var h=0,i=e.length;h<i;h++){var j=e[h];if(j){var k=!1;j=j[a];while(j){if(j[d]===c){k=e[j.sizset];break}if(j.nodeType===1){g||(j[d]=c,j.sizset=h);if(typeof b!="string"){if(j===b){k=!0;break}}else if(m.filter(b,[j]).length>0){k=j;break}}j=j[a]}e[h]=k}}}function w(a,b,c,e,f,g){for(var h=0,i=e.length;h<i;h++){var j=e[h];if(j){var k=!1;j=j[a];while(j){if(j[d]===c){k=e[j.sizset];break}j.nodeType===1&&!g&&(j[d]=c,j.sizset=h);if(j.nodeName.toLowerCase()===b){k=j;break}j=j[a]}e[h]=k}}}var a=/((?:\((?:\([^()]+\)|[^()]+)+\)|\[(?:\[[^\[\]]*\]|['"][^'"]*['"]|[^\[\]'"]+)+\]|\\.|[^ >+~,(\[\\]+)+|[>+~])(\s*,\s*)?((?:.|\r|\n)*)/g,d="sizcache"+(Math.random()+"").replace(".",""),e=0,g=Object.prototype.toString,h=!1,i=!0,j=/\\/g,k=/\r\n/g,l=/\W/;[0,0].sort(function(){i=!1;return 0});var m=function(b,d,e,f){e=e||[],d=d||c;var h=d;if(d.nodeType!==1&&d.nodeType!==9)return[];if(!b||typeof b!="string")return e;var i,j,k,l,n,q,r,t,u=!0,v=m.isXML(d),w=[],x=b;do{a.exec(""),i=a.exec(x);if(i){x=i[3],w.push(i[1]);if(i[2]){l=i[3];break}}}while(i);if(w.length>1&&p.exec(b))if(w.length===2&&o.relative[w[0]])j=y(w[0]+w[1],d,f);else{j=o.relative[w[0]]?[d]:m(w.shift(),d);while(w.length)b=w.shift(),o.relative[b]&&(b+=w.shift()),j=y(b,j,f)}else{!f&&w.length>1&&d.nodeType===9&&!v&&o.match.ID.test(w[0])&&!o.match.ID.test(w[w.length-1])&&(n=m.find(w.shift(),d,v),d=n.expr?m.filter(n.expr,n.set)[0]:n.set[0]);if(d){n=f?{expr:w.pop(),set:s(f)}:m.find(w.pop(),w.length===1&&(w[0]==="~"||w[0]==="+")&&d.parentNode?d.parentNode:d,v),j=n.expr?m.filter(n.expr,n.set):n.set,w.length>0?k=s(j):u=!1;while(w.length)q=w.pop(),r=q,o.relative[q]?r=w.pop():q="",r==null&&(r=d),o.relative[q](k,r,v)}else k=w=[]}k||(k=j),k||m.error(q||b);if(g.call(k)==="[object Array]")if(!u)e.push.apply(e,k);else if(d&&d.nodeType===1)for(t=0;k[t]!=null;t++)k[t]&&(k[t]===!0||k[t].nodeType===1&&m.contains(d,k[t]))&&e.push(j[t]);else for(t=0;k[t]!=null;t++)k[t]&&k[t].nodeType===1&&e.push(j[t]);else s(k,e);l&&(m(l,h,e,f),m.uniqueSort(e));return e};m.uniqueSort=function(a){if(u){h=i,a.sort(u);if(h)for(var b=1;b<a.length;b++)a[b]===a[b-1]&&a.splice(b--,1)}return a},m.matches=function(a,b){return m(a,null,null,b)},m.matchesSelector=function(a,b){return m(b,null,null,[a]).length>0},m.find=function(a,b,c){var d,e,f,g,h,i;if(!a)return[];for(e=0,f=o.order.length;e<f;e++){h=o.order[e];if(g=o.leftMatch[h].exec(a)){i=g[1],g.splice(1,1);if(i.substr(i.length-1)!=="\\"){g[1]=(g[1]||"").replace(j,""),d=o.find[h](g,b,c);if(d!=null){a=a.replace(o.match[h],"");break}}}}d||(d=typeof b.getElementsByTagName!="undefined"?b.getElementsByTagName("*"):[]);return{set:d,expr:a}},m.filter=function(a,c,d,e){var f,g,h,i,j,k,l,n,p,q=a,r=[],s=c,t=c&&c[0]&&m.isXML(c[0]);while(a&&c.length){for(h in o.filter)if((f=o.leftMatch[h].exec(a))!=null&&f[2]){k=o.filter[h],l=f[1],g=!1,f.splice(1,1);if(l.substr(l.length-1)==="\\")continue;s===r&&(r=[]);if(o.preFilter[h]){f=o.preFilter[h](f,s,d,r,e,t);if(!f)g=i=!0;else if(f===!0)continue}if(f)for(n=0;(j=s[n])!=null;n++)j&&(i=k(j,f,n,s),p=e^i,d&&i!=null?p?g=!0:s[n]=!1:p&&(r.push(j),g=!0));if(i!==b){d||(s=r),a=a.replace(o.match[h],"");if(!g)return[];break}}if(a===q)if(g==null)m.error(a);else break;q=a}return s},m.error=function(a){throw new Error("Syntax error, unrecognized expression: "+a)};var n=m.getText=function(a){var b,c,d=a.nodeType,e="";if(d){if(d===1||d===9){if(typeof a.textContent=="string")return a.textContent;if(typeof a.innerText=="string")return a.innerText.replace(k,"");for(a=a.firstChild;a;a=a.nextSibling)e+=n(a)}else if(d===3||d===4)return a.nodeValue}else for(b=0;c=a[b];b++)c.nodeType!==8&&(e+=n(c));return e},o=m.selectors={order:["ID","NAME","TAG"],match:{ID:/#((?:[\w\u00c0-\uFFFF\-]|\\.)+)/,CLASS:/\.((?:[\w\u00c0-\uFFFF\-]|\\.)+)/,NAME:/\[name=['"]*((?:[\w\u00c0-\uFFFF\-]|\\.)+)['"]*\]/,ATTR:/\[\s*((?:[\w\u00c0-\uFFFF\-]|\\.)+)\s*(?:(\S?=)\s*(?:(['"])(.*?)\3|(#?(?:[\w\u00c0-\uFFFF\-]|\\.)*)|)|)\s*\]/,TAG:/^((?:[\w\u00c0-\uFFFF\*\-]|\\.)+)/,CHILD:/:(only|nth|last|first)-child(?:\(\s*(even|odd|(?:[+\-]?\d+|(?:[+\-]?\d*)?n\s*(?:[+\-]\s*\d+)?))\s*\))?/,POS:/:(nth|eq|gt|lt|first|last|even|odd)(?:\((\d*)\))?(?=[^\-]|$)/,PSEUDO:/:((?:[\w\u00c0-\uFFFF\-]|\\.)+)(?:\((['"]?)((?:\([^\)]+\)|[^\(\)]*)+)\2\))?/},leftMatch:{},attrMap:{"class":"className","for":"htmlFor"},attrHandle:{href:function(a){return a.getAttribute("href")},type:function(a){return a.getAttribute("type")}},relative:{"+":function(a,b){var c=typeof b=="string",d=c&&!l.test(b),e=c&&!d;d&&(b=b.toLowerCase());for(var f=0,g=a.length,h;f<g;f++)if(h=a[f]){while((h=h.previousSibling)&&h.nodeType!==1);a[f]=e||h&&h.nodeName.toLowerCase()===b?h||!1:h===b}e&&m.filter(b,a,!0)},">":function(a,b){var c,d=typeof b=="string",e=0,f=a.length;if(d&&!l.test(b)){b=b.toLowerCase();for(;e<f;e++){c=a[e];if(c){var g=c.parentNode;a[e]=g.nodeName.toLowerCase()===b?g:!1}}}else{for(;e<f;e++)c=a[e],c&&(a[e]=d?c.parentNode:c.parentNode===b);d&&m.filter(b,a,!0)}},"":function(a,b,c){var d,f=e++,g=x;typeof b=="string"&&!l.test(b)&&(b=b.toLowerCase(),d=b,g=w),g("parentNode",b,f,a,d,c)},"~":function(a,b,c){var d,f=e++,g=x;typeof b=="string"&&!l.test(b)&&(b=b.toLowerCase(),d=b,g=w),g("previousSibling",b,f,a,d,c)}},find:{ID:function(a,b,c){if(typeof b.getElementById!="undefined"&&!c){var d=b.getElementById(a[1]);return d&&d.parentNode?[d]:[]}},NAME:function(a,b){if(typeof b.getElementsByName!="undefined"){var c=[],d=b.getElementsByName(a[1]);for(var e=0,f=d.length;e<f;e++)d[e].getAttribute("name")===a[1]&&c.push(d[e]);return c.length===0?null:c}},TAG:function(a,b){if(typeof b.getElementsByTagName!="undefined")return b.getElementsByTagName(a[1])}},preFilter:{CLASS:function(a,b,c,d,e,f){a=" "+a[1].replace(j,"")+" ";if(f)return a;for(var g=0,h;(h=b[g])!=null;g++)h&&(e^(h.className&&(" "+h.className+" ").replace(/[\t\n\r]/g," ").indexOf(a)>=0)?c||d.push(h):c&&(b[g]=!1));return!1},ID:function(a){return a[1].replace(j,"")},TAG:function(a,b){return a[1].replace(j,"").toLowerCase()},CHILD:function(a){if(a[1]==="nth"){a[2]||m.error(a[0]),a[2]=a[2].replace(/^\+|\s*/g,"");var b=/(-?)(\d*)(?:n([+\-]?\d*))?/.exec(a[2]==="even"&&"2n"||a[2]==="odd"&&"2n+1"||!/\D/.test(a[2])&&"0n+"+a[2]||a[2]);a[2]=b[1]+(b[2]||1)-0,a[3]=b[3]-0}else a[2]&&m.error(a[0]);a[0]=e++;return a},ATTR:function(a,b,c,d,e,f){var g=a[1]=a[1].replace(j,"");!f&&o.attrMap[g]&&(a[1]=o.attrMap[g]),a[4]=(a[4]||a[5]||"").replace(j,""),a[2]==="~="&&(a[4]=" "+a[4]+" ");return a},PSEUDO:function(b,c,d,e,f){if(b[1]==="not")if((a.exec(b[3])||"").length>1||/^\w/.test(b[3]))b[3]=m(b[3],null,null,c);else{var g=m.filter(b[3],c,d,!0^f);d||e.push.apply(e,g);return!1}else if(o.match.POS.test(b[0])||o.match.CHILD.test(b[0]))return!0;return b},POS:function(a){a.unshift(!0);return a}},filters:{enabled:function(a){return a.disabled===!1&&a.type!=="hidden"},disabled:function(a){return a.disabled===!0},checked:function(a){return a.checked===!0},selected:function(a){a.parentNode&&a.parentNode.selectedIndex;return a.selected===!0},parent:function(a){return!!a.firstChild},empty:function(a){return!a.firstChild},has:function(a,b,c){return!!m(c[3],a).length},header:function(a){return/h\d/i.test(a.nodeName)},text:function(a){var b=a.getAttribute("type"),c=a.type;return a.nodeName.toLowerCase()==="input"&&"text"===c&&(b===c||b===null)},radio:function(a){return a.nodeName.toLowerCase()==="input"&&"radio"===a.type},checkbox:function(a){return a.nodeName.toLowerCase()==="input"&&"checkbox"===a.type},file:function(a){return a.nodeName.toLowerCase()==="input"&&"file"===a.type},password:function(a){return a.nodeName.toLowerCase()==="input"&&"password"===a.type},submit:function(a){var b=a.nodeName.toLowerCase();return(b==="input"||b==="button")&&"submit"===a.type},image:function(a){return a.nodeName.toLowerCase()==="input"&&"image"===a.type},reset:function(a){var b=a.nodeName.toLowerCase();return(b==="input"||b==="button")&&"reset"===a.type},button:function(a){var b=a.nodeName.toLowerCase();return b==="input"&&"button"===a.type||b==="button"},input:function(a){return/input|select|textarea|button/i.test(a.nodeName)},focus:function(a){return a===a.ownerDocument.activeElement}},setFilters:{first:function(a,b){return b===0},last:function(a,b,c,d){return b===d.length-1},even:function(a,b){return b%2===0},odd:function(a,b){return b%2===1},lt:function(a,b,c){return b<c[3]-0},gt:function(a,b,c){return b>c[3]-0},nth:function(a,b,c){return c[3]-0===b},eq:function(a,b,c){return c[3]-0===b}},filter:{PSEUDO:function(a,b,c,d){var e=b[1],f=o.filters[e];if(f)return f(a,c,b,d);if(e==="contains")return(a.textContent||a.innerText||n([a])||"").indexOf(b[3])>=0;if(e==="not"){var g=b[3];for(var h=0,i=g.length;h<i;h++)if(g[h]===a)return!1;return!0}m.error(e)},CHILD:function(a,b){var c,e,f,g,h,i,j,k=b[1],l=a;switch(k){case"only":case"first":while(l=l.previousSibling)if(l.nodeType===1)return!1;if(k==="first")return!0;l=a;case"last":while(l=l.nextSibling)if(l.nodeType===1)return!1;return!0;case"nth":c=b[2],e=b[3];if(c===1&&e===0)return!0;f=b[0],g=a.parentNode;if(g&&(g[d]!==f||!a.nodeIndex)){i=0;for(l=g.firstChild;l;l=l.nextSibling)l.nodeType===1&&(l.nodeIndex=++i);g[d]=f}j=a.nodeIndex-e;return c===0?j===0:j%c===0&&j/c>=0}},ID:function(a,b){return a.nodeType===1&&a.getAttribute("id")===b},TAG:function(a,b){return b==="*"&&a.nodeType===1||!!a.nodeName&&a.nodeName.toLowerCase()===b},CLASS:function(a,b){return(" "+(a.className||a.getAttribute("class"))+" ").indexOf(b)>-1},ATTR:function(a,b){var c=b[1],d=m.attr?m.attr(a,c):o.attrHandle[c]?o.attrHandle[c](a):a[c]!=null?a[c]:a.getAttribute(c),e=d+"",f=b[2],g=b[4];return d==null?f==="!=":!f&&m.attr?d!=null:f==="="?e===g:f==="*="?e.indexOf(g)>=0:f==="~="?(" "+e+" ").indexOf(g)>=0:g?f==="!="?e!==g:f==="^="?e.indexOf(g)===0:f==="$="?e.substr(e.length-g.length)===g:f==="|="?e===g||e.substr(0,g.length+1)===g+"-":!1:e&&d!==!1},POS:function(a,b,c,d){var e=b[2],f=o.setFilters[e];if(f)return f(a,c,b,d)}}},p=o.match.POS,q=function(a,b){return"\\"+(b-0+1)};for(var r in o.match)o.match[r]=new RegExp(o.match[r].source+/(?![^\[]*\])(?![^\(]*\))/.source),o.leftMatch[r]=new RegExp(/(^(?:.|\r|\n)*?)/.source+o.match[r].source.replace(/\\(\d+)/g,q));var s=function(a,b){a=Array.prototype.slice.call(a,0);if(b){b.push.apply(b,a);return b}return a};try{Array.prototype.slice.call(c.documentElement.childNodes,0)[0].nodeType}catch(t){s=function(a,b){var c=0,d=b||[];if(g.call(a)==="[object Array]")Array.prototype.push.apply(d,a);else if(typeof a.length=="number")for(var e=a.length;c<e;c++)d.push(a[c]);else for(;a[c];c++)d.push(a[c]);return d}}var u,v;c.documentElement.compareDocumentPosition?u=function(a,b){if(a===b){h=!0;return 0}if(!a.compareDocumentPosition||!b.compareDocumentPosition)return a.compareDocumentPosition?-1:1;return a.compareDocumentPosition(b)&4?-1:1}:(u=function(a,b){if(a===b){h=!0;return 0}if(a.sourceIndex&&b.sourceIndex)return a.sourceIndex-b.sourceIndex;var c,d,e=[],f=[],g=a.parentNode,i=b.parentNode,j=g;if(g===i)return v(a,b);if(!g)return-1;if(!i)return 1;while(j)e.unshift(j),j=j.parentNode;j=i;while(j)f.unshift(j),j=j.parentNode;c=e.length,d=f.length;for(var k=0;k<c&&k<d;k++)if(e[k]!==f[k])return v(e[k],f[k]);return k===c?v(a,f[k],-1):v(e[k],b,1)},v=function(a,b,c){if(a===b)return c;var d=a.nextSibling;while(d){if(d===b)return-1;d=d.nextSibling}return 1}),function(){var a=c.createElement("div"),d="script"+(new Date).getTime(),e=c.documentElement;a.innerHTML="<a name='"+d+"'/>",e.insertBefore(a,e.firstChild),c.getElementById(d)&&(o.find.ID=function(a,c,d){if(typeof c.getElementById!="undefined"&&!d){var e=c.getElementById(a[1]);return e?e.id===a[1]||typeof e.getAttributeNode!="undefined"&&e.getAttributeNode("id").nodeValue===a[1]?[e]:b:[]}},o.filter.ID=function(a,b){var c=typeof a.getAttributeNode!="undefined"&&a.getAttributeNode("id");return a.nodeType===1&&c&&c.nodeValue===b}),e.removeChild(a),e=a=null}(),function(){var a=c.createElement("div");a.appendChild(c.createComment("")),a.getElementsByTagName("*").length>0&&(o.find.TAG=function(a,b){var c=b.getElementsByTagName(a[1]);if(a[1]==="*"){var d=[];for(var e=0;c[e];e++)c[e].nodeType===1&&d.push(c[e]);c=d}return c}),a.innerHTML="<a href='#'></a>",a.firstChild&&typeof a.firstChild.getAttribute!="undefined"&&a.firstChild.getAttribute("href")!=="#"&&(o.attrHandle.href=function(a){return a.getAttribute("href",2)}),a=null}(),c.querySelectorAll&&function(){var a=m,b=c.createElement("div"),d="__sizzle__";b.innerHTML="<p class='TEST'></p>";if(!b.querySelectorAll||b.querySelectorAll(".TEST").length!==0){m=function(b,e,f,g){e=e||c;if(!g&&!m.isXML(e)){var h=/^(\w+$)|^\.([\w\-]+$)|^#([\w\-]+$)/.exec(b);if(h&&(e.nodeType===1||e.nodeType===9)){if(h[1])return s(e.getElementsByTagName(b),f);if(h[2]&&o.find.CLASS&&e.getElementsByClassName)return s(e.getElementsByClassName(h[2]),f)}if(e.nodeType===9){if(b==="body"&&e.body)return s([e.body],f);if(h&&h[3]){var i=e.getElementById(h[3]);if(!i||!i.parentNode)return s([],f);if(i.id===h[3])return s([i],f)}try{return s(e.querySelectorAll(b),f)}catch(j){}}else if(e.nodeType===1&&e.nodeName.toLowerCase()!=="object"){var k=e,l=e.getAttribute("id"),n=l||d,p=e.parentNode,q=/^\s*[+~]/.test(b);l?n=n.replace(/'/g,"\\$&"):e.setAttribute("id",n),q&&p&&(e=e.parentNode);try{if(!q||p)return s(e.querySelectorAll("[id='"+n+"'] "+b),f)}catch(r){}finally{l||k.removeAttribute("id")}}}return a(b,e,f,g)};for(var e in a)m[e]=a[e];b=null}}(),function(){var a=c.documentElement,b=a.matchesSelector||a.mozMatchesSelector||a.webkitMatchesSelector||a.msMatchesSelector;if(b){var d=!b.call(c.createElement("div"),"div"),e=!1;try{b.call(c.documentElement,"[test!='']:sizzle")}catch(f){e=!0}m.matchesSelector=function(a,c){c=c.replace(/\=\s*([^'"\]]*)\s*\]/g,"='$1']");if(!m.isXML(a))try{if(e||!o.match.PSEUDO.test(c)&&!/!=/.test(c)){var f=b.call(a,c);if(f||!d||a.document&&a.document.nodeType!==11)return f}}catch(g){}return m(c,null,null,[a]).length>0}}}(),function(){var a=c.createElement("div");a.innerHTML="<div class='test e'></div><div class='test'></div>";if(!!a.getElementsByClassName&&a.getElementsByClassName("e").length!==0){a.lastChild.className="e";if(a.getElementsByClassName("e").length===1)return;o.order.splice(1,0,"CLASS"),o.find.CLASS=function(a,b,c){if(typeof b.getElementsByClassName!="undefined"&&!c)return b.getElementsByClassName(a[1])},a=null}}(),c.documentElement.contains?m.contains=function(a,b){return a!==b&&(a.contains?a.contains(b):!0)}:c.documentElement.compareDocumentPosition?m.contains=function(a,b){return!!(a.compareDocumentPosition(b)&16)}:m.contains=function(){return!1},m.isXML=function(a){var b=(a?a.ownerDocument||a:0).documentElement;return b?b.nodeName!=="HTML":!1};var y=function(a,b,c){var d,e=[],f="",g=b.nodeType?[b]:b;while(d=o.match.PSEUDO.exec(a))f+=d[0],a=a.replace(o.match.PSEUDO,"");a=o.relative[a]?a+"*":a;for(var h=0,i=g.length;h<i;h++)m(a,g[h],e,c);return m.filter(f,e)};m.attr=f.attr,m.selectors.attrMap={},f.find=m,f.expr=m.selectors,f.expr[":"]=f.expr.filters,f.unique=m.uniqueSort,f.text=m.getText,f.isXMLDoc=m.isXML,f.contains=m.contains}();var L=/Until$/,M=/^(?:parents|prevUntil|prevAll)/,N=/,/,O=/^.[^:#\[\.,]*$/,P=Array.prototype.slice,Q=f.expr.match.POS,R={children:!0,contents:!0,next:!0,prev:!0};f.fn.extend({find:function(a){var b=this,c,d;if(typeof a!="string")return f(a).filter(function(){for(c=0,d=b.length;c<d;c++)if(f.contains(b[c],this))return!0});var e=this.pushStack("","find",a),g,h,i;for(c=0,d=this.length;c<d;c++){g=e.length,f.find(a,this[c],e);if(c>0)for(h=g;h<e.length;h++)for(i=0;i<g;i++)if(e[i]===e[h]){e.splice(h--,1);break}}return e},has:function(a){var b=f(a);return this.filter(function(){for(var a=0,c=b.length;a<c;a++)if(f.contains(this,b[a]))return!0})},not:function(a){return this.pushStack(T(this,a,!1),"not",a)},filter:function(a){return this.pushStack(T(this,a,!0),"filter",a)},is:function(a){return!!a&&(typeof a=="string"?Q.test(a)?f(a,this.context).index(this[0])>=0:f.filter(a,this).length>0:this.filter(a).length>0)},closest:function(a,b){var c=[],d,e,g=this[0];if(f.isArray(a)){var h=1;while(g&&g.ownerDocument&&g!==b){for(d=0;d<a.length;d++)f(g).is(a[d])&&c.push({selector:a[d],elem:g,level:h});g=g.parentNode,h++}return c}var i=Q.test(a)||typeof a!="string"?f(a,b||this.context):0;for(d=0,e=this.length;d<e;d++){g=this[d];while(g){if(i?i.index(g)>-1:f.find.matchesSelector(g,a)){c.push(g);break}g=g.parentNode;if(!g||!g.ownerDocument||g===b||g.nodeType===11)break}}c=c.length>1?f.unique(c):c;return this.pushStack(c,"closest",a)},index:function(a){if(!a)return this[0]&&this[0].parentNode?this.prevAll().length:-1;if(typeof a=="string")return f.inArray(this[0],f(a));return f.inArray(a.jquery?a[0]:a,this)},add:function(a,b){var c=typeof a=="string"?f(a,b):f.makeArray(a&&a.nodeType?[a]:a),d=f.merge(this.get(),c);return this.pushStack(S(c[0])||S(d[0])?d:f.unique(d))},andSelf:function(){return this.add(this.prevObject)}}),f.each({parent:function(a){var b=a.parentNode;return b&&b.nodeType!==11?b:null},parents:function(a){return f.dir(a,"parentNode")},parentsUntil:function(a,b,c){return f.dir(a,"parentNode",c)},next:function(a){return f.nth(a,2,"nextSibling")},prev:function(a){return f.nth(a,2,"previousSibling")},nextAll:function(a){return f.dir(a,"nextSibling")},prevAll:function(a){return f.dir(a,"previousSibling")},nextUntil:function(a,b,c){return f.dir(a,"nextSibling",c)},prevUntil:function(a,b,c){return f.dir(a,"previousSibling",c)},siblings:function(a){return f.sibling(a.parentNode.firstChild,a)},children:function(a){return f.sibling(a.firstChild)},contents:function(a){return f.nodeName(a,"iframe")?a.contentDocument||a.contentWindow.document:f.makeArray(a.childNodes)}},function(a,b){f.fn[a]=function(c,d){var e=f.map(this,b,c);L.test(a)||(d=c),d&&typeof d=="string"&&(e=f.filter(d,e)),e=this.length>1&&!R[a]?f.unique(e):e,(this.length>1||N.test(d))&&M.test(a)&&(e=e.reverse());return this.pushStack(e,a,P.call(arguments).join(","))}}),f.extend({filter:function(a,b,c){c&&(a=":not("+a+")");return b.length===1?f.find.matchesSelector(b[0],a)?[b[0]]:[]:f.find.matches(a,b)},dir:function(a,c,d){var e=[],g=a[c];while(g&&g.nodeType!==9&&(d===b||g.nodeType!==1||!f(g).is(d)))g.nodeType===1&&e.push(g),g=g[c];return e},nth:function(a,b,c,d){b=b||1;var e=0;for(;a;a=a[c])if(a.nodeType===1&&++e===b)break;return a},sibling:function(a,b){var c=[];for(;a;a=a.nextSibling)a.nodeType===1&&a!==b&&c.push(a);return c}});var V="abbr|article|aside|audio|canvas|datalist|details|figcaption|figure|footer|header|hgroup|mark|meter|nav|output|progress|section|summary|time|video",W=/ jQuery\d+="(?:\d+|null)"/g,X=/^\s+/,Y=/<(?!area|br|col|embed|hr|img|input|link|meta|param)(([\w:]+)[^>]*)\/>/ig,Z=/<([\w:]+)/,$=/<tbody/i,_=/<|&#?\w+;/,ba=/<(?:script|style)/i,bb=/<(?:script|object|embed|option|style)/i,bc=new RegExp("<(?:"+V+")","i"),bd=/checked\s*(?:[^=]|=\s*.checked.)/i,be=/\/(java|ecma)script/i,bf=/^\s*<!(?:\[CDATA\[|\-\-)/,bg={option:[1,"<select multiple='multiple'>","</select>"],legend:[1,"<fieldset>","</fieldset>"],thead:[1,"<table>","</table>"],tr:[2,"<table><tbody>","</tbody></table>"],td:[3,"<table><tbody><tr>","</tr></tbody></table>"],col:[2,"<table><tbody></tbody><colgroup>","</colgroup></table>"],area:[1,"<map>","</map>"],_default:[0,"",""]},bh=U(c);bg.optgroup=bg.option,bg.tbody=bg.tfoot=bg.colgroup=bg.caption=bg.thead,bg.th=bg.td,f.support.htmlSerialize||(bg._default=[1,"div<div>","</div>"]),f.fn.extend({text:function(a){if(f.isFunction(a))return this.each(function(b){var c=f(this);c.text(a.call(this,b,c.text()))});if(typeof a!="object"&&a!==b)return this.empty().append((this[0]&&this[0].ownerDocument||c).createTextNode(a));return f.text(this)},wrapAll:function(a){if(f.isFunction(a))return this.each(function(b){f(this).wrapAll(a.call(this,b))});if(this[0]){var b=f(a,this[0].ownerDocument).eq(0).clone(!0);this[0].parentNode&&b.insertBefore(this[0]),b.map(function(){var a=this;while(a.firstChild&&a.firstChild.nodeType===1)a=a.firstChild;return a}).append(this)}return this},wrapInner:function(a){if(f.isFunction(a))return this.each(function(b){f(this).wrapInner(a.call(this,b))});return this.each(function(){var b=f(this),c=b.contents();c.length?c.wrapAll(a):b.append(a)})},wrap:function(a){var b=f.isFunction(a);return this.each(function(c){f(this).wrapAll(b?a.call(this,c):a)})},unwrap:function(){return this.parent().each(function(){f.nodeName(this,"body")||f(this).replaceWith(this.childNodes)}).end()},append:function(){return this.domManip(arguments,!0,function(a){this.nodeType===1&&this.appendChild(a)})},prepend:function(){return this.domManip(arguments,!0,function(a){this.nodeType===1&&this.insertBefore(a,this.firstChild)})},before:function(){if(this[0]&&this[0].parentNode)return this.domManip(arguments,!1,function(a){this.parentNode.insertBefore(a,this)});if(arguments.length){var a=f.clean(arguments);a.push.apply(a,this.toArray());return this.pushStack(a,"before",arguments)}},after:function(){if(this[0]&&this[0].parentNode)return this.domManip(arguments,!1,function(a){this.parentNode.insertBefore(a,this.nextSibling)});if(arguments.length){var a=this.pushStack(this,"after",arguments);a.push.apply(a,f.clean(arguments));return a}},remove:function(a,b){for(var c=0,d;(d=this[c])!=null;c++)if(!a||f.filter(a,[d]).length)!b&&d.nodeType===1&&(f.cleanData(d.getElementsByTagName("*")),f.cleanData([d])),d.parentNode&&d.parentNode.removeChild(d);return this},empty:function()
{for(var a=0,b;(b=this[a])!=null;a++){b.nodeType===1&&f.cleanData(b.getElementsByTagName("*"));while(b.firstChild)b.removeChild(b.firstChild)}return this},clone:function(a,b){a=a==null?!1:a,b=b==null?a:b;return this.map(function(){return f.clone(this,a,b)})},html:function(a){if(a===b)return this[0]&&this[0].nodeType===1?this[0].innerHTML.replace(W,""):null;if(typeof a=="string"&&!ba.test(a)&&(f.support.leadingWhitespace||!X.test(a))&&!bg[(Z.exec(a)||["",""])[1].toLowerCase()]){a=a.replace(Y,"<$1></$2>");try{for(var c=0,d=this.length;c<d;c++)this[c].nodeType===1&&(f.cleanData(this[c].getElementsByTagName("*")),this[c].innerHTML=a)}catch(e){this.empty().append(a)}}else f.isFunction(a)?this.each(function(b){var c=f(this);c.html(a.call(this,b,c.html()))}):this.empty().append(a);return this},replaceWith:function(a){if(this[0]&&this[0].parentNode){if(f.isFunction(a))return this.each(function(b){var c=f(this),d=c.html();c.replaceWith(a.call(this,b,d))});typeof a!="string"&&(a=f(a).detach());return this.each(function(){var b=this.nextSibling,c=this.parentNode;f(this).remove(),b?f(b).before(a):f(c).append(a)})}return this.length?this.pushStack(f(f.isFunction(a)?a():a),"replaceWith",a):this},detach:function(a){return this.remove(a,!0)},domManip:function(a,c,d){var e,g,h,i,j=a[0],k=[];if(!f.support.checkClone&&arguments.length===3&&typeof j=="string"&&bd.test(j))return this.each(function(){f(this).domManip(a,c,d,!0)});if(f.isFunction(j))return this.each(function(e){var g=f(this);a[0]=j.call(this,e,c?g.html():b),g.domManip(a,c,d)});if(this[0]){i=j&&j.parentNode,f.support.parentNode&&i&&i.nodeType===11&&i.childNodes.length===this.length?e={fragment:i}:e=f.buildFragment(a,this,k),h=e.fragment,h.childNodes.length===1?g=h=h.firstChild:g=h.firstChild;if(g){c=c&&f.nodeName(g,"tr");for(var l=0,m=this.length,n=m-1;l<m;l++)d.call(c?bi(this[l],g):this[l],e.cacheable||m>1&&l<n?f.clone(h,!0,!0):h)}k.length&&f.each(k,bp)}return this}}),f.buildFragment=function(a,b,d){var e,g,h,i,j=a[0];b&&b[0]&&(i=b[0].ownerDocument||b[0]),i.createDocumentFragment||(i=c),a.length===1&&typeof j=="string"&&j.length<512&&i===c&&j.charAt(0)==="<"&&!bb.test(j)&&(f.support.checkClone||!bd.test(j))&&(f.support.html5Clone||!bc.test(j))&&(g=!0,h=f.fragments[j],h&&h!==1&&(e=h)),e||(e=i.createDocumentFragment(),f.clean(a,i,e,d)),g&&(f.fragments[j]=h?e:1);return{fragment:e,cacheable:g}},f.fragments={},f.each({appendTo:"append",prependTo:"prepend",insertBefore:"before",insertAfter:"after",replaceAll:"replaceWith"},function(a,b){f.fn[a]=function(c){var d=[],e=f(c),g=this.length===1&&this[0].parentNode;if(g&&g.nodeType===11&&g.childNodes.length===1&&e.length===1){e[b](this[0]);return this}for(var h=0,i=e.length;h<i;h++){var j=(h>0?this.clone(!0):this).get();f(e[h])[b](j),d=d.concat(j)}return this.pushStack(d,a,e.selector)}}),f.extend({clone:function(a,b,c){var d,e,g,h=f.support.html5Clone||!bc.test("<"+a.nodeName)?a.cloneNode(!0):bo(a);if((!f.support.noCloneEvent||!f.support.noCloneChecked)&&(a.nodeType===1||a.nodeType===11)&&!f.isXMLDoc(a)){bk(a,h),d=bl(a),e=bl(h);for(g=0;d[g];++g)e[g]&&bk(d[g],e[g])}if(b){bj(a,h);if(c){d=bl(a),e=bl(h);for(g=0;d[g];++g)bj(d[g],e[g])}}d=e=null;return h},clean:function(a,b,d,e){var g;b=b||c,typeof b.createElement=="undefined"&&(b=b.ownerDocument||b[0]&&b[0].ownerDocument||c);var h=[],i;for(var j=0,k;(k=a[j])!=null;j++){typeof k=="number"&&(k+="");if(!k)continue;if(typeof k=="string")if(!_.test(k))k=b.createTextNode(k);else{k=k.replace(Y,"<$1></$2>");var l=(Z.exec(k)||["",""])[1].toLowerCase(),m=bg[l]||bg._default,n=m[0],o=b.createElement("div");b===c?bh.appendChild(o):U(b).appendChild(o),o.innerHTML=m[1]+k+m[2];while(n--)o=o.lastChild;if(!f.support.tbody){var p=$.test(k),q=l==="table"&&!p?o.firstChild&&o.firstChild.childNodes:m[1]==="<table>"&&!p?o.childNodes:[];for(i=q.length-1;i>=0;--i)f.nodeName(q[i],"tbody")&&!q[i].childNodes.length&&q[i].parentNode.removeChild(q[i])}!f.support.leadingWhitespace&&X.test(k)&&o.insertBefore(b.createTextNode(X.exec(k)[0]),o.firstChild),k=o.childNodes}var r;if(!f.support.appendChecked)if(k[0]&&typeof (r=k.length)=="number")for(i=0;i<r;i++)bn(k[i]);else bn(k);k.nodeType?h.push(k):h=f.merge(h,k)}if(d){g=function(a){return!a.type||be.test(a.type)};for(j=0;h[j];j++)if(e&&f.nodeName(h[j],"script")&&(!h[j].type||h[j].type.toLowerCase()==="text/javascript"))e.push(h[j].parentNode?h[j].parentNode.removeChild(h[j]):h[j]);else{if(h[j].nodeType===1){var s=f.grep(h[j].getElementsByTagName("script"),g);h.splice.apply(h,[j+1,0].concat(s))}d.appendChild(h[j])}}return h},cleanData:function(a){var b,c,d=f.cache,e=f.event.special,g=f.support.deleteExpando;for(var h=0,i;(i=a[h])!=null;h++){if(i.nodeName&&f.noData[i.nodeName.toLowerCase()])continue;c=i[f.expando];if(c){b=d[c];if(b&&b.events){for(var j in b.events)e[j]?f.event.remove(i,j):f.removeEvent(i,j,b.handle);b.handle&&(b.handle.elem=null)}g?delete i[f.expando]:i.removeAttribute&&i.removeAttribute(f.expando),delete d[c]}}}});var bq=/alpha\([^)]*\)/i,br=/opacity=([^)]*)/,bs=/([A-Z]|^ms)/g,bt=/^-?\d+(?:px)?$/i,bu=/^-?\d/,bv=/^([\-+])=([\-+.\de]+)/,bw={position:"absolute",visibility:"hidden",display:"block"},bx=["Left","Right"],by=["Top","Bottom"],bz,bA,bB;f.fn.css=function(a,c){if(arguments.length===2&&c===b)return this;return f.access(this,a,c,!0,function(a,c,d){return d!==b?f.style(a,c,d):f.css(a,c)})},f.extend({cssHooks:{opacity:{get:function(a,b){if(b){var c=bz(a,"opacity","opacity");return c===""?"1":c}return a.style.opacity}}},cssNumber:{fillOpacity:!0,fontWeight:!0,lineHeight:!0,opacity:!0,orphans:!0,widows:!0,zIndex:!0,zoom:!0},cssProps:{"float":f.support.cssFloat?"cssFloat":"styleFloat"},style:function(a,c,d,e){if(!!a&&a.nodeType!==3&&a.nodeType!==8&&!!a.style){var g,h,i=f.camelCase(c),j=a.style,k=f.cssHooks[i];c=f.cssProps[i]||i;if(d===b){if(k&&"get"in k&&(g=k.get(a,!1,e))!==b)return g;return j[c]}h=typeof d,h==="string"&&(g=bv.exec(d))&&(d=+(g[1]+1)*+g[2]+parseFloat(f.css(a,c)),h="number");if(d==null||h==="number"&&isNaN(d))return;h==="number"&&!f.cssNumber[i]&&(d+="px");if(!k||!("set"in k)||(d=k.set(a,d))!==b)try{j[c]=d}catch(l){}}},css:function(a,c,d){var e,g;c=f.camelCase(c),g=f.cssHooks[c],c=f.cssProps[c]||c,c==="cssFloat"&&(c="float");if(g&&"get"in g&&(e=g.get(a,!0,d))!==b)return e;if(bz)return bz(a,c)},swap:function(a,b,c){var d={};for(var e in b)d[e]=a.style[e],a.style[e]=b[e];c.call(a);for(e in b)a.style[e]=d[e]}}),f.curCSS=f.css,f.each(["height","width"],function(a,b){f.cssHooks[b]={get:function(a,c,d){var e;if(c){if(a.offsetWidth!==0)return bC(a,b,d);f.swap(a,bw,function(){e=bC(a,b,d)});return e}},set:function(a,b){if(!bt.test(b))return b;b=parseFloat(b);if(b>=0)return b+"px"}}}),f.support.opacity||(f.cssHooks.opacity={get:function(a,b){return br.test((b&&a.currentStyle?a.currentStyle.filter:a.style.filter)||"")?parseFloat(RegExp.$1)/100+"":b?"1":""},set:function(a,b){var c=a.style,d=a.currentStyle,e=f.isNumeric(b)?"alpha(opacity="+b*100+")":"",g=d&&d.filter||c.filter||"";c.zoom=1;if(b>=1&&f.trim(g.replace(bq,""))===""){c.removeAttribute("filter");if(d&&!d.filter)return}c.filter=bq.test(g)?g.replace(bq,e):g+" "+e}}),f(function(){f.support.reliableMarginRight||(f.cssHooks.marginRight={get:function(a,b){var c;f.swap(a,{display:"inline-block"},function(){b?c=bz(a,"margin-right","marginRight"):c=a.style.marginRight});return c}})}),c.defaultView&&c.defaultView.getComputedStyle&&(bA=function(a,b){var c,d,e;b=b.replace(bs,"-$1").toLowerCase(),(d=a.ownerDocument.defaultView)&&(e=d.getComputedStyle(a,null))&&(c=e.getPropertyValue(b),c===""&&!f.contains(a.ownerDocument.documentElement,a)&&(c=f.style(a,b)));return c}),c.documentElement.currentStyle&&(bB=function(a,b){var c,d,e,f=a.currentStyle&&a.currentStyle[b],g=a.style;f===null&&g&&(e=g[b])&&(f=e),!bt.test(f)&&bu.test(f)&&(c=g.left,d=a.runtimeStyle&&a.runtimeStyle.left,d&&(a.runtimeStyle.left=a.currentStyle.left),g.left=b==="fontSize"?"1em":f||0,f=g.pixelLeft+"px",g.left=c,d&&(a.runtimeStyle.left=d));return f===""?"auto":f}),bz=bA||bB,f.expr&&f.expr.filters&&(f.expr.filters.hidden=function(a){var b=a.offsetWidth,c=a.offsetHeight;return b===0&&c===0||!f.support.reliableHiddenOffsets&&(a.style&&a.style.display||f.css(a,"display"))==="none"},f.expr.filters.visible=function(a){return!f.expr.filters.hidden(a)});var bD=/%20/g,bE=/\[\]$/,bF=/\r?\n/g,bG=/#.*$/,bH=/^(.*?):[ \t]*([^\r\n]*)\r?$/mg,bI=/^(?:color|date|datetime|datetime-local|email|hidden|month|number|password|range|search|tel|text|time|url|week)$/i,bJ=/^(?:about|app|app\-storage|.+\-extension|file|res|widget):$/,bK=/^(?:GET|HEAD)$/,bL=/^\/\//,bM=/\?/,bN=/<script\b[^<]*(?:(?!<\/script>)<[^<]*)*<\/script>/gi,bO=/^(?:select|textarea)/i,bP=/\s+/,bQ=/([?&])_=[^&]*/,bR=/^([\w\+\.\-]+:)(?:\/\/([^\/?#:]*)(?::(\d+))?)?/,bS=f.fn.load,bT={},bU={},bV,bW,bX=["*/"]+["*"];try{bV=e.href}catch(bY){bV=c.createElement("a"),bV.href="",bV=bV.href}bW=bR.exec(bV.toLowerCase())||[],f.fn.extend({load:function(a,c,d){if(typeof a!="string"&&bS)return bS.apply(this,arguments);if(!this.length)return this;var e=a.indexOf(" ");if(e>=0){var g=a.slice(e,a.length);a=a.slice(0,e)}var h="GET";c&&(f.isFunction(c)?(d=c,c=b):typeof c=="object"&&(c=f.param(c,f.ajaxSettings.traditional),h="POST"));var i=this;f.ajax({url:a,type:h,dataType:"html",data:c,complete:function(a,b,c){c=a.responseText,a.isResolved()&&(a.done(function(a){c=a}),i.html(g?f("<div>").append(c.replace(bN,"")).find(g):c)),d&&i.each(d,[c,b,a])}});return this},serialize:function(){return f.param(this.serializeArray())},serializeArray:function(){return this.map(function(){return this.elements?f.makeArray(this.elements):this}).filter(function(){return this.name&&!this.disabled&&(this.checked||bO.test(this.nodeName)||bI.test(this.type))}).map(function(a,b){var c=f(this).val();return c==null?null:f.isArray(c)?f.map(c,function(a,c){return{name:b.name,value:a.replace(bF,"\r\n")}}):{name:b.name,value:c.replace(bF,"\r\n")}}).get()}}),f.each("ajaxStart ajaxStop ajaxComplete ajaxError ajaxSuccess ajaxSend".split(" "),function(a,b){f.fn[b]=function(a){return this.on(b,a)}}),f.each(["get","post"],function(a,c){f[c]=function(a,d,e,g){f.isFunction(d)&&(g=g||e,e=d,d=b);return f.ajax({type:c,url:a,data:d,success:e,dataType:g})}}),f.extend({getScript:function(a,c){return f.get(a,b,c,"script")},getJSON:function(a,b,c){return f.get(a,b,c,"json")},ajaxSetup:function(a,b){b?b_(a,f.ajaxSettings):(b=a,a=f.ajaxSettings),b_(a,b);return a},ajaxSettings:{url:bV,isLocal:bJ.test(bW[1]),global:!0,type:"GET",contentType:"application/x-www-form-urlencoded",processData:!0,async:!0,accepts:{xml:"application/xml, text/xml",html:"text/html",text:"text/plain",json:"application/json, text/javascript","*":bX},contents:{xml:/xml/,html:/html/,json:/json/},responseFields:{xml:"responseXML",text:"responseText"},converters:{"* text":a.String,"text html":!0,"text json":f.parseJSON,"text xml":f.parseXML},flatOptions:{context:!0,url:!0}},ajaxPrefilter:bZ(bT),ajaxTransport:bZ(bU),ajax:function(a,c){function w(a,c,l,m){if(s!==2){s=2,q&&clearTimeout(q),p=b,n=m||"",v.readyState=a>0?4:0;var o,r,u,w=c,x=l?cb(d,v,l):b,y,z;if(a>=200&&a<300||a===304){if(d.ifModified){if(y=v.getResponseHeader("Last-Modified"))f.lastModified[k]=y;if(z=v.getResponseHeader("Etag"))f.etag[k]=z}if(a===304)w="notmodified",o=!0;else try{r=cc(d,x),w="success",o=!0}catch(A){w="parsererror",u=A}}else{u=w;if(!w||a)w="error",a<0&&(a=0)}v.status=a,v.statusText=""+(c||w),o?h.resolveWith(e,[r,w,v]):h.rejectWith(e,[v,w,u]),v.statusCode(j),j=b,t&&g.trigger("ajax"+(o?"Success":"Error"),[v,d,o?r:u]),i.fireWith(e,[v,w]),t&&(g.trigger("ajaxComplete",[v,d]),--f.active||f.event.trigger("ajaxStop"))}}typeof a=="object"&&(c=a,a=b),c=c||{};var d=f.ajaxSetup({},c),e=d.context||d,g=e!==d&&(e.nodeType||e instanceof f)?f(e):f.event,h=f.Deferred(),i=f.Callbacks("once memory"),j=d.statusCode||{},k,l={},m={},n,o,p,q,r,s=0,t,u,v={readyState:0,setRequestHeader:function(a,b){if(!s){var c=a.toLowerCase();a=m[c]=m[c]||a,l[a]=b}return this},getAllResponseHeaders:function(){return s===2?n:null},getResponseHeader:function(a){var c;if(s===2){if(!o){o={};while(c=bH.exec(n))o[c[1].toLowerCase()]=c[2]}c=o[a.toLowerCase()]}return c===b?null:c},overrideMimeType:function(a){s||(d.mimeType=a);return this},abort:function(a){a=a||"abort",p&&p.abort(a),w(0,a);return this}};h.promise(v),v.success=v.done,v.error=v.fail,v.complete=i.add,v.statusCode=function(a){if(a){var b;if(s<2)for(b in a)j[b]=[j[b],a[b]];else b=a[v.status],v.then(b,b)}return this},d.url=((a||d.url)+"").replace(bG,"").replace(bL,bW[1]+"//"),d.dataTypes=f.trim(d.dataType||"*").toLowerCase().split(bP),d.crossDomain==null&&(r=bR.exec(d.url.toLowerCase()),d.crossDomain=!(!r||r[1]==bW[1]&&r[2]==bW[2]&&(r[3]||(r[1]==="http:"?80:443))==(bW[3]||(bW[1]==="http:"?80:443)))),d.data&&d.processData&&typeof d.data!="string"&&(d.data=f.param(d.data,d.traditional)),b$(bT,d,c,v);if(s===2)return!1;t=d.global,d.type=d.type.toUpperCase(),d.hasContent=!bK.test(d.type),t&&f.active++===0&&f.event.trigger("ajaxStart");if(!d.hasContent){d.data&&(d.url+=(bM.test(d.url)?"&":"?")+d.data,delete d.data),k=d.url;if(d.cache===!1){var x=f.now(),y=d.url.replace(bQ,"$1_="+x);d.url=y+(y===d.url?(bM.test(d.url)?"&":"?")+"_="+x:"")}}(d.data&&d.hasContent&&d.contentType!==!1||c.contentType)&&v.setRequestHeader("Content-Type",d.contentType),d.ifModified&&(k=k||d.url,f.lastModified[k]&&v.setRequestHeader("If-Modified-Since",f.lastModified[k]),f.etag[k]&&v.setRequestHeader("If-None-Match",f.etag[k])),v.setRequestHeader("Accept",d.dataTypes[0]&&d.accepts[d.dataTypes[0]]?d.accepts[d.dataTypes[0]]+(d.dataTypes[0]!=="*"?", "+bX+"; q=0.01":""):d.accepts["*"]);for(u in d.headers)v.setRequestHeader(u,d.headers[u]);if(d.beforeSend&&(d.beforeSend.call(e,v,d)===!1||s===2)){v.abort();return!1}for(u in{success:1,error:1,complete:1})v[u](d[u]);p=b$(bU,d,c,v);if(!p)w(-1,"No Transport");else{v.readyState=1,t&&g.trigger("ajaxSend",[v,d]),d.async&&d.timeout>0&&(q=setTimeout(function(){v.abort("timeout")},d.timeout));try{s=1,p.send(l,w)}catch(z){if(s<2)w(-1,z);else throw z}}return v},param:function(a,c){var d=[],e=function(a,b){b=f.isFunction(b)?b():b,d[d.length]=encodeURIComponent(a)+"="+encodeURIComponent(b)};c===b&&(c=f.ajaxSettings.traditional);if(f.isArray(a)||a.jquery&&!f.isPlainObject(a))f.each(a,function(){e(this.name,this.value)});else for(var g in a)ca(g,a[g],c,e);return d.join("&").replace(bD,"+")}}),f.extend({active:0,lastModified:{},etag:{}});var cd=f.now(),ce=/(\=)\?(&|$)|\?\?/i;f.ajaxSetup({jsonp:"callback",jsonpCallback:function(){return f.expando+"_"+cd++}}),f.ajaxPrefilter("json jsonp",function(b,c,d){var e=b.contentType==="application/x-www-form-urlencoded"&&typeof b.data=="string";if(b.dataTypes[0]==="jsonp"||b.jsonp!==!1&&(ce.test(b.url)||e&&ce.test(b.data))){var g,h=b.jsonpCallback=f.isFunction(b.jsonpCallback)?b.jsonpCallback():b.jsonpCallback,i=a[h],j=b.url,k=b.data,l="$1"+h+"$2";b.jsonp!==!1&&(j=j.replace(ce,l),b.url===j&&(e&&(k=k.replace(ce,l)),b.data===k&&(j+=(/\?/.test(j)?"&":"?")+b.jsonp+"="+h))),b.url=j,b.data=k,a[h]=function(a){g=[a]},d.always(function(){a[h]=i,g&&f.isFunction(i)&&a[h](g[0])}),b.converters["script json"]=function(){g||f.error(h+" was not called");return g[0]},b.dataTypes[0]="json";return"script"}}),f.ajaxSetup({accepts:{script:"text/javascript, application/javascript, application/ecmascript, application/x-ecmascript"},contents:{script:/javascript|ecmascript/},converters:{"text script":function(a){f.globalEval(a);return a}}}),f.ajaxPrefilter("script",function(a){a.cache===b&&(a.cache=!1),a.crossDomain&&(a.type="GET",a.global=!1)}),f.ajaxTransport("script",function(a){if(a.crossDomain){var d,e=c.head||c.getElementsByTagName("head")[0]||c.documentElement;return{send:function(f,g){d=c.createElement("script"),d.async="async",a.scriptCharset&&(d.charset=a.scriptCharset),d.src=a.url,d.onload=d.onreadystatechange=function(a,c){if(c||!d.readyState||/loaded|complete/.test(d.readyState))d.onload=d.onreadystatechange=null,e&&d.parentNode&&e.removeChild(d),d=b,c||g(200,"success")},e.insertBefore(d,e.firstChild)},abort:function(){d&&d.onload(0,1)}}}});var cf=a.ActiveXObject?function(){for(var a in ch)ch[a](0,1)}:!1,cg=0,ch;f.ajaxSettings.xhr=a.ActiveXObject?function(){return!this.isLocal&&ci()||cj()}:ci,function(a){f.extend(f.support,{ajax:!!a,cors:!!a&&"withCredentials"in a})}(f.ajaxSettings.xhr()),f.support.ajax&&f.ajaxTransport(function(c){if(!c.crossDomain||f.support.cors){var d;return{send:function(e,g){var h=c.xhr(),i,j;c.username?h.open(c.type,c.url,c.async,c.username,c.password):h.open(c.type,c.url,c.async);if(c.xhrFields)for(j in c.xhrFields)h[j]=c.xhrFields[j];c.mimeType&&h.overrideMimeType&&h.overrideMimeType(c.mimeType),!c.crossDomain&&!e["X-Requested-With"]&&(e["X-Requested-With"]="XMLHttpRequest");try{for(j in e)h.setRequestHeader(j,e[j])}catch(k){}h.send(c.hasContent&&c.data||null),d=function(a,e){var j,k,l,m,n;try{if(d&&(e||h.readyState===4)){d=b,i&&(h.onreadystatechange=f.noop,cf&&delete ch[i]);if(e)h.readyState!==4&&h.abort();else{j=h.status,l=h.getAllResponseHeaders(),m={},n=h.responseXML,n&&n.documentElement&&(m.xml=n),m.text=h.responseText;try{k=h.statusText}catch(o){k=""}!j&&c.isLocal&&!c.crossDomain?j=m.text?200:404:j===1223&&(j=204)}}}catch(p){e||g(-1,p)}m&&g(j,k,m,l)},!c.async||h.readyState===4?d():(i=++cg,cf&&(ch||(ch={},f(a).unload(cf)),ch[i]=d),h.onreadystatechange=d)},abort:function(){d&&d(0,1)}}}});var ck={},cl,cm,cn=/^(?:toggle|show|hide)$/,co=/^([+\-]=)?([\d+.\-]+)([a-z%]*)$/i,cp,cq=[["height","marginTop","marginBottom","paddingTop","paddingBottom"],["width","marginLeft","marginRight","paddingLeft","paddingRight"],["opacity"]],cr;f.fn.extend({show:function(a,b,c){var d,e;if(a||a===0)return this.animate(cu("show",3),a,b,c);for(var g=0,h=this.length;g<h;g++)d=this[g],d.style&&(e=d.style.display,!f._data(d,"olddisplay")&&e==="none"&&(e=d.style.display=""),e===""&&f.css(d,"display")==="none"&&f._data(d,"olddisplay",cv(d.nodeName)));for(g=0;g<h;g++){d=this[g];if(d.style){e=d.style.display;if(e===""||e==="none")d.style.display=f._data(d,"olddisplay")||""}}return this},hide:function(a,b,c){if(a||a===0)return this.animate(cu("hide",3),a,b,c);var d,e,g=0,h=this.length;for(;g<h;g++)d=this[g],d.style&&(e=f.css(d,"display"),e!=="none"&&!f._data(d,"olddisplay")&&f._data(d,"olddisplay",e));for(g=0;g<h;g++)this[g].style&&(this[g].style.display="none");return this},_toggle:f.fn.toggle,toggle:function(a,b,c){var d=typeof a=="boolean";f.isFunction(a)&&f.isFunction(b)?this._toggle.apply(this,arguments):a==null||d?this.each(function(){var b=d?a:f(this).is(":hidden");f(this)[b?"show":"hide"]()}):this.animate(cu("toggle",3),a,b,c);return this},fadeTo:function(a,b,c,d){return this.filter(":hidden").css("opacity",0).show().end().animate({opacity:b},a,c,d)},animate:function(a,b,c,d){function g(){e.queue===!1&&f._mark(this);var b=f.extend({},e),c=this.nodeType===1,d=c&&f(this).is(":hidden"),g,h,i,j,k,l,m,n,o;b.animatedProperties={};for(i in a){g=f.camelCase(i),i!==g&&(a[g]=a[i],delete a[i]),h=a[g],f.isArray(h)?(b.animatedProperties[g]=h[1],h=a[g]=h[0]):b.animatedProperties[g]=b.specialEasing&&b.specialEasing[g]||b.easing||"swing";if(h==="hide"&&d||h==="show"&&!d)return b.complete.call(this);c&&(g==="height"||g==="width")&&(b.overflow=[this.style.overflow,this.style.overflowX,this.style.overflowY],f.css(this,"display")==="inline"&&f.css(this,"float")==="none"&&(!f.support.inlineBlockNeedsLayout||cv(this.nodeName)==="inline"?this.style.display="inline-block":this.style.zoom=1))}b.overflow!=null&&(this.style.overflow="hidden");for(i in a)j=new f.fx(this,b,i),h=a[i],cn.test(h)?(o=f._data(this,"toggle"+i)||(h==="toggle"?d?"show":"hide":0),o?(f._data(this,"toggle"+i,o==="show"?"hide":"show"),j[o]()):j[h]()):(k=co.exec(h),l=j.cur(),k?(m=parseFloat(k[2]),n=k[3]||(f.cssNumber[i]?"":"px"),n!=="px"&&(f.style(this,i,(m||1)+n),l=(m||1)/j.cur()*l,f.style(this,i,l+n)),k[1]&&(m=(k[1]==="-="?-1:1)*m+l),j.custom(l,m,n)):j.custom(l,h,""));return!0}var e=f.speed(b,c,d);if(f.isEmptyObject(a))return this.each(e.complete,[!1]);a=f.extend({},a);return e.queue===!1?this.each(g):this.queue(e.queue,g)},stop:function(a,c,d){typeof a!="string"&&(d=c,c=a,a=b),c&&a!==!1&&this.queue(a||"fx",[]);return this.each(function(){function h(a,b,c){var e=b[c];f.removeData(a,c,!0),e.stop(d)}var b,c=!1,e=f.timers,g=f._data(this);d||f._unmark(!0,this);if(a==null)for(b in g)g[b]&&g[b].stop&&b.indexOf(".run")===b.length-4&&h(this,g,b);else g[b=a+".run"]&&g[b].stop&&h(this,g,b);for(b=e.length;b--;)e[b].elem===this&&(a==null||e[b].queue===a)&&(d?e[b](!0):e[b].saveState(),c=!0,e.splice(b,1));(!d||!c)&&f.dequeue(this,a)})}}),f.each({slideDown:cu("show",1),slideUp:cu("hide",1),slideToggle:cu("toggle",1),fadeIn:{opacity:"show"},fadeOut:{opacity:"hide"},fadeToggle:{opacity:"toggle"}},function(a,b){f.fn[a]=function(a,c,d){return this.animate(b,a,c,d)}}),f.extend({speed:function(a,b,c){var d=a&&typeof a=="object"?f.extend({},a):{complete:c||!c&&b||f.isFunction(a)&&a,duration:a,easing:c&&b||b&&!f.isFunction(b)&&b};d.duration=f.fx.off?0:typeof d.duration=="number"?d.duration:d.duration in f.fx.speeds?f.fx.speeds[d.duration]:f.fx.speeds._default;if(d.queue==null||d.queue===!0)d.queue="fx";d.old=d.complete,d.complete=function(a){f.isFunction(d.old)&&d.old.call(this),d.queue?f.dequeue(this,d.queue):a!==!1&&f._unmark(this)};return d},easing:{linear:function(a,b,c,d){return c+d*a},swing:function(a,b,c,d){return(-Math.cos(a*Math.PI)/2+.5)*d+c}},timers:[],fx:function(a,b,c){this.options=b,this.elem=a,this.prop=c,b.orig=b.orig||{}}}),f.fx.prototype={update:function(){this.options.step&&this.options.step.call(this.elem,this.now,this),(f.fx.step[this.prop]||f.fx.step._default)(this)},cur:function(){if(this.elem[this.prop]!=null&&(!this.elem.style||this.elem.style[this.prop]==null))return this.elem[this.prop];var a,b=f.css(this.elem,this.prop);return isNaN(a=parseFloat(b))?!b||b==="auto"?0:b:a},custom:function(a,c,d){function h(a){return e.step(a)}var e=this,g=f.fx;this.startTime=cr||cs(),this.end=c,this.now=this.start=a,this.pos=this.state=0,this.unit=d||this.unit||(f.cssNumber[this.prop]?"":"px"),h.queue=this.options.queue,h.elem=this.elem,h.saveState=function(){e.options.hide&&f._data(e.elem,"fxshow"+e.prop)===b&&f._data(e.elem,"fxshow"+e.prop,e.start)},h()&&f.timers.push(h)&&!cp&&(cp=setInterval(g.tick,g.interval))},show:function(){var a=f._data(this.elem,"fxshow"+this.prop);this.options.orig[this.prop]=a||f.style(this.elem,this.prop),this.options.show=!0,a!==b?this.custom(this.cur(),a):this.custom(this.prop==="width"||this.prop==="height"?1:0,this.cur()),f(this.elem).show()},hide:function(){this.options.orig[this.prop]=f._data(this.elem,"fxshow"+this.prop)||f.style(this.elem,this.prop),this.options.hide=!0,this.custom(this.cur(),0)},step:function(a){var b,c,d,e=cr||cs(),g=!0,h=this.elem,i=this.options;if(a||e>=i.duration+this.startTime){this.now=this.end,this.pos=this.state=1,this.update(),i.animatedProperties[this.prop]=!0;for(b in i.animatedProperties)i.animatedProperties[b]!==!0&&(g=!1);if(g){i.overflow!=null&&!f.support.shrinkWrapBlocks&&f.each(["","X","Y"],function(a,b){h.style["overflow"+b]=i.overflow[a]}),i.hide&&f(h).hide();if(i.hide||i.show)for(b in i.animatedProperties)f.style(h,b,i.orig[b]),f.removeData(h,"fxshow"+b,!0),f.removeData(h,"toggle"+b,!0);d=i.complete,d&&(i.complete=!1,d.call(h))}return!1}i.duration==Infinity?this.now=e:(c=e-this.startTime,this.state=c/i.duration,this.pos=f.easing[i.animatedProperties[this.prop]](this.state,c,0,1,i.duration),this.now=this.start+(this.end-this.start)*this.pos),this.update();return!0}},f.extend(f.fx,{tick:function(){var a,b=f.timers,c=0;for(;c<b.length;c++)a=b[c],!a()&&b[c]===a&&b.splice(c--,1);b.length||f.fx.stop()},interval:13,stop:function(){clearInterval(cp),cp=null},speeds:{slow:600,fast:200,_default:400},step:{opacity:function(a){f.style(a.elem,"opacity",a.now)},_default:function(a){a.elem.style&&a.elem.style[a.prop]!=null?a.elem.style[a.prop]=a.now+a.unit:a.elem[a.prop]=a.now}}}),f.each(["width","height"],function(a,b){f.fx.step[b]=function(a){f.style(a.elem,b,Math.max(0,a.now)+a.unit)}}),f.expr&&f.expr.filters&&(f.expr.filters.animated=function(a){return f.grep(f.timers,function(b){return a===b.elem}).length});var cw=/^t(?:able|d|h)$/i,cx=/^(?:body|html)$/i;"getBoundingClientRect"in c.documentElement?f.fn.offset=function(a){var b=this[0],c;if(a)return this.each(function(b){f.offset.setOffset(this,a,b)});if(!b||!b.ownerDocument)return null;if(b===b.ownerDocument.body)return f.offset.bodyOffset(b);try{c=b.getBoundingClientRect()}catch(d){}var e=b.ownerDocument,g=e.documentElement;if(!c||!f.contains(g,b))return c?{top:c.top,left:c.left}:{top:0,left:0};var h=e.body,i=cy(e),j=g.clientTop||h.clientTop||0,k=g.clientLeft||h.clientLeft||0,l=i.pageYOffset||f.support.boxModel&&g.scrollTop||h.scrollTop,m=i.pageXOffset||f.support.boxModel&&g.scrollLeft||h.scrollLeft,n=c.top+l-j,o=c.left+m-k;return{top:n,left:o}}:f.fn.offset=function(a){var b=this[0];if(a)return this.each(function(b){f.offset.setOffset(this,a,b)});if(!b||!b.ownerDocument)return null;if(b===b.ownerDocument.body)return f.offset.bodyOffset(b);var c,d=b.offsetParent,e=b,g=b.ownerDocument,h=g.documentElement,i=g.body,j=g.defaultView,k=j?j.getComputedStyle(b,null):b.currentStyle,l=b.offsetTop,m=b.offsetLeft;while((b=b.parentNode)&&b!==i&&b!==h){if(f.support.fixedPosition&&k.position==="fixed")break;c=j?j.getComputedStyle(b,null):b.currentStyle,l-=b.scrollTop,m-=b.scrollLeft,b===d&&(l+=b.offsetTop,m+=b.offsetLeft,f.support.doesNotAddBorder&&(!f.support.doesAddBorderForTableAndCells||!cw.test(b.nodeName))&&(l+=parseFloat(c.borderTopWidth)||0,m+=parseFloat(c.borderLeftWidth)||0),e=d,d=b.offsetParent),f.support.subtractsBorderForOverflowNotVisible&&c.overflow!=="visible"&&(l+=parseFloat(c.borderTopWidth)||0,m+=parseFloat(c.borderLeftWidth)||0),k=c}if(k.position==="relative"||k.position==="static")l+=i.offsetTop,m+=i.offsetLeft;f.support.fixedPosition&&k.position==="fixed"&&(l+=Math.max(h.scrollTop,i.scrollTop),m+=Math.max(h.scrollLeft,i.scrollLeft));return{top:l,left:m}},f.offset={bodyOffset:function(a){var b=a.offsetTop,c=a.offsetLeft;f.support.doesNotIncludeMarginInBodyOffset&&(b+=parseFloat(f.css(a,"marginTop"))||0,c+=parseFloat(f.css(a,"marginLeft"))||0);return{top:b,left:c}},setOffset:function(a,b,c){var d=f.css(a,"position");d==="static"&&(a.style.position="relative");var e=f(a),g=e.offset(),h=f.css(a,"top"),i=f.css(a,"left"),j=(d==="absolute"||d==="fixed")&&f.inArray("auto",[h,i])>-1,k={},l={},m,n;j?(l=e.position(),m=l.top,n=l.left):(m=parseFloat(h)||0,n=parseFloat(i)||0),f.isFunction(b)&&(b=b.call(a,c,g)),b.top!=null&&(k.top=b.top-g.top+m),b.left!=null&&(k.left=b.left-g.left+n),"using"in b?b.using.call(a,k):e.css(k)}},f.fn.extend({position:function(){if(!this[0])return null;var a=this[0],b=this.offsetParent(),c=this.offset(),d=cx.test(b[0].nodeName)?{top:0,left:0}:b.offset();c.top-=parseFloat(f.css(a,"marginTop"))||0,c.left-=parseFloat(f.css(a,"marginLeft"))||0,d.top+=parseFloat(f.css(b[0],"borderTopWidth"))||0,d.left+=parseFloat(f.css(b[0],"borderLeftWidth"))||0;return{top:c.top-d.top,left:c.left-d.left}},offsetParent:function(){return this.map(function(){var a=this.offsetParent||c.body;while(a&&!cx.test(a.nodeName)&&f.css(a,"position")==="static")a=a.offsetParent;return a})}}),f.each(["Left","Top"],function(a,c){var d="scroll"+c;f.fn[d]=function(c){var e,g;if(c===b){e=this[0];if(!e)return null;g=cy(e);return g?"pageXOffset"in g?g[a?"pageYOffset":"pageXOffset"]:f.support.boxModel&&g.document.documentElement[d]||g.document.body[d]:e[d]}return this.each(function(){g=cy(this),g?g.scrollTo(a?f(g).scrollLeft():c,a?c:f(g).scrollTop()):this[d]=c})}}),f.each(["Height","Width"],function(a,c){var d=c.toLowerCase();f.fn["inner"+c]=function(){var a=this[0];return a?a.style?parseFloat(f.css(a,d,"padding")):this[d]():null},f.fn["outer"+c]=function(a){var b=this[0];return b?b.style?parseFloat(f.css(b,d,a?"margin":"border")):this[d]():null},f.fn[d]=function(a){var e=this[0];if(!e)return a==null?null:this;if(f.isFunction(a))return this.each(function(b){var c=f(this);c[d](a.call(this,b,c[d]()))});if(f.isWindow(e)){var g=e.document.documentElement["client"+c],h=e.document.body;return e.document.compatMode==="CSS1Compat"&&g||h&&h["client"+c]||g}if(e.nodeType===9)return Math.max(e.documentElement["client"+c],e.body["scroll"+c],e.documentElement["scroll"+c],e.body["offset"+c],e.documentElement["offset"+c]);if(a===b){var i=f.css(e,d),j=parseFloat(i);return f.isNumeric(j)?j:i}return this.css(d,typeof a=="string"?a:a+"px")}}),a.jQuery=a.$=f,typeof define=="function"&&define.amd&&define.amd.jQuery&&define("jquery",[],function(){return f})})(window);
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# Highlight.js

[![Build Status](https://travis-ci.org/isagalaev/highlight.js.svg?branch=master)](https://travis-ci.org/isagalaev/highlight.js)

Highlight.js is a syntax highlighter written in JavaScript. It works in the
browser as well as on the server. It works with pretty much any markup,
doesn't depend on any framework and has automatic language detection.


## Getting Started

The bare minimum for using highlight.js on a web page is linking to the library
along with one of the styles and calling [`initHighlightingOnLoad`][1]:

```html
<link rel="stylesheet" href="/path/to/styles/default.css">
<script src="/path/to/highlight.pack.js"></script>
<script>hljs.initHighlightingOnLoad();</script>
```

This will find and highlight code inside of `<pre><code>` tags trying to detect
the language automatically. If automatic detection doesn't work for you, you can
specify the language in the class attribute:

```html
<pre><code class="html">...</code></pre>
```

The list of supported language classes is available in the [class reference][8].
Classes can also be prefixed with either `language-` or `lang-`.

To disable highlighting altogether use the `nohighlight` class:

```html
<pre><code class="nohighlight">...</code></pre>
```

## Custom Initialization

When you need a bit more control over the initialization of
highlight.js, you can use the [`highlightBlock`][2] and [`configure`][3]
functions. This allows you to control *what* to highlight and *when*.

Here's an equivalent way to calling [`initHighlightingOnLoad`][1] using jQuery:

```javascript
$(document).ready(function() {
  $('pre code').each(function(i, block) {
    hljs.highlightBlock(block);
  });
});
```

You can use any tags instead of `<pre><code>` to mark up your code. If you don't
use a container that preserve line breaks you will need to configure
highlight.js to use the `<br>` tag:

```javascript
hljs.configure({useBR: true});

$('div.code').each(function(i, block) {
  hljs.highlightBlock(block);
});
```

For other options refer to the documentation for [`configure`][3].


## Getting the Library

You can get highlight.js as a hosted or custom-build browser script or as a
server module. Head over to the [download page][4] for all the options.

Note, that the library is not supposed to work straight from the source on
GitHub, it requires building. If none of the pre-packaged options work for you
refer to the [building documentation][5].


## License

Highlight.js is released under the BSD License. See [LICENSE][10] file for
details.


## Links

The official site for the library is at <https://highlightjs.org/>.

Further in-depth documentation for the API and other topics is at
<http://highlightjs.readthedocs.org/>.

Authors and contributors are listed in the [AUTHORS.en.txt][9] file.

[1]: http://highlightjs.readthedocs.org/en/latest/api.html#inithighlightingonload
[2]: http://highlightjs.readthedocs.org/en/latest/api.html#highlightblock-block
[3]: http://highlightjs.readthedocs.org/en/latest/api.html#configure-options
[4]: https://highlightjs.org/download/
[5]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[8]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[9]: https://github.com/isagalaev/highlight.js/blob/master/AUTHORS.en.txt
[10]: https://github.com/isagalaev/highlight.js/blob/master/LICENSE
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[#] Control Bus - The controlbus component provides easy management of Camel applications based on the Control Bus EIP pattern.

(& CXF - The cxf component is used for SOAP WebServices using Apache CXF.

(& CXF-R - The cxfrs component s used for JAX-RS REST services using Apache CXF.
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3 Netty HTTP - Netty HTTP server and client using the Netty 3.x library.

@ (cancel ] [_Finish





OEBPS/Common_Content/images/bullet_arrowblue.png





OEBPS/images/topics/images/FuseOnlineExtWiz_connector.png
What kind of Fuse Online extension do you want to create?

Custom Step

° Custom Connector





OEBPS/images/topics/images/CnfigsVGlobalDFSourceV.png
) *camelContext.xml 3

1 <oxml version="1.6" encoding="UTF-8"7>
22 <beans xnlns=" http// . springfranewor k. org/schena beans®

3 xnlns vhttp://camel.apache. org/schema/ spring"

4 xmlns :xsi="http://www. u3. org/2001/XMLSchema-instance’ xsi:schemaLocation="http://ww. springframewo
5o <camelContext id="camelContext-500h5988-60F7-4387-adbf-049d5220c1F2"

s trace="false’ xmlns="http://camel.apache. org/schema/spring”>

)

]

10

12
13 <endpoint 1d="myJMS* uri="jms:destinationType:destinationName’ />
14 <route id="_routel"/>

15 </camelContexts

16 </beans>

Design | Source | Configurations | REST






OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Black.eot


OEBPS/Common_Content/images/24.png





OEBPS/images/topics/images/gray-dot.png





OEBPS/images/topics/images/routeDelete.png





OEBPS/Common_Content/images/title_logo.png
& RedHat





OEBPS/images/topics/images/set_property_drpdwn_menu.png
ABCOrder
orderitems

item! |

|0 idv

xploré  Set variable

Set expression
Add transformation

Add custom transformation





OEBPS/Common_Content/images/7.png





OEBPS/images/topics/images/nfpTemplateKaraf.png
New Fuse Integration Project a x

r
Advanced Project Setup

Select a template for your new project,

)

1 TRl o ety 47e G et c met m e r

type fiter tex (flers on name, description and keywords) €1

~ Beginner

Content Based Router - Spring DSL
Content Based Router - Java DSL
~ Advanced
CXF code frst - Spring DSL
CXF code frst - Java DSL
- Empty
Empty - Blueprint DSL
Empty - Spring DSL
Empty - Java DSL

[This template provides a sample Camel route definition which
reads files from a specific Location and routes these files
depending on their content to different output folders,

Where can you find more examples to use as templates?

e ) om






OEBPS/images/topics/images/DTtransformEditor5.png
=

‘Source: ABCOrder 80 Varaies

Create 3 new mapping below by dragging a property from source ABCOrder on the left to a property in target XyzOrder on the right.

<

x

Wogpiogs Togets Xyzondr
- x
e [N &
o et o omena
-0 Xjzorser
o st o prrty e
o pre o e o ongn
o quniy /0 ameunt
o customrtom | [0 custa
o /o emid
Ascorder
== iy
© ottt

© ordertium






OEBPS/images/topics/images/UGservDisconnectJMXN.png
@ JMX Navigator 32 | 1 Diagram View & Terminal =8

L e -
» @ Local Processes
v & server Connections
¥ 4! Red Hat Fuse 7+ Runtime Ser ™~ * ]
» & MBeans " Refresh
4 Bundles
e el 4. Attach Agent
# User-Defined Connections
Delete Connection

2_ New Connection...





OEBPS/images/topics/images/UGservRuntimeOverviewTab.png
5] Red Hot Fuse 7+ Runtime Server 53

B overview

‘General Information
‘Specify the host name and other common settings.

Server name: Red Hat Fuse 7+ Runtime Server

Host name: localhost

Runtime Environment: | Red Hat Fuse 7+ Runtime
Open launch configuration

~ Connection Details

‘SSH Connection details

SSH Port: 8101

admin

o

~ Publishing
Modify settings for publishing.

) Never publish automatically
%) Automatically publish when resources change.
*) Automatically publish after a buld event
Publishing interval (in seconds): 15
~ Timeouts
‘Specify the time limit to complete server operations.
Start (in seconds): £y

Stop (in seconds): a5






OEBPS/images/topics/images/UGservPublishSynched.png
g Messages View &4 Servers 53 | E) Console

v G4 Red Hat Fuse 7+ Runtime Server (Started, Synchronizad)
1) ZooOrdernpp [started, Synchronized]
@ JMx(Disconnected]





OEBPS/images/topics/images/NewPreferredLabel.png
New Preferred Label a ox

Select your preferred label

@ Select a parameter to display in the diagram for a specific
Yy
component

“

Componen: |

“

Parameter: |

@ [ cnce [ ok |






OEBPS/images/topics/images/green-dot.png





OEBPS/Common_Content/images/19.png





OEBPS/images/topics/images/newCamTstEndpts.png
Test Endp

Slec endpoins we should sen 10 or consume fom i the E”

‘generated test case.

Available endpoints:
VEndpoints
Vinputs
fle:sre/datatnooy
voutputs

fle-target/messages /uk
fle:target/messages /others

3 endpoints selected.

@ Cema ) ( nows

Gl ) (s





OEBPS/images/topics/images/ugBundleNamesPomFile.png
<build>
<defaultGoal>install</defaultGoal>
<plugins>
<plugin>
<groupldsorg. apache. felix</groupld>
<art: factId>naven-bundle-plugin</arti factld>
<version>${version.maven-bundle-plugin}</version
<extensions>true</extensions>
<configuration>
<instructions>
<Bundle-Synbo T cNane> CBRroute</Bund e SymboTLcNane>
<Bundle_Name>Enpty Camel Blueprint Example [CBRroute]</Bundle-Namesfe/instructions:
Configuration
plugin]






OEBPS/images/topics/images/DTnewRoute.png
nnnnnnnnnn






OEBPS/images/topics/images/new_trans.png
Set property

Set variable
hift Explorer il

Set expression

Add transformation

Add custom transformation





OEBPS/images/topics/images/UGservrStartConsoleV.png
[ Messages View 4 Servers | [E) Console 53 - BEREE ve-8-=0

Red Hat Fuse 7+ Runtime Server [Red Hat Fuse Launcher] /LibrarylJavalJavaVirtualMachines/idic1.8.0.171.jdk/Content:
Red Hat Fuse starting up. Press Enter to open the shell now...






OEBPS/images/topics/images/UGDefNewServer.png
Define a New Server
Choose the type of server to create

Select the server type:

» (& JBoss Community
> owz
» & Opensnitt
» 5 Oracle
¥ 5 Red Hat JBoss Middleware
R Minishift 1.7+
8 Red Hat Container Development Kit 2.x
#h Red Hat Container Development Kit 3
i Red Hat Container Development Kit 3.2+
5] Red Hat Fuse 7+ Server
|Red Hat JBoss Enterprise Application Platform 4.3
@ Red Hat JBoss Enterprise Application Platform 5.x
|Red Hat JBoss Enterprise Application Platform 6.0
@ Red Hat JBoss Enterprise Application Platform 6.1+
Server Defintion of Red Hat Fuse 7+

Server's host name: 7 localhost

Server name: Red Hat Fuse 7+ Runtime Server

) Nert > cance





OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Bold.woff


OEBPS/Common_Content/images/10.png





OEBPS/images/topics/images/CnfigsVCreateGlobalBean1.png
Add Bean a ox

Bean Definition

Specify detals for new bean definition

Id* T
—_— [HE

A =

Constructor Arguments

Type Value Add

Bean Properties:

Name Value Add






OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-MediumItalic.woff


OEBPS/images/topics/images/DTaddFuncAppndStd.png
ABCOrder
s XyzOrder

-
append( [staws |, [-level| ) ol





OEBPS/Common_Content/images/watermark-draft.png





OEBPS/images/topics/images/FuseDebugPerspectExample.png
Lo | | Comns e vmgrtion Gpouig

[T EE R — 4Bexe v=o
o e g spcn o st e
s ot iy % oo Combeneseniys o s
5 e T Contrn i R
5 oen T o o g .
e e s Comtacroae - 259525

5 ouen T ettt Gt 1 i)
[y

P L
e e =,

052 in Route] (buepriotx] _.\' B ———

Er bt
o

| e =S5 e ounonen
e,

e S
eman & 7 CERY L N
o it et

70 Goetiond®
£ 16 o






OEBPS/Common_Content/scripts/utils.js
var work = 1;

function pop(entity) {
	if(entity) {
		var my_parent = entity.parentNode;
		var my_class = my_parent.className;
		my_parent.className = my_class.replace(/popper/,"popped");
	}
}
function unpop(entity) {
	if(entity) {
		var my_parent = entity.parentNode;
		var my_class = my_parent.className;
		my_parent.className = my_class.replace(/popped/,"popper");
	}
}

function siblings(entity){
	var r = [];
	for ( var n = entity.parentNode.firstChild; n; n = n.nextSibling ) 
		if ( n.nodeType == 1 && n != entity)
			r.push( n );		
	return r;
}

/* This activates an element and deactivates all it's siblings */
function activateElement(id) {
	var entity = document.getElementById(id);
	if(entity.className.indexOf("active") == -1) {
		entity.className = entity.className + " active";
	}
	var sibs = siblings(entity);

	for(var i=0; i < sibs.length; i++) {
		if(sibs[i].className.indexOf("active") != -1) {
			deactivateElement(sibs[i]);
		}
	}
}

function deactivateElement(entity) {
	if(entity.className.indexOf("active") != -1) {
		 entity.className = entity.className.replace(/[ ]*active/, '');
	}
}

function getCookie(name) {
	var name_c = window.location.hostname + '-' + name;

	if(document.cookie) {
		var cookies = document.cookie.split(/ *; */);
		for(var i=0; i < cookies.length; i++) {
			var current_c = cookies[i].split("=");
			if(current_c[0] == name_c) {
				return(current_c[1]);
				break;
			}
		}
	}
	return('');
}

function setCookie(name, value, expires, path) {
	name = window.location.hostname + '-' + name;

	var curCookie = name + "=" + value + 
		((expires) ? ";expires=" + expires.toGMTString() : "") + 
		((path) ? ";path=" + path : "");
	document.cookie = curCookie; 
}

function setDefLangCookie(entity) {
	setCookie('switchery', entity.options[entity.selectedIndex].value, '', '/');
}

function initSwitchery() {
	var divs = document.getElementsByTagName('div');
	for(i in divs) {
		if(typeof(divs[i].className) != 'undefined' && divs[i].className.indexOf("switchery") != -1) {
			var lang = getCookie('switchery');
			if(lang != '') {
				var entity = document.getElementById(divs[i].id + '-' + lang);
				if(entity) {
					entity.onclick();
					entity.parentNode.lastChild.value = lang;
				} else {
					divs[i].firstChild.firstChild.onclick();
				}
			} else {
				divs[i].firstChild.firstChild.onclick();
			}
		}
	}

}

function showhide(id) {
	if(work) {
		work = 0;
		var entity = document.getElementById(id);
		if(entity) {
			var my_class = entity.className;
			if(my_class.indexOf("hidden") != -1) {
				entity.className = my_class.replace(/hidden/,"visible");
			}
			else if(my_class.indexOf("visible") != -1) {
				entity.className = my_class.replace(/visible/,"hidden");
			}
		}
	}

	return false;
}

function hide(id) {
	if(work) {
		work = 0;
		var entity = document.getElementById(id);
		if(entity) {
			var my_class = entity.className;
			if(my_class.indexOf("visible") != -1) {
				entity.className = my_class.replace(/visible/,"hidden");
			}
		}
	} else {
		work=1;
	}
}

var preventReset = 0;

function dehighlightTarget(entity) {
	if(preventReset == 0 && entity) {
		var id = entity.href;
		if(id.indexOf("#") != -1) {
			id = id.substr(id.indexOf('#')+1);
		}
		var target = document.getElementById(id);
		if(target) {
			deactivateElement(target);
		}
		}
}

function highlightTarget(entity, norefresh) {
	if(entity) {
		var id = entity.href;
		if(id.indexOf("#") != -1) {
			id = id.substr(id.indexOf('#')+1);
		}
		activateElement(id);
		preventReset = 0;
	} 
	if(norefresh == 1) {
		preventReset=1;
	}
}
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Select a transformation for the status property, along with any applicable arguments

Transformations
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format
indexOf
isEmpty
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length
lowerCase
prepend
properCase
remove
removeAll
replace
replaceAll
startsWith
substring
toBoolean
toDouble
toFloat
tolnteger
tolong
toShort
token

trim

Description

Appends the supplied suffix to the end of the source string.

Arguments

Name Value

Type _Description

String The string to be appended to the end of the
source string
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)

type fiter tex (flers on name, description and keywords) €1
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232 <blueprint xmlns="http://mww. 0sgi.org/xmlns/blueprint/vl.6.6"

24 xmlns:xsi="http://ww. u3.org/2001/XM.Schema-instance xsi:schemalocation="http: //ww.0sgi.org/xmlns/blu
268 The namespace for the camelContext element in Blueprint is 'https://camel.apache.org/schema/blueprint
32 <bean class="com.mycompany. GreeterService" id="Greeterservice'/>

5335 <camelContext id='_contextl® xmlns="http://camel.apache.org/ schema/blueprint®s
Ed <restConfigurafion component="netty-http" host="localhost" port="16600"/>
3 <rest path='/say">
369 <get uri="hello/{name}">
37 <to uri="direct:service-hello"/>
E </get>
399 <get consumes="application/json" uri="/bye/{name}">
s <to uri="direct:service-bye' />
41 </get>
420 <post uri='/greeter'>
43 <to uri=*direct:service-greeter'/>
44 </post>
45 </rest>
468 <route id="service-hello">
a7 <from id="_froml" uri="direct:service-hello"/>
485 <setBody id="_setBodyl">
49 <sinple-Hello ${header.name}</simple>
50 </setBody>
s1 </route>
520 <route id="service-bye"s
s3 <from id="_from2" uri=tdirect:service-bye'/>
sae <transforn id="_transforml">
S5 <simple>Bye ${header.name}</simple>
s6 </transform
57 </route>
s8e <route id="service-grester's
9 <from id="_froms" uri="direct:service-greeter"/>
605 <unmarshal id="_unmarshall">
61 <json libraTy="Jackson" unmarshalTypeName="com. mycompany. Hel loRequest" />
62 </unmarshal>
63 <to 1d="_tol" uri="bean:GreeterService?method=createtello" />
625 <marshalid="_marshall’>
65 <json Library="Jackson" />
6 </marshal>
57 </route>
68 </camelContext>

69 </blueprint>
——

B soure ) Contauraions |
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